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l Part 3: Debugging, adjustment, documentation and appendices.
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About the book
At a Glance

Document Scope This manual describes the installation of software for Micro and Premium PLCs

Validity Note The update of this documentation takes into account the functions of PL7 V4.0
Nevertheless, it can be used to set up previous versions of PL7.

User Comments We welcome your comments about this document. You can reach us by e-mail at 
TECHCOMM@modicon.com
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Operate modes manual 09/2000
I
Operating modes, general points
Presentation

Subject of this 
part

This spacer describes how to set up the software tool and gives general points on 
managing applications.

What’s in this 
part?

This Part contains the following Chapters:

Chapter Chaptername Page

1 Setting up 17

2 Presentation of PL7 functions 27

3 Managing applications 45
15
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1
Setting up
Presentation

What’s in this 
chapter

This chapter describes the software set up for the programming software.

What’s in this 
Chapter?

This Chapter contains the following Maps:

Topic Page

General points on PL7 software 18

Connections 20

Software installation 21
17



Setting up
General points on PL7 software

At a Glance PL7 Micro/Junior/Pro are programming and debugging tools for TSX Micro and TSX 
Premium PLCs.

There are three software variants:
l the software suite that is used to install PL7 software,
l the software update suite that is used to update a previous version to a new ver-

sion (Pl7 Micro V1.0 to P17 Micro V4.0),
l the software upgrade suite that is used to upgrade a previous version to a new 

version with a higher level of functionality (PL7 Micro V1.0 to P17 Junior V4.0, or 
PL7 Junior V1.0 to PL7 Pro V4.0).

A PL7 software suite comprises:
l a PL7 software installation CD-ROM,
l a CD-ROM containing the previous version of the TSX37 and TSX57 processor 

operating systems,
l a TSX07/37/57 PC UNI-TE terminal port cable (reference TSX PCU 1030, not 

supplied with updates or upgrades),
l an installation and start up guide for PL7,
l a product identification number.A record of this number should be kept because 

it is needed each time the corresponding software is installed,
l a CD containing documentation in French/English/German/Italian/Spanish.

Functions The functions of PL7 software are as follows:

Pl7-Micro Pl7-Junior Pl7-Pro

Programming TSX-Micro TSX-Micro\Premium TSX-Micro\Premium

Grafcet Chart
Grafcet Macro

yes yes yes

no TSX Premium TSX Premium

Ladder yes yes yes

List yes yes yes

Structured text no yes yes

Sections yes yes yes

Functional mod-
ules

no no yes

Debugging yes yes yes

Adjustments yes yes yes

Diagnostics yes yes yes

Runtime screens no no creation/use
18 Operate modes manual 09/2000



Setting up
References TLX CD PL7M P 40 M: PL7-Micro

TLX CD PL7J P 40 M:  PL7-Junior

TLX CD PL7P P 40 M: PL7-Pro

TLX RCD PL7M P 40 M: Update for PL7 Micro to the new version

TLX RCD PL7J P 40 M: Update for PL7 Junior to the new version

TLX RCD PL7P P 40 M: Update for PL7 Pro to the new version

TLX UCD PL7J P 40 M: Upgrade for PL7 Micro to the new version of PL7 Junior

TLX UCD PL7P P 40 M: Upgrade for PL7 Junior to the new version of PL7 Pro

DFB types no use creation/use

DFB diagnostics no no TSX/PCX/PMX57

Storage of PLC 
symbols

TSX Premium TSX Premium

Application docu-
mentation file

yes yes yes
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Setting up
Connections

Introduction This module deals with linking the terminal to the PL7 by cable. The specific links to 
the terminal (monitor, keyboard, mouse, printer, power) are described in the con-
struction documentation. 
Other connection methods are possible such as UNITELWAY bus, modem (via the 
telephone network). 

Connection from 
the PC <-> to the 
PL7

Connecting a PC type terminal means using a TSX PCU 1030 link cable 2.5 metres 
long which is supplied with new software packages (not supplied with updates or up-
grades).    

Connection of 
FTX517/FT2000 
<-> to the PL7

Connecting an FTX 517 terminal requires a T FTX CBF 020 link cable 2.5 metres 
long.
Connecting an FT 2000 terminal requires a TSX PCU 1030 link cable 2.5 metres 
long which is supplied with new software packages (not supplied with updates or up-
grades).   

TSX PCU 1030

TSX PCU 1030

TSX 57

TSX 37 PC

Secteur SecteurSecteur

TSX PCU 1030

T FTX CBF 020

TSX PCU 1030

TSX 57

TSX 37
FT 2000

FTX 517

Secteur Secteur

Secteur

Connecteur
liaison série
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Setting up
Software installation

Configuring the 
terminal

Nominal configuration

Typical configuration

Note:
These characteristics are for configurations for the installation of the PL7 software 
only.
A larger configuration may be necessary if it is to be used at the same time as other 
software.

Processor Pentium 133MHz

System Windows 95\98 or Windows NT 4.0

Ram 64 Mb

Drives Hard disk 50 Mb for P17 + 25 Mb for temporary directories
Disks

Ports COM serial ports available for PLC connection (COM 1 to COM 4)
Parallel ports for printing (LPT1 to LPT4)

Monitor VGA

Processor Pentium  266MHz

System Windows 95\98 or Windows NT 4.0

Ram 128 Mb

Drives Hard disk 50 Mb for P17 + 25 Mb for temporary directories
Disks
CD-ROM

Ports COM serial ports available for PLC connection (COM 1 to COM 4)
Parallel ports for printing (LPT1 to LPT4)

Monitor VGA or above (SVGA with 24 bit color management recommended).
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Setting up
Contents of PL7 You can choose which components of the PL7 software you wish to install. The stan-
dard installation is the most straightforward, but a customized installation allows you 
to optimize the space taken up by the software.
Contents of a standard installation (in bold):

Software Contents

PL7-Micro Core, function library, Uni-Telway driver.
Servers (security management).
Demonstration application.
FIP drivers
PL7-2 converter

PL7-Junior Core, function library, Uni-Telway driver.
Servers (security management).
Demonstration application.
FIP drivers
PL7-2 converter
PL7-3 converter
S1000 converter

PL7-Pro Core, function library, Uni-Telway driver.
Servers (security management).
Demonstration application.
FIP drivers
FNES Import/Export function
PL7-2 converter
PL7-3 converter
S1000 converter
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Setting up
Installation This procedure describes the various stages for PL7 software installation. 

Enter the product identification number
then confirm via Next

(a maximum of 3 entry attempts)

O
pt

io
n 

of
 m

od
ify

in
g 

in
fo

rm
at

io
n 

by
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lic
ki

ng
 o

n 
P

re
vi

o
u

s 

common to all installations

Standard

Customized

Insert the first diskInsert the CD-ROM

Launch the Setup.exe file

Confirm the first screen
via Next

Choose the software language
then confirm via Next

Define an installation path then confirm via 
Next

 Confirm the information via Next

Select the elements to be installed and 
confirm via Next

Define the various installation
 paths and then confirm via Next

Confirm the information via Next

Exit the installation via
Return to Windows

Save your coordinates
then confirm via OK

Select:
the type of installation
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Setting up
PL7 directories 
and files

Directories created on C:

Directories created on a path defined by the user (e.g.: D:\PROGRAMS\

Directories created in C:\WINDOWS\

C:\PL7USER\ directory containing client and demonstration applications,

C:\PL7TEMP\ directory used as temporary space,

C:\CONGIG.SYS modified file incorporating the UNITELWAY and FIPWAY 
drivers

C:\CONFIG.001 Old configuration file

\OFLIB32\ directory containing the functions 

\PL7Micro33\ directory containing the module descriptions and executables 
for PL7 Micro

\PL7Junior33\ directory containing the module descriptions and executables 
for PL7 Junior

\PL7Pro33\ directory containing the module descriptions and executables 
for PL7 Pro

\PL7SYS\ directory containing shared PL7 files

\XWAYDRV\ directory containing COM drivers

\PL7SYS\ directory containing history

\PL7SYS\HISTO.REF file containing installation history

\PL7SYS.INI initialization file

\START MENU\PRO-
GRAMS\MODICON 
TELEMECANIQUE

directory containing the startup icons
24 Operate modes manual 09/2000



Setting up
Execution Carry out the following steps from the Start menu:

Uninstalling the 
software

Carry out the following steps from the Start menu:

Step Action

1 Select Programs from theStart menu.

2 Select the Modicon Telemecanique program group.

3 Select the software icon.

Step Action

1 Go to Settings\Control Panel\Add-Remove programs.

2 Select PL7***V4.*.

3 Select Add-Remove.

4 Select the elements to be uninstalled (core and / shared components)

5 Select OK.

6 Confirm with YES.

7 At the information screen confirm the uninstall by selecting OK.
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2
Presentation of PL7 functions
Presentation

What’s in this 
chapter

This chapter describes very generally the various components of the software prod-
uct.

What’s in this 
Chapter?

This Chapter contains the following Maps:

Topic Page

Configuration editor 28

Variables editor 29

Editing in ladder language 30

Instruction list language editing 31

Structured text language editor. 32

Grafcet language editor 33

Animation tables 34

Debugging 35

Diagnostics 37

Operating screens 39

Structure of the documentation file 40

General software ergonomics 41
27



Presentation
Configuration editor

Hardware 
configuration

The configuration editor is used intuitively and graphically to declare and configure 
the various constituent parts of the PL7.
l rack,
l supply,
l processor,
l application specific modules.
Editor: 

Software 
configuration

The configuration editor also ensures the software parametrizing of the application 
by informing on the number of function blocks, registers and the size of the global 
variable fields.

Configuring 
Grafcet objects

If the Grafcet programming language has been used, the configuration editor is used 
to define the Grafcet objects (steps, macro steps,….) and the execution parameters 
(number of steps and active transitions).

Note In on-line mode the configuration editor also provides the debugging, adjustment 
and diagnostic functions.
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Presentation
Variables editor

Presentation The variables editor is used:
l to symbolize the various application objects,
l to parametrize the predefined function blocks,
l to enter the constant values and choose the display base,
l to parametrize the DFB user function blocks.

Access to variables is gained by:
l classifying by family and type,
l sorting functions (symbols or addresses),
l being able to pre-symbolize objects in certain applications,
l being able to launch a search with a joker on the symbol or comment,
l being able to filter the I/Os,
l being able to Copy/Paste by variables block,
l being able to remove pre-symbolization,
l displaying the variables used in the program in bold.
Editor: 

I/O 1: TSX DEY 16D2 Input zoneParameters Addr

Variables

Address Type CommentSymbol

+

P

+
+

+

%CH1.MOD CH
%I1.MOD.ERR EBOOL
%MW1.MOD WORD
%MW1.MOD.1 WORD
%MW1.MOD.2 WORD
%CH1.0 CH
%KW 1.0 WORD
%KW 1.0.1 WORD
%KW 1.0.2 WORD
%I1.0 EBOOL detects a part in front of cylinder v 1PRESENCE_PIECE

sensor for return position of cylinder v 1CAPTEUR_V1_ENTREE

starts systemINIT
stops automatic cycleARRET

%I1.1
%I1.2
%I1.3
%I1.4
%I1.5
%I1.6
%I1.7
%I1.0.ERR

EBOOL
EBOOL
EBOOL
EBOOL
EBOOL
EBOOL
EBOOL
BOOL

CAPTEUR_V2_ENTREE
CAPTEUR_V1_SORTIE

CAPTEUR_V2_SORTIE

sensor for out position of cylinder v 1
sensor for return position of cylinder v 2
sensor for out position of cylinder v 2

%CH1.MOD

+
+
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Editing in ladder language

At a Glance The Ladder editor offers a number of tools to help build a ladder in a user-friendly 
way:
l a graphics palette,
l the language objects can be entered at random and displayed in the form of ad-

dresses, symbols or both at the same time,
l a collapsed view.
Editor: 

The editor is used to immediately call up assisted entry functions:
l to access function libraries,
l to enter variables in the form of symbols or addresses.

When displayed, the ladders are shown in contracted form. It is thus possible to view 
several ladders in the same window and to access them using the scroll bar or their 
label.

A subroutine can be accessed directly from the call program.

1.F3 1.F4 1.F5 1S.F6 1.F81.F2F12F11F10  F8 F9 F6 F4 F3 F2
P S R OPER COHP COHP

H V F (...)
 F5

N

1F7 F7

%MVV15:=%MVV13*500

OPERATE

IN        TM                         
Q
   
      MODE  TON
      TB:  1 s
 
     TM.P: 10
      MODIF: Y

%I1.0 %M12 %I1.7 %Q2.

%TM4.Q

%I1.5 %M27 %MW0:X5 %M25

%M17

LD : MAST - test

%TM0
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Presentation
Instruction list language editing

Introduction The Listeditor is used to input language instructions and operands via the keyboard, 
they are formatted automatically.

The operands can be input and viewed either as addresses or symbols.

To make program reading easier, key words of the language and comments are dis-
played in color.
Instruction list editor. 

The Instruction list language editor offers input help options :
l for function block instructions ((%TMi, %Ci,...),
l for functions, via the functions library.

IL: MAST - SR0

! ( * Verification of part in drying position * )
LD %I1.0
AND %I1.1
ST %Q2.2

! ( * Start motor * )
LDN %I1.0
ANDN %I1.4
AND %I1.3
ST %Q2.0
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Structured text language editor.

Introduction The editor is used to input program lines via the keyboard, using alphanumeric char-
acters.

The operands can be input and viewed either as addresses or symbols.

The editor provides a help option for function input via the functions library.

To make program reading easier, key words of the language and comments are dis-
played in color.
Structured text editor 

ST : MAST - SR1

! (*Search for the first not null element in a 32 word table
Determination of its value ( %MW10), and its rank (%MW11)
This search is carried out if %M0 is set to 1
%M1 is set to 1 if a not null element exists, if not it is set to 0*)

IF %M0 THEN
FOR %MW99: =0 TO31  DO

IF %MW100 [ %MW99 ] < >0 THEN
%MW10: = %MW100 [ %MW99 ];
%MW11: = %MW99;
%M1: =TRUE;
EXIT;               (*Exit FOR loop*)

ELSE
%M1: =FALSE;

END_IF;
END_FOR;

ELSE
%M1: FALSE;

END_IF;
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Presentation
Grafcet language editor

Presentation The editor has a number of tools which are used to enter the chart in a user-friendly 
manner: 
l a range of graphic objects,
l access to the actions or receptivity programs,
l automatic numbering of steps,
l a display of each Grafcet page with step and transition lines,
l simplified entering of remarks,
l a reduced view.

The graph is constructed by selecting the desired object from the graphics palette 
and putting it into the Grafcet page.

The graphics (fine lines) appear which ensures that the programmed graphic objects 
are displayed immediately.

Illustration Grafcet editor 

The Grafcet editor behaves like an editing field by shifting onto a complete module 
of 8 Grafcet pages.

GRAFCET: MAST - Chart

F11F8F7F6F5F4F3 F10 F12 1F2F9F2

0

2 31 54

1

1

1

1

(*Display the Recipe
on the Display*)
(*Recipe Number*)

(*Copy the
Recipe data*)

(*Select the Recipe
with the Display key*)
(*Start the cut/
New Recipe*)
(*Advance the high-speed
bar*)
(*Deceleration threshhold
reached*)
(*Advance the low-speed
bar*)
(*Length of cut
reached*)
(*Cut off a section*)

(*New section/
Cut completed*)
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Animation tables

At a Glance Animation tables can be created by entering them or automatically initializing them 
from the rungs, selected sequences, or animated objects in the runtime screens.

The variables can then be:
l modified,
l forced to 0 or to 1 for the bit objects.

For each numerical variable it is possible to select the display base (decimal, binary, 
hexadecimal, floating, ASCII message).
Animation table: 

Modify

 Display

Table: TABLE_TEST (Animated)*

0

1

Force 0

Force 1

Unforce

 Forcing

 Modification

Dec.

F6

F5

F4

F8

F7

F3

0

%Q3.0
%Q3.1
%I4.0
%I4.1
%M0
%M1
%TM0.V RETARD_ALLUMAGE-V

1
0
0
0
0
1
8

Address Symbol\Name Current value Nature Type

7/8

TEMOIN_DEMARRAGE
TEMOIN_TEMPO
DEMARRAGE
ARRET
MEMO_RETARD_ALLUMAGE
MEMO_FONCTIONNEME
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Presentation
Debugging

Debugging tools The PL7 software offers a complete range of tools for debugging applications.

A range of tools is used to access the main functions directly: 
l setting the break point,
l running the program from step to step,
l independent running of the MAST master task and the FAST rapid task.
Debugging bar 

CU debugging 
screen

This CU debugging screen has the following functions:
l information on the application status,
l controlling the running of the program,
l access to the diagnostic module specific programs,
l access to updating and display of the real time clock.
Diagnostic tool: 

RUN aGO cc c R7cF

 Mast  Evt Debug  Ap  Surv.

RUN aRUN a

 Fast

Designation: PROCESSOR TSX P 57302

 Task

 Operating Mode

 Last stop  Timestamp

 Events

Time:

Number of events:

State: 

Date:

Tuesday
Tuesday
Cause

Outputs in fallback mode

Network address:
Processor present:

Number of forced bits:
Processor version:

TSX 57302  [RACK 0    POSITION 0]

 Information

10:47:5524/02/1998

Change to Stop

Output fallback Warm restart

Cold start
RUN active Fault Reset fault bit

0

OK

Cancel
Upd

24/02/1998

10:49:13

TSX 57302

SYS

3.0(35)

1

IO DIAG...ERRRUN

Debug

Period
Set

Minimum
Duration

Current
Duration

Maximum
Duration

Cycle time
FIPIO 

Network

Watch
dog

Operating
Mode

State Cmd Activate 
task

Error Init
duration

Reset
Fault

MAST
FAST

CYCLIC
5 0 1 2 Not pres 100 RUN a Stop Deactivate Fault Init Reset

2 6 12 Not pres 250 RUN a Stop Deactivate Fault Init Reset
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Grafcet 
debugging 
screen

This Grafcet debugging screen is used to give a hierarchical display of the graph 
with overlays of the CHART module and the macro steps.

This view is animated on line. The animation is represented by the absence and 
presence of flags.
Debugging browser 

The debugging bar is used to display the status of the graph, to modify the status of 
the graph, to inform on the status of the master task.
Debugging bar 

Debugging 
function 
modules

Organizing a function module, distributing the sections, events and Grafcet modules 
to the various modules has no effect on the running of the program. This is carried 
out according to the order shown in the structure view.

To debug a function module, the user has basic debugging functions and additional 
functions used for incremental debugging of the application, function module by 
function module.

These functions are:
l deactivating all sections attached to a function module,
l activating all sections attached to a function module,
l cancelling the forcing of all sections attached to a function module.

Prl
Chart

Macro0
Macro1

Post

Grafcet Debug Browser

LDLD

G7G7

G7G7

operate

G7G7

PRG RUN aFrozen
 Chart status  Actions on chart  Prepositioning  Mast

Error
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Diagnostics

Diagnostics tool The software provides various diagnostics tools. To access the tools you need to be 
in online mode.

These tools are:
l diagnostics for the PLC’s last operational stop,
l module/channel diagnostics,
l program diagnostics,
l system diagnostics (See "Diagnostics functions installation manual",)
l Diagnostics DFBs (See "Diagnostics functions installation manual")

Diagnostics 
DFBs

Can be used with PL7 PRO. The diagnostics DFBs are composed of:
l Application diagnostics DFBs, which are used to set up process monitoring via 

the application program:
l PL7 equation monitoring,
l monitoring the reaction time of the process to a command,
l monitoring safety conditions,
l monitoring inputs, outputs and the ASI bus.

l Working part control and diagnostics DFBs which are used to control and monitor 
elements of the working part (EPOs):
l monitoring sensor information,
l monitoring actuator control requests,
l monitoring the duration of a movement,
l storing minimum and maximum movement durations,
l learning the duration times of a movement,
l controlling an actuator.

The library breaks down into the following DFBs:

EV_DIA Monitoring the status of 2 bits without taking a time factor into account.

MV_DIA Monitoring the status of two bits without taking a time factor into account, with 
the option of monitoring a movement’s changes (change of bit status within a 
given time period).

NEPO_DIA
TEPO_DIA

Monitoring, checking and diagnostics for a working part element.

IO_DIA Diagnostics for all the I/O modules.

ASI_DIA Diagnostics for an Asi input/output module.

ALRM_DIA Interface with a diagnostics buffer (storage of errors).
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Error message:

Each DFB has its own standard error message, which may be customized according 
to the type of DFB.

Error messages are displayed on a Viewer integrated into PL7 Pro. A Diagnostics 
Viewer is also available with the CCX17 V2.5
Viewer: 

Ack Error Zone Appearance Disappearance Error Message Status
0ALARM 10/03/1998... 10/03/1998... Silo empty or weighing ho

0EV_DIA 11/03/1998... 11/03/1998... DEF_1_DEFAUTS PLC 1 HO ISLAND... 0.2

0.2
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Operating screens

Presentation The operating screens editor is a tool integrated into the PRO PL7 program from ver-
sion V3.0 onwards.

It is used to make running an automated process easier.

From the screen tab you can:
l create operating screens, screen families,
l manage importing and exporting screens and screen families,
l manage the link between the screen number and the screen browser object,
l list all the variables used in a screen,
l parametrize the screen (size, elevator, full screen, mouse position….),
l copy/paste one or more objects,
l display the errors found by the diagnostic DFBs in the program.

From the message tab you can:
l Create the messages used in the screens.

From the screen tab you can:
l Create a library of graphics objects.
Operating screen: 

3- VOIT LINE DIAGRAM
34 – PRO CUT DIAGRAM
27 – DEF_1_DEFAUTS 
24 - SYNZ1_SYNOPTIQUE 

5 – Screen 1 blank for 

7 – Valve management

1

0

1

0

1

0

0
0

0

0 0

1

0

VAL

VAL
S o l v e n t R e a g e n t

VALL I T E R 
V o l u m e

ContentsL I T E R 

E v o l u t i o n   at   v e s s e l   l e v e l

L I T E R S

A N O M A L Y A N O M A L Y

VAL L I T E R S

Screen

4 – Program debug
2 – Chemical process
111 - Clock

1 - Contents

Run-time screen IE2.14: Product mix

112 - Product mix

5 – Screen 2 blank for 

a
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Structure of the documentation file

At a Glance The documentation editor is linked to the Documentation browser which shows the 
documentation file structure in tree diagram format.

The documentation editor is used to define:
l a title page containing the name of the project and the designer,
l general information pages,
l a cartridge.

The documentation editor automatically generates:
l the contents table,
l the application documentation file (hardware/software configurations and pro-

gram),
l the list of variables sorted by address or by symbol.

The documentation editor is also used:
l to print all or part of the application documentation file,
l to display documentation file pages before printing.
Documentation browser: 

For functional 
modules

When the documentation tool is launched, it detects whether there is at least one 
functional module referencing either program modules which are not empty (Sec-
tion, Evt, Grafcet modules, Srs), or animation tables.
If this is the case, an additional node "Function view" is added to the directory tree.

Documentation

Sr0
Sr1

normal_cycle

Rack configuration
Module parameters

Sections

Sr

Variables
Footer

Contents
Configuration

Title page

Cross references

Application structure
MAST Task

Software configuration
Program

Station Documentation File

Hardware configuration
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General software ergonomics

General points The PL7 software uses all the standard working tools for Windows: 
l mouse or keyboard,
l drop-down menus,
l browsers,
l tool bars and palettes with icons,
l several tools in parallel,
l on-line help and tool tips.

Standard 
elements

PL7 software uses Windows ergonomics and looks like this:
Example of a window: 

OFFLINE U:SYS GR7 NOK OVRReady

STOPRUN ??? ???STOPRUN

File Edit ?
PL7 PRO: IE54VT

Services View Tools PLC Debug Options Window

 GRAFCET:  MAST  -  run - Chart

F11F8F7F6F5F4F3F2 F10 F12

0

1

5

M1

2M0 

1F2F9

 2 3 4

5 6 7

1
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This table describes the different zones:

Tool bar The tool bar provides a rapid means of access to the standard software functions: 

This table shows what each element of the tool bar is for:

Number Description

1 Menu bar, which is used to access all the software functions.

2 Tool bar for rapid access to all basic functions using the mouse.

3 On-line help on how to use the software.

4 Context sensitive help for the software.

5 Comments zone.

6 Palette of graphics elements.

7 Work context.

Element Function Element Function

  New application   Offline mode

  Open an application   Online mode

  Save the application   Switch PLC to RUN mode

  Print all or part of the application   Switch the PLC to STOP mode

  Undo   Start / Stop animation

  Confirm modifications   Arrange the windows in a cas-
cade

  Go to   Tile Horizontally

  Application browser   Tile Vertically

  Cross references   Help

  Function library   What’s This?

  PLC transfer<-> terminal
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Status bar The PL7 status bar looks like this:   

This table describes the different zones that make up the status bar: 

Number Zone Function

1 Mini on-line help Provides help linked to the menu commands or tool bar icons 
when these are selected.

2 Operating mode Shows the current operating mode (offline, online).

3 PLC status Shows the PLC status (Run, Stop, faulty,etc.). 

4 Network address Provides details of the PLC’s network address.

5 Grafcet mode Shows whether Grafcet mode is used in the application.

6 Modification in 
progress

Shows that the current application is not backed up or is dif-
ferent from the back up.

7 Animation flag Symbol for online mode.

8 Keyboard func-
tions

Shows the status of the Insert and Caps functions of the key-
board.

ONLINE GR7 OK MODIF OVRReady STOP SHIFTU:SYS
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Managing applications
Presentation

What’s in this 
chapter

This chapter shows the different tools used to manage an application.

What’s in this 
Chapter?

This Chapter contains the following Maps:

Topic Page

PL7 access security management 46

Accessing PL7 software 47

Creating an application 48

Opening an application 49

Protecting an application on a PLC 50

Saving an application 53

Offline/online operation 54

Transferring a program from a PC to the PLC or vice versa 55

Transferring data from file to PLC and vice versa 57

Comparing applications 58

Backing up in the internal Eprom Flash memory 59

Backing up on a TSX MFP BAK 032P memory card 60

Accessing a PL7 through a network 62

Memory Usage 63

Sending a command to the PL7 65
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Managing applications
PL7 access security management

At a Glance PL7 access security management, administered by the super user, limits and con-
trols access to the various PL7 functions.

It is applied to the terminal where the PL7 software is installed, not the application.

PL7 software provides 5 user profiles:
l Read Only,
l Operate,
l Adjust,
l Debug,
l Program.

User information The User information box displays information on the current user.

When the PL7 Access security management option has not been implemented or 
is inactive, this information is as follows:
l indication that PL7 access control is inactive,
l the PL7.INI file path.

When PL7 Access security management is active, this information is as follows:
l indication that PL7 access control is active,
l user name,
l user profile,
l the "User".INI file name and path.
l the start options file name and path.

PL7 software 
access 
management

The super user is the only one with the rights to manage PL7 access security.

From the "PL7 Access Security Management" dialog box the super user can:
l create/ modify a list of users,
l import a list of users,
l export a list of users,
l activate the "PL7 Access Security Management" function,
l modify his/her password.

Note: The name reserved for the super user is Supervisor.
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Accessing PL7 software

At a Glance It is possible to run several PL7 operations simultaneously (multi-instance) from the 
same station.  

PL7 software also offers the possibility of setting the launch parameters for PL7 us-
ing a launch options file. This is used, for example, to automatically launch an appli-
cation in a given work environment using a customized short cut icon. 

Access without 
launch option

Carry out the following operations:

Access with 
launch option

Carry out the following operations:

Notes:

The operating mode described above can vary slightly depending on the launch op-
tions.

Depending on the launch options declared in the options file, different dialog boxes 
may appear.

When the user is not known (name and/or password incorrect), only the minimum 
PL7 profile (read only) is available.

Step Action

1 Select the PL7 icon required  (Micro, Junior or Pro) from the Modicon Teleme-
canique program group.

2 If PL7 Access Security Management is active, a dialog box is used to iden-
tify the user.
Enter a user name.

3 Enter a password, where applicable.

4 Confirm with OK or press Enter.

Step Action

1 Select the icon for the launch option command line.

2 If PL7 Access Security Management is active, an information box warns that 
the program cannot be launched unless access rights have been granted.
Click on OK.

3 A dialog box is then used to identify the user.
Enter a password.

4 Confirm with OK or press ENTER.
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Creating an application

Procedure Carry out the following actions:

Suggestion for 
setting up an 
application

Define the structure of the program to be used:
l single task,
l multi task,
l fast task,
l events,
l function view.
Define the structuring of the variables in:
l bits,
l words,
l tables,
l chains,
l symbols.
Define the PL7 configuration and the module parameters.

Step Action

1 Select the command File/New.

2 Select the hardware base.

3 Select the processor type:

4 Depending on which processor it is, select the type of memory card. The type 
of memory card can always be modified subsequently when configuring the 
processor.

5 Depending on the processor version, the Grafcet option must be selected be-
fore being used in the application.
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Managing applications
Opening an application

Procedure This function is applied from a PL7 product that is already open.

Carry out the following actions:

Note:

The applications are saved by default in the directory defined when it was installed.  
This can be looked up and modified using the command Option/Personalize.
The modifications will take effect after the next PL7 session.

Action Step

1 Select the command File/ Open.

2 Select the file for the application (*STX).

3 Click on Open.
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Managing applications
Protecting an application on a PLC

At a Glance The application’s Protection function can be accessed in offline mode from the Ap-
plication properties screen.

This function provides:
l Global application protection,
l For protecting the sections, the type of protection can be defined:

l individually by section,
l for all sections of an application or task.

Global 
application 
protection

Carry out the following actions:

This function is used after transferring the application to the PLC to provide read and 
write protection.
Only the Run, Stop and Init functions which can be accessed via the PLC/Com-
mand to the PLC command are authorized in a protected PLC application.

Step Action

1 From the Station directory select Properties via the contextual menu

2 Select the Protection tab.

3 In the Application zone, check the Global application protection box.

WARNING

Protection cannot be removed once applied. A protected application 
cannot be modified. The only option is to load a new application onto 
the PLC.

Failure to observe this precaution can result in severe injury or 
equipment damage.
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Managing applications
Global 
protection of all 
sections

This is for sections included in either:
l the program,
l or a task.
Carry out the following actions:

Individual 
protection of 
sections

Carry out the following actions:

Activating 
section 
protection

Notes:

The first time the application is used, the password must be confirmed.

The Clear button is used to delete the password.

The password is stored in the PLC when the application is transferred.

Deactivating 
protection

Carry out the following actions:

Step Action

1 Select the Programs, Tasks or Section directory.

2 Using the contextual menu select Protection of Included Sections.

3 Select the following from the drop-down menu: Write Protect, or Read and 
Write Protect.

Step Action

1 Select the section to be protected.

2 Using the contextual menu selectProperties.

3 From the drop-down menu, select Protection: Write or Read and Write

Step Action

1 From theStation directory selectProperties using the contextual menu.

2 Select the Protection tab.

3  Check the box protection activated, and enter the password. A padlock by 
the section shows that it is protected.

Step Action

1 From theStation directory selectProperties using the contextual menu.

2 Select the Protection tab.

3  Check the Protection deactivated box, and enter password. An open padlock 
by the section shows that protection has been deactivated.
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Note It is not possible to modify a section if partial or total protection is activated.

A padlock shows which type of protection has been activated:
l open: protected section - protection deactivated,
l closed: protected section - protection activated.
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Managing applications
Saving an application

Saving a new 
application

Carry out the following actions:

Saving an 
existing 
application

Select the command File/Save.

Step Action

1 Select the command File/Save or File/Save as.

2 If necessary, select the application’s disk and/or save directory using the pull-
down menu "In".

3 Enter the name of the file in the  "Name" field (maximum of 215 characters).
Caution: The characters given below cannot be used in naming a :\    /    file:    
*    ?    "    <    >    |.

4 Confirm using Save.

Note: When saving an application, which exceeds the capacity of one disk, dialog 
boxes will appear on the screen asking you to insert the disks one after another. 
This will continue until the save of the application is complete.
You are advised to prepare several empty, formatted discs in advance, and to num-
ber them in the order in which you insert them. 
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Offline/online operation

Offline mode Offline mode (no PLC connection) is used to Create/Modify an application on the 
terminal. The application being edited is stored on disk in the working directory.

The File/Save command or the icon  must be used to save to disk in the appli-
cations directory.

Online mode  Online mode (connected to the PLC) is used to Create/Modify an application in the 
PLC.

The following functions are available:
l create/modify LD, IL, ST or Grafcet programs,
l modify task period,
l modify predefined function block parameters (apart from register size),
l modify number of internal words,
l modify module data and parameters,
l import/export a source file or variables, PLC in Stop mode,
l export an application, PLC in Stop mode,
l debug, adjustment.
The following functions are not available:
l add or remove a module,
l modify the I/O channel association<->application-specific function,
l add predefined function blocks,
l modify register size,
l modify number of bits and internal constants,
l import an application
l open an application.

Notes:
When being modified in online mode, the application is updated on the PLC and on 
the disk in the working directory:
l the save to the PLC is automatic.

l The File/Save command or the icon  must be used to save to disk in the ap-
plications directory.

For functional 
modules

A functional module can be created, modified, and removed in offline or online 
mode, with the PLC in Stop or Run mode.

Commands Switching to online mode: Select PLC/Connect command.
Switching to offline mode: Select the PLC/Disconnect command.
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Transferring a program from a PC to the PLC or vice versa

PC -> PLC 
Transfer

Carry out the following actions:

Elements not transferred to the PLC:
l Functional Module descriptive forms,
l comments on DFB types,
l comments on DFB instances (with TSXMRP 2128P, TSXMRP 3256P memory 

cartridges),
l animation tables,
l runtime screens,
l symbols and comments on variables (when there is no memory cartridge).

PLC -> PC 
Transfer

Carry out the following actions:

Notes on PLC -> 
PC transfer

First scenario:

 If no applications are open on the terminal (PC), the program is transferred. If there 
is a symbol and comments database on the PLC, it is transferred, otherwise the of-
fline database is initialized (empty).

Second scenario:

If the PC has an application open when a request for PLC -> PC transfer is made, 
and modifications have been made since the last save, the software suggests sav-
ing them before continuing.
The software then suggests:

Step Action

1

Select the PLC/Transfer Program command or the icon .

2 Select PC->PLC transfer and click OK.

3 If a cartridge allowing symbols and comments to be stored is declared in con-
figuration, the box with the symbols is available: you can choose to make the 
symbol transfer or delay it until a later stage of the transfer.

Step Action

1

Select the PLC/Transfer Program command or the icon .

2  Select PLC->PC transfer and click on OK.
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l either saving the data (symbols), the respective application documentation file, 
the animation tables and the runtime screens on the terminal (PC) – to do this use 
the Keep button.

l or it suggests initializing the data (symbols), the respective application documen-
tation file, the animation tables and the runtime screens on the terminal (PC) – to 
do this use the Initialize button (default values are the same as at application in-
stallation).

If there is a symbol and comments database is on the PLC, it is transferred from the 
PLC to the PC.

Transfer results Results of the transfer are shown in the status bar (at the bottom of the window).

The ESC key can be used at any time to interrupt a transfer.

WARNING

For DFB instance comments:

DFB instance comments are not retained in the variables editor even if 
the user selects the "Keep" option
To combat this problem you must:
l either  use a PCMCIA memory card for storing symbols and com-

ments,
l or Export the symbols and comments from the old application, un-

load the new one and Import the symbols and comments into this 
new application.

Failure to observe this precaution can result in severe injury or 
equipment damage.
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Transferring data from file to PLC and vice versa

File -> PLC data 
transfer

Carry out the following actions:

The range of values contained in the file can be displayed by clicking on 

the icon 
The ">" command displays a dialog box which is used to choose a data file from the 
existing ones on the disk.

PLC -> File data 
transfer

Carry out the following actions:

The ">" command displays a dialog box which is used to choose the destination file.

Step Action

1 Select the PLC/Transfer Data command.

2 Select transfer direction, File -> PLC.

3 Enter the name of the file to be transferred then click on OK.

Step Action

1 Select the PLC/Transfer Data command.

2 Select transfer direction, PLC -> File.

3  Set the transfer parameters:
l the range of %MW values to be transferred,
l the name of the file in which the data will be stored.

4 Click on OK.

WARNING

A transfer in progress can only be interrupted if there is a fault of some 
kind (PLC fault, break in the PLC/PC link, etc.).

Failure to observe this precaution can result in severe injury or 
equipment damage.
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Comparing applications

Presentation Comparing applications is used to identify any differences between:
l the application in the PL7 and the one in the terminal,
l the application in the PL7’s RAM and the one in the EPROM FLASH memory.
l the PC and PL7 symbol base.

Procedure Carry out the following actions:

Result The result is shown in a dialogue box with:
l the date and the time of the last modification of the application run,
l the version number,
l the application name,
l the comments.

With the symbol base the dialogue box shows:
l the date and time of the last modification,
l the signature,
l the number of symbols,
l the space occupied,
l the total compressed size

Step Action

1  Select the command AP/Comparet.

2 Select the type of comparison:
l PC program<->PL7 program,
l RAM <->BACKUP field,,
l  PC symbol<-> PL7 symbol.

3 Click on OK.
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Backing up in the internal Eprom Flash memory

Presentation TSX 37-10 PL7s  and TSX 37-20 PL7s can save the application (program and con-
stants) in the internal PL7 EPROM FLASH memory if this is in the RAM and is not 
more than 15 associated symbol addresses.

This is used:
l  to reload the PL7 RAM manually (transferring BACK UP -> RAM field) using the 

contents of the EPROM FLASH,
l to reload the RAM automatically using the contents of the EPROM FLASH, when 

the application in RAM is invalid.

This function must be carried out in offline mode.

Transferring 
Ram -> Back up 
field

Carry out the following steps:

Transferring 
Back up  -> Ram 
field

Carry out the following steps:

The results of the transfer are shown on the status bar.

Step Action

1 Select the command AP/Backup.

2 Select the RAM->BACK UP field transfer and click on OK

WARNING

If the %SW97 system word is initialized at 0, only the application pro-
gram contained in the internal RAM is transferred to the Eprom Flash 
(equivalent to a program back up).
Any saving of %MWi is deleted.

Failure to observe this precaution can result in severe injury or 
equipment damage.

Step Action

1 Select the command AP/Backup.

2 Select the BACK UP->RAM field transfer and click on OK.
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Backing up on a TSX MFP BAK 032P memory card

At a Glance TSX Micro and Premium PLCs provide the option of backing up the application (pro-
gram and constants) on a TSX MFP BAK 032P memory card.

This Backup function is not available if the application is already running on a RAM 
or EPROM memory card. The internal RAM memory can thus be reloaded using the 
contents of the Backup card.

This function must be performed in Offline mode.

Ram -> Backup 
memory card 
transfer

Carry out the following actions:

Notes:

For a RAM->Backup transfer on TSX 3720 PLCs with an external memory card, pri-
ority is given to transferring the application to the memory card.

When the memory card is inserted into the PLC the contents of the internal RAM 
memory are re-initialized.

Backup memory 
card -> Ram 
transfer

Carry out the following actions:

Step Action

1 Save the application held in the PLC’s internal RAM on the programming ter-
minal, if necessary.

2 Insert the  TSX MFP BAK 032P memory card into the PLC (the write protection 
lock must be set to OFF).

3 Transfer the application from the terminal to the PLC’s internal RAM memory.

4 Declare the memory card in the configuration editor.

5 Select the PLC/Backup command.

6 Select the RAM->BACKUP zone transfer and click on OK.

Step Action

1 Insert the TSX MFP BAK 032P memory card into the PLC (the write protection 
lock must be set to ON).

2 Inserting the memory card automatically transfers its contents into internal 
RAM (and into EPROM FLASH: for the TSX 37-20).
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Notes on the 
PLC’s operating 
modes

At the end of transfer, with the Backup card in the processor, the PLC is forced to 
STOP even if the RUN AUTO option has been configured. The PLC can be set to 
RUN from the terminal, but after a power restoration the PLC starts systematically 
in forced STOP mode.

After removing the Backup memory card, the PLC performs a cold restart in RUN or 
STOP mode depending on the AUTO RUN configuration.

If internal word initialization on cold restart is not configured, the transfer from the 
Backup memory card into RAM retains the internal word values.
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Accessing a PL7 through a network

Procedure Carry out the following actions:

Network address 
syntax

The network address syntax is as follows:
l (network no. station no) module track no. PL7 address
l (network no. station no.)SYS

{network no. station no.} = network address and destination station on FIPWAY 
(this part is omitted if the PL7 to be accessed is not on the FIPWAY network).

PL7 module.track address = UNI-TELWAY address (module = 0 or 254, track no. 
= 0 terminal point or 1 for the communication card, PL7 address = 0 to 98).

SYS = access to the system gate (or UNI-TE server) of the destination PL7.

Note Using the number 254 as a position when communicating between slaves allows it 
to stay on the same UNITELWAY bus by optimizing exchange routing.

Example {0.2}0.1.3 = PL7 having 3 for an address on the Unitelway link of the module 0 com-
munication card, track 1 of station 2 on network 0.

SYS = default address of the PL7 physically linked to the  terminal.

Step Action

1 Select the command AP/Enter PL7 address.

2 Select the type of drivers (e.g. UNTLW01).

3 Enter the network address
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Memory Usage

At a Glance The memory usage function can be accessed via the PLC/Memory usage com-
mand or from theApplication properties screen.

It provides information on:
l PLC memory used (data, program, configuration and system),
l memory mapping for an application (internal memory and memory card).

"User data" zone This zone groups together the objects linked to software configuration data:
l Bits and I/O bits:

l %Mi bits,
l %Si bits,
l Input/output bits,
l Bits associated with Grafcet,  %Xi, %Xi,j,…

TSX37xx: zone set at 2560 bits and I/O bits outside the internal memory.
TSX57xx: zone in the internal memory that can be configured.

l Words:
l %MWi words,
l %SWi system words,
l Words linked to configured function blocks (%Ci:V, etc),
l Words associated with Grafcet, %Xi, T,  %Xi,j,T,…

l I/O data:
l Data used for managing I/O modules and I/O words (%IW, %QW, %MW).

l DFB:
l data for DFB type instances,
l PL7 internal management.

"User program" 
zone

This zone gives user program consumption details.
l Constants:

l constants %Kwi + display base (binary, etc.).
l Executable code:

l code linked to the user program,
l application EF code,
l DFB type code + initialization value.

l Comments and graphic information:
l user program decompilation information,
l information linked to EFs,
l information linked to DFBs.
Operate modes manual 09/2000 63



Managing applications
"Other" zone This zone summarizes consumption linked to the application configuration and ap-
plication structure.

The total of the values declared is equal to the total amount of memory available in 
the various memory spaces.

Mapping by memory type is displayed by positioning the mouse over the bars of the 
chart.
l Configuration.

l hardware configuration (I/O, FIP),
l software configuration (Timers, Registers, etc.),

l System:
l Stack of tasks, catalogs, etc.

"Optimize" 
command

The Optimize command is used to reorganize the memory structure where possi-
ble.

It is also used to remove EFs which are not used in the application from the memory.
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Sending a command to the PL7

Presentation The Command to a PL7 function is used to run (Run), stop (Stop) or initialize (Init) 
a PL7 application from the terminal in offline mode.

Procedure Carry out the following actions:

Step Action

1 Enter the communication driver type between the terminal and the PL7.

2 Enter the PL7’s network address.

3 Select the command Identify in order to establish communication with the tar-
get PL7.  The following parameters are supplied:
l  the type of processor,
l the current status of the PL7 (Run, Stop or Init),
l the name and version of the PL7 application,
l the date of the last modification,
l any comments.

4 Select the type of command (Run, Stop or Init).

5 Select the Send command.
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II
Configuration and Programming
Introduction

Subject of this 
part

This section describes how to configure the hardware devices TSX Micro/TSX Pre-
mium and how to program an application.

What’s in this 
part?

This Part contains the following Chapters:

Chapter Chaptername Page

4 TSX Micro and TSX Premium: Configuring 69

5 Program access 101

6 Programming in LD rung language 115

7 Programming instruction list in LIST language 151

8 Programming in Structured Text ST language 173

9 Programming in  Grafcet language 195

10 Editing variables 227

11 Function modules 245

12 DFB function blocks 259
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4
TSX Micro and TSX Premium: 
Configuring 
At a Glance

Subject of this
chapter

This chapter describes:
l How to configure the software application.
l How to configure the hardware application.

What’s in this 
Chapter?

This Chapter contains the following Sections:

Section Topic Page

4.1 TSX-Micro 71

4.2 TSX Premium 84
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TSX Micro/TSX Premium: Configuring the application
4.1 TSX-Micro

At a glance

Object of this 
section

This section describes:
l How to configure the software application with a TSX-Micro.
l How to configure the hardware application with a TSX-Micro.

What’s in this 
Section?

This Section contains the following Maps:

Topic Page

Accessing the application configuration 72

Choosing/Changing the processor 73

Configuring the processor 75

Configuring the module positions 78

Configuring inputs/ outputs for each module 80

Software configuration of the application 81

Configuring Grafcet objects 82
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Accessing the application configuration

Principles The configuration software displays the processor selected when the application 
was created.

The aim of this function is to: 
l replace the processor (if the one selected at the time of creation is not suitable),
l configure the processor,
l declare/parametrize the various input/output modules and integrated modules,
l enter the software configuration,
l enter the Grafcet configuration.

In online mode this function is used to:
l diagnose module faults,
l debug modules.

Procedure Carry out the following actions:

Note:

The Edit/Cancel modifications (CTRL+Z) command or the  icon cancels all 
modifications made since the last confirmation.

Step Action

1 From the Application Browser, double left click on the "Configuration" di-
rectory or position the cursor over it using the arrow keys and press right arrow.

2 Select:
l Hardware configuration to access the module racks,
l Software configuration  to define the application software parameters,
l Grafcet object configuration to define the grafcet  parameters specific to 

the application.

3 The configuration entered is confirmed by the Edit/Confirm command, the 

Confirm command from the contextual menu, or the icon
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Choosing/Changing the processor

Choosing the 
processor

 Choosing the processor is the first stage in setting up an application. This choice is 
reversible.
Carry out the following actions:

Changing the 
processor

The configuration editor provides assistance when attempting to change the proces-
sor. A message is sent out if the change is not authorized.

Carry out the following actions:

Step Action

1 Select the commandFile/ New from the PL7 home screen.

2 Select the PLC type >TSX MICRO.

3 Select the processor type -> TSX37xx Vyy.

4 If necessary, select a memory extension card (PCMCIA - if the processor sup-
ports it).

5 Specify whether or not your application contains Grafcet.

6 Click on OK.

WARNING

When changing to a version V3.x processor

Using aV3.x processor in an application that has previously been con-
figured with a lower processor version leads to an  irreversible change  
in the application structure.
This conversion involves:
l the creation of program structure in sections,
l the automatic creation of the Grafcet section when the initial program 

module is written in Grafcet language,
l an increase in the size of the application by approximately 100 bytes.

Failure to observe this precaution can result in severe injury or 
equipment damage.

Step Action

1 Select the Edit/Change processor command.

2 Select the required processor.

3 Select a memory card if necessary.

4 Confirm and then click on OK or press ENTER.
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Note:
It is possible to change the processor using the drop-down menu in the configuration 
editor.
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Configuring the processor

Procedure Carry out the following operations:

Step Action

1 From the application configurator select position 0.

2 Select Open module using the contextual menu or double click on the proces-
sor.

3 According to the application, enable the RUN/STOP input (See RUN/STOP 
input, p. 76).

4 According to the application, enable the  Alarm (See Alarm output, p. 76) out-
put.

5 According to the application, enable the Save program and first %MWi (See 
Saving/Restoring %MWi internal words, p. 76) input.

6  According to the application, enable Automatic start in RUN (See Automatic 
start in RUN, p. 76).

7 According to the application, enable the initialization of %MWi internal words 
on Cold restart.

8 Select the type of memory card for processors which have this option.

9 Select the type of MAST task execution:
l Cyclical
l Periodic: 1 to 255 ms (20 ms, default value). If the value is 0 execution will 

be cyclical.

10 Enter the MAST task watchdog (See WatchDog, p. 77) value: 10 to 500 ms 
maximum (250ms, default value).

11 According to the application, enter the FAST task period value: 1 to 255 ms 
maximum (5ms, default value).

12 According to the application, enter the FAST task watchdog value: 10 to 500 
ms maximum (100 ms, default value).

13

Confirm using the Edit/ Confirm (CTRL + W) command or using the icon . 
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RUN/STOP input The %I1.8 input parameters can be set to switch the PLC between RUN/STOP as 
follows:
l %I1.8 to 1 -> the PLC switches to RUN (program running),
l %I1.8 to 0 -> the PLC switches to STOP (program stops running).
This is taken into account on rising edge.

A STOP command by the %I1.8 input takes priority over a RUN command from a 
terminal or a network command.

A fault on the RUN/STOP input causes the machine to STOP.

Alarm output An alarm function can be assigned to the %Q2.0 output.

After setting the PLC in RUN mode, if no blocking faults are detected (PLC in STOP 
mode or output in fallback mode, %S9=1), the safety output is set to 1.

This output can be used in safety circuits external to the PLC. For example:
l to pace the supply of output pre-actuators,
l to pace the PLC supply.

As soon as a blocking fault appears, the safety output is set to 0.

Saving/
Restoring %MWi 
internal words

This function is only available on version V2.0 PL7s or later:
l Saving

To save internal words in Flash EPROM the application must be in STOP.
Saving %MWi internal words is always linked to an application program save.
It is triggered according to the selection made during configuration:
l by setting the discrete %I1.9 input to 1,
l by setting the bit 0 of %SW96 to 1.

l Restoring
The saved %MWi’s are transferred from internal flash EPROM memory to RAM 
memory on a cold restart.
To restore the %MWi internal words to internal RAM you need to deactivate the 
Reset %MWi on cold restart box in the processor configuration screen .

Automatic start 
in RUN

If this option is checked, the PLC will automatically switch to RUN on a cold start.

If there is no memory card, the PLC will start up using the contents of the processor’s 
internal RAM.

If a memory card is inserted, its contents determine the start up.
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WatchDog The duration of the master task operation when in cyclic or periodic mode, is con-
trolled by the PLC (watchdog) and must not exceed the value set out in the T max 
configuration (250ms default, 500ms maximum, rollover 10ms).

If this value is exceeded, an error is declared in the application, which stops the PLC 
immediately:
l TSX Micro: setting the %Q2.0 alarm output to 0 if it has been configured.

Execution monitoring:
l %S11: indicates that the watchdog has been exceeded. It is set to 1 by the sys-

tem when the cycle time exceeds the watchdog value.
l %SW11: contains the watchdog value (in ms).
l %S19 (periodic operation): indicates that the period has been exceeded. The 

system sets it to 1 when the cycle time exceeds the task period.
l %SW0 (periodic operation): this word contains the period value (in ms). It is ini-

tialized on cold restart by the value set during configuration. It can be modified by 
the user.
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Configuring the module positions

Introduction Editor: 

A standard format module takes up two positions.

A half format module takes up one position.

 The 0 position is allocated to the processor and to integrated modules (such as the 
TSX 37-22).

Procedure Carry out the following operations:

Notes:
If the module takes up 2 positions (as with all standard format modules), the soft-
ware automatically updates the position configuration.

If no input/output modules are declared in the configuration, or if there are any   for-
mat modules, the PL7 software gives access to the %Ix.0 to %Ix.15 bits and to the 
%Qx.0 to %Qx.15 outputs for each position (even if the half format module con-
cerned has less inputs/outputs).

0 3 5 7

TSX
3710

1

8642

Positions of standard format 
and semi format modules

Main rack Extension rack

Step Action

1 Select the position of the module to be configured (using the mouse or arrow 
keys).

2 Select the Edit/Add module command or double click on the position select-
ed. A dialogue box is displayed showing a list by family of the modules that can 
be configured for the selected position (standard format module or half format).

3 Select the family (using the mouse or arrow keys), the module (the TAB key is 
used to move between the different zones) and choose OK to confirm.
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If there are any standard format modules, the PL7 software gives access to the 
%Ix.0 to %Ix.31 input bits for odd positions and to the %Qx+1.0 to %Qx+1.31 output 
bits for even positions (even if the standard format module concerned has less in-
puts/outputs).
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Configuring inputs/ outputs for each module

Procedure Carry out the following actions:

Configuration 
context

The Configuration selection is used to set the module’s parameters.

Adjust can be selected for counting, movement and weighing modules and is used 
to:
l set initial parameter values offline,
l modify parameters on-line.

The Debugging selection (only accessible in on-line mode) is used, depending on 
the module to:
l display the status of the inputs,
l display the module diagnostics and the channels,
l perform output writing.

Step Action

1 Select the module to be configured (using mouse or arrow keys).

2 Select the command Services/Open the module or double click on the mod-
ule selected.
For integrated modules a window shows:
l the module reference and position,
l the configuration context (See Configuration context, p. 80) in progress.

3 Enter the parameters and confirm with the command Edit/ Confirm (CTRL + 
W). 
To find out about the various parameters, refer to the job headings concerned.
Depending on whether the command View/Module Zone is selected or not, 
the display is different.

4 Close the window by pressing (CTRL+F4) and parametrize the next module.
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Software configuration of the application

Procedure Carry out the following operations:

Maximum 
number of 
authorized 
objects

For each of the objects this number is:

Step Action

1 Double left click on the Configuration directory or select it using the arrow 
keys, then press right arrow.

2 Select the Software configuration directory.
Software configuration is used to set the following for the application:
l the number of different types of function blocks,
l the number of register words,
l the number of %M internal bits,
l the number of %M internal words,
l the number of %KW constants.

3 For each of the fields to be modified, select the field and then enter the required 
value (entry is controlled to prevent values greater than the maximum autho-
rized number (See Maximum number of authorized objects, p. 81)) from being 
entered. 

4 Confirm the configuration with the Edit/Confirm (Ctrl + W) command

Objects Maximum value

%TMi timers 64

%Ti Series 7 timers 64

%MNi monostables 8

%Ci counters 32

%Ri registers 4

%DRi drums 8

Number of words per register 255

%Mi internal bits depends on the size of memory available

%MWi internal words depends on the size of memory available

%KWi constants depends on the size of memory available
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Configuring Grafcet objects

Introduction Before configuring Grafcet objects the following action must be taken:
l when setting up the application you must specify that it will contain a Grafcet sec-

tion, otherwise you will not be able to access the Grafcet configuration editor,
l the processor version (See Processor version, p. 83) used must support Grafcet 

language.

Grafcet object configuration is used to set the following for the application:
l the number of steps,
l the number of active steps,
l the number of valid transitions.

Procedure Carry out the following actions:

Maximum 
number of 
authorized 
objects

For each of the objects this number is:

Step Action

1 Double left click on the Configuration directory or select it using the arrow 
keys, then press right arrow.

2 Select the Configure Grafcet Objects directory.

3 For each of the fields to be modified, select the field and then enter the required 
value (entry is controlled to prevent values greater than the maximum autho-
rized number (See Maximum number of authorized objects, p. 82)) from being 
entered). 

4 Confirm the configuration with the command Edit/ Confirm (Ctrl + W).

Objects Maximum values

Number of steps TSX3705/08/10: 1 to 96.
TSX3721/22: 1 to 128.

Number of active steps TSX3705/08/10: 1 to 96.
TSX3721/22: 1 to 128.

Number of valid transitions TSX3705/08/10: 1 to 192.
TSX3721/22: 1 to 256.
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Processor 
version

Compatibility table

V1.1 processor

This generation of processors does not support Grafcet.

V1.5, V2.0, V3.x, and V4.0 processors

If you are using Grafcet it must be declared when the application is set up.
It is not possible to change this option subsequently.
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4.2 TSX Premium

At a glance

Object of this 
section

This section describes:
l How to configure the software application with a TSX-Micro.
l How to configure the hardware application with a TSX-Premium.

What’s in this 
Section?

This Section contains the following Maps:

Topic Page

Accessing the application configuration 85

Configuring the racks 86

Configuring the supply modules 88

Choosing/Changing the processor 89

Configuration of the processor 91

Configuring the module positions 94

Configuring inputs/outputs for each module 96

Software configuration of the application 98

Configuring Grafcet objects 99
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Accessing the application configuration

Principle The configuration software displays a supply module and the processor selected 
when the application was set up.

The object of this function is to: 
l replace the processor (if the one chosen at the beginning is not right),
l configure the processor,
l declare/parametrize the various input/output modules and integrated modules,
l enter the software configuration,
l enter the Grafcet configuration.

In on-line mode this function is used to:
l diagnose module faults,
l debug modules.

Procedure Carry out the following actions:

Note:

The command Edit/ Cancel modifications (CTRL+Z) or the icon    cancels all 
modifications made since the last confirmation.

Step Action

1 From the Application browser, double left click on the repertoire "Configura-
tionor position the arrow keys on this and press the right arrow.

2 Select:
l Hardware configuration  to access the module racks,
l Software configuration  to define the software application parameters,
l Grafcet objects configuration to define the specific grafcet parameters for 

the application.

3 To confirm the configuration entered use the command Edit/Confirm or in the 

contextual menu Confirm or use the icon
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Configuring the racks

Introduction A rack with a 0 address is compulsory.  It contains the station processor.
Number of racks managed by the different processor types

For a station configured with TSX/PCX/PMX 57-2x/3x processors, it is not neces-
sary to use successive addresses. It is possible to configure one station with a rack 
with a 0 address and one rack with a 7 address.

A configuration with several racks must contain one rack that can be extended to a 
0 address.

Processor type Number of racks managed

TSX/PCX/PMX 57-1x Up to 2 racks

TSX/PCX/PMX 57-2x/3x Up to 16 racks
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Extension racks There are the following possibilities:

Note:

The button   only appears for version V3.3 processors or later and for extend-
ible racks.
Changing a V3.3 -> V3.0 processor can be refused if there are extension racks.

You want….. then….. and…..

adding a rack select an empty address 

  or the symbol    
(rack EX) then the command 
Edit/Add a rack

select the desired rack from 
the dialogue box displayed.

selecting a rack Click on the white rectangle 
containing the address of the 
rack or on the white rectangle 
associated with the EX rack, a 
dotted frame will surround the 
selected rack.

replacing a rack double click on the white rect-
angle containing the address 
of the rack or on the white 
rectangle associated with the 
EX rack

and select an extendible rack 
or not from the dialogue box 
displayed.

suppressing a rack select the rack press the Suppr key or select 
the command Edit/Sup-
press the rack (suppressiing 
the 0 rack is not possible.
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Configuring the supply modules

Introduction The supply does not necessarily occupy the first position in a rack (the position fur-
thest to the left). This position has no address.

Double format supplies occupy not only the first position but the 0 address position. 
In this case the processor is configured in the 1 address position.

Configuration There are the following possibilities:

You want….. then….. and…..

select a module click on the module.

adding a module select the extreme left position 
of the rack then the command 
Edit/ Add a module

select a module from the dia-
logue box displayed.

replacing a module select the module select a module from the dia-
logue box displayed (it is not 
possible to configure a double 
format supply if the position is 
already occupied).

suppressing a module select the module press the Suppr key or select 
the command Edit/Suppress 
the module.

moving a module select the module move the module without re-
leasing the mouse button (this 
action is possible if the fur-
thest left position in another 
rack is free).

copying a module select the module press the Ctrl key and move 
the module without releasing 
the mouse button (this action 
is possible if the furthest left 
position in another rack is 
free).
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Choosing/Changing the processor

Choosing the 
processor

 Choosing the processor is the first stage in setting up an application. This choice is 
reversible.
Carry out the following actions:

Changing the 
processor

The configuration editor provides assistance when attempting to change the proces-
sor. A message is sent out if the change is not authorized.

Step Action

1 Select the commandFile/ New from the PL7 home screen.

2 Select the PLC type>PREMIUM TSX.

3 Select the processor type -> TSX57xx Vyy.

4 Select an extension memory card if necessary (PCMCIA).

5 Specify (depending on the processor configured) whether or not your applica-
tion contains Grafcet.

6 Click on OK.

WARNING

When changing to a version V3.x processor

Using aV3.x processor in an application that has previously been con-
figured with a lower processor version leads to an  irreversible change  
in the application structure.
This conversion involves:
l the creation of program structure in sections,
l the automatic creation of the  Grafcet section when the initial pro-

gram module is written in Grafcet language.
l the automatic replacement of TSX SCY 21600 modules, if there are 

any in the configuration, with TSX SCY 21601 modules. 
l an increase in the size of the application by approximately 10%, 

which can cause the conversion to fail.

Failure to observe this precaution can result in severe injury or 
equipment damage.
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Carry out the following actions:

Note:
It is possible to change the processor using the drop-down menu in the configuration 
editor.

Step Action

1 Select the Edit/Change processor command.

2 Select the required processor.

3 Select a memory card if necessary.

4 Confirm and then click on OK or press ENTER.
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Configuration of the processor

Procedure  Carry out the following actions:

RUN/STOP input The input %I1.8 can be parameterized to control the PLC’s switching between RUN/
STOP in the following way:

Step Action

1 From the application configurator, select  position 0 or 1 from rack 0.

2 Select Open module from the context menu or double click on the processor.

3 Confirm, depending on the application, the RUN/STOP input (See RUN/STOP 
input, p. 91).

4  Confirm, depending on the application, the Automatic startup in RUN (See 
Automatic startup in RUN, p. 92).

5 Confirm, depending on the application, the memory protection, then, if need 
be, enter the input dedicated to this function.

6 Confirm, depending on the application, the initialization of internal words 
%MWi on Cold restart.

7 Select the type of memory card for processors with this option.

8 Select the type of MAST task execution:
l Cyclic
l Periodic: 3 to 255 ms (20 ms, default value).If the value is 0, execution will 

be cyclic.

9 Enter the value of the watchdog (See Watchdog, p. 92) of the MAST task: 10 
to 500 ms maximum (250ms, default value).

10 Enter, depending on the application, the value of the period of the FAST task: 
2 to 255 ms maximum (5ms, default value).

11 Enter, depending on the application, the value of the FAST task watchdog: 10 
to 500 ms maximum (100 ms, default value).

12 If necessary, select type of Fipio (See Fipio, p. 93) mode for the MAST task:
l Controlled mode:the task is timed by a period (MAST in periodic execu-

tion).
l  Free mode: the task controlled variables are scanned in "Optimal" mode, 

but the scanning period may be greater than the period of the task, while 
still less than the task watchdog.

13  If necessary, select type of Fipio mode for the FAST task (Controlled mode, 
Free mode).

14

Confirm using the command Edit/Confirm (CTRL + W) or using the icon . 
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l %I1.8 = 1 -> the PLC switches to RUN (program executes),
l %I1.8 = 0 -> the PLC switches to STOP (program stops executing).
Retrieval is rising edge.

A STOP command via %I1.8 input has priority over a RUN command via terminal or 
network command.

An error on the RUN/STOP input causes a switch to STOP.

Automatic 
startup in RUN

If this option is checked, the PLC will automatically switch to RUN during a cold start.

If there is no memory card, the PLC starts up according to the contents of the pro-
cessor’s internal RAM.
ee
If a memory card is inserted, it is the contents of the card which defines the startup.

Memory 
protection

This option enables the application contained in the PLC to be protected against any 
attempt to alter it.
The protection is activated by setting the PLC input dedicated to this function to 1.

Watchdog The period of master task execution, in cyclic or periodic operation, is controlled 
by the PLC (watchdog) and must not exceed the value defined in Tmax configuration 
(250ms by default, 500ms maximum, modulo 10ms).

If overflow should occur, the application is declared in error, which causes the PLC 
to stop immediately:
l TSX Premium: supply alarm relay set to 0

Execution monitoring:
l %S11: indicates a watchdog overflow, it is positioned to 1 by the system, when 

the cycle time becomes greater than the watchdog.
l %SW11: contains the value of the watchdog (in ms).
l %S19 (periodic operation): indicates a period overflow, it is positioned to 1 by 

the system, when the cycle time becomes greater than the task period.
l %SW0 (periodic operation): this word contains the value of the period (in ms), 

it is initialized on cold restart by the value defined at configuration, it can be 
changed by the user.
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Fipio The FIPIO bus allows 127 devices to be connected to the connection point which is 
built into the processor.

The software PL7-Junior or PL7-PRO and the processors,  TSX P 5725x / 35x / 
45x, TPCX 57351x, and TPMX 57352 /452 are used to configure and monitor the 
connected devices.

These devices can be any of the following:
l FIPIO agent PLCs,
l TBX TOR or ANA,
l Momentum TOR or ANA,
l CCX-17,
l ATV16/58/66,
l AS-i gateway TBX SAP10,
l devices which comply with FIPIO standard profiles,
l PCs.
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Configuring the module positions

Positioning a 
module

Carry out the following actions:

Notes:
Double format modules (for example the TSX CAY41 movement module) only ap-
pear in the module list when both the position selected, and the position before or 
after it (depending on type) are not occupied.

Position 0 can only be occupied by a double format supply module or processor.

Moving a module Carry out the following actions:

Notes:
Objects linked to the module at the former address are:
l deleted then recreated automatically at the new address,
l replaced in the program and variables editor (except for animation tables and 

runtime screens) by objects at the new address.

Symbols associated with objects from the moved module are reattached to the ob-
jects at the new address.

The module that has been moved keeps all its parameters.

The processor can only be moved into positions 0 and 1 of rack 0.

Step Action

1 Select the position of the module to be configured (using the mouse or arrow 
keys). (The PgUp, PgDn, TAB and SHIFT+TAB keys are used to select a dif-
ferent rack).

2  Select the Edit/Add module command or double click on the position selected 
(ENTERkey). A dialogue box is displayed showing a list by family of modules 
that can be configured for the selected position

3 Select the family (using the mouse or arrow keys), the module (the TAB key is 
used to move between the different fields) and confirm by OK.

Step Action

1 Select the required module.

2 Move it to the new position while keeping  the mouse button held down or se-
lect the Edit/Move a module command.

3 Select the Edit/Confirm command for the modifications to be taken into ac-
count.
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If you move a discrete module whose channel has been configured in RUN/STOP 
mode, the address of the RUN/STOP bit is not modified. You must ensure that the 
RUN/STOP input corresponds to an valid address for a discrete input.

When the module addresses are used in an EF (e.g.  SEND_REQ, READ_VAR, 
etc.), they are not updated automatically.

Copying a 
module

Carry out the following actions:

Notes:
The objects associated with a module with the old address are copied to the new 
address.
The module that has been copied keeps all its parameters.
Duplicating a module associated with an event (at least one module channel is as-
sociated with oneevent) is impossible. One event cannot be associated with several 
channels/modules at the same time.

Deleting a 
module

Carry out the following actions:

Notes If no input/output modules are declared in the configuration, or if there are any   for-
mat modules, the PL7 software gives access to the %Ix.0 to %Ix.15 bits and to the 
%Qx.0 to %Qx.15 outputs for each position (even if the half format module con-
cerned has less inputs/outputs).

If there are any standard format modules, the PL7 software gives access to the 
%Ix.0 to %Ix.31 input bits for odd positions and to the %Qx+1.0 to %Qx+1.31 output 
bits for even positions (even if the standard format module concerned has less in-
puts/outputs).

Step Action

1 Select the required module.

2 hold down Ctrl and drag the copy to the new position or select the Edit/Copy 
Module command.

3 Select the Edit/Confirm command for the modifications to be taken into ac-
count.

Step Action

1 Select the required module.

2 Select Edit/Delete or press the Del key.

3 Select the Edit/Confirm command for the modifications to be taken into ac-
count.
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Configuring inputs/outputs for each module

Procedure Carry out the following actions:

Special case for 
PCMCIA 
communication 
modules

Carry out the following actions:

Special case for 
FIPIO 
communication 
modules

Carry out the following actions:

Special case for 
integrated 
Adjustment 
modules (PMX 
57102)

Carry out the following actions:

Step Action

1 Select the module to be configured (using mouse or arrow keys).

2 Select the command Services/Open the module or double click on the mod-
ule selected.
A window is displayed indicating:
l the module reference and position,
l the configuration context (See Configuration context in progress , p. 97) in 

progress.

3 Enter the parameters and confirm with the command Edit/Confirm (CTRL + 
W). 
To find out about the various parameters, refer to the job headings concerned.
Depending on whether the command View/ Module Zone is selected or not, 
the display is different.

4 Close the window by pressing (CTRL+F4) and parametrize the next module.

Step Action

1 Select the "Comm" position.

2 Double click or move the up/down arrows and press the ENTER key.

Step Action

1 Select the "FIPIO" position.

2 Double click or move the up/down arrows and press the ENTER key.

Step Action

1 Select the "Loops" position.

2 Double click or move the up/down arrows and press the ENTER key.
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Configuration 
context in 
progress 

The Configuration selection is used to set the module’s parameters.

Adjust can be selected for counting, movement and weighing modules and is used 
to:
l set initial parameter values offline,
l modify these parameters on-line.

The Debugging selection (only accessible in on-line mode) is used, depending on 
the module to:
l display the status of the inputs,
l display the module diagnostics and the channels,
l perform output writing.
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Software configuration of the application

Procedure Carry out the following operations:

Maximum 
number of 
authorized 
objects

For each of the objects this number is:

Step Action

1 Double left click on the Configuration directory or select it using the arrow 
keys, then press right arrow.

2 Select the Software configuration directory.
Software configuration is used to set the following for the application:
l the number of different types of function blocks,
l the number of register words,
l the number of %M internal bits,
l the number of %M internal words,
l the number of %KW constants.

3 For each of the fields to be modified, select the field and then enter the required 
value (entry is controlled to prevent values greater than the maximum autho-
rized number (See Maximum number of authorized objects, p. 98)) from being 
entered. 

4 Confirm the configuration with the Edit/Confirm (Ctrl + W) command

Objects Maximum value

%TMi timers 255

%Ti Series 7 timers 255

%MNi monostables 255

%Ci counters 255

%Ri registers 255

%DRi drums 255

Number of words per register 255

%Mi internal bits depends on the processor

%MWi internal words depends on the size of memory available

%KWi constants depends on the size of memory available
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Configuring Grafcet objects

Introduction Before configuring Grafcet objects   the following action must be taken:
l the processor version (See Processor version, p. 100) used must support Grafcet 

language,
l creation of the Grafcet section for >= V3.x processors.

Grafcet object configuration is used to set the following for the application:
l the number of macro steps,
l the number of (Chart + Macro steps),
l the number of active steps,
l the number of valid transitions.

Procedure Carry out the following actions:

Maximum 
number of 
authorized 
objects

For each of the objects this number is:

Step Action

1 Double left click on the Configuration directory or select it using the arrow 
keys, then press right arrow.

2 Select the Configure Grafcet Objects directory.

3 For each of the fields to be modified, select the field and then enter the required 
value (a check is made so that entries higher than the maximum authorized 
number (See Maximum number of authorized objects, p. 99) cannot be made). 

4 Confirm the configuration with the command Edit/ Confirm (Ctrl + W)

Objects Maximum values

Number of steps (Chart) 250

Number of Macro steps 64

Number of steps in Macro steps 250 per Macro step

Number of steps (Chart + Macro step) 1024

Number of active steps 250

Number of valid transitions 400
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Processor 
version

Compatibility table:

V1.5 and V2.0 processors

If you are using Grafcet it must be declared when the application is set up.
This option cannot subsequently be changed.

V3.x and V4.0 processors

The choice of whether to use Grafcet is made when creating the Grafcet section.
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Program access
Introduction

Subject of this
chapter

This chapter describes how to: 
l  Creating a program module. 
l Access to a program module. 
l Modifying a module program’s execution order. 

What’s in this 
Chapter?

This Chapter contains the following Maps:

Topic Page

Introducing the application browser 102

Creating or importing an LD, IL, ST section 105

Creating or importing a Grafcet section 107

Creating or importing a subroutine (SR) 109

Creating or importing an event 110

Editing/emptying/suppressing a section, an event or a sub-program 111

Modifying the section execution order 112

Accessing the runtime screens editor 113
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Introducing the application browser

General points The application browser shows the contents of a PL7 application in two forms:
l the structure view,
l the function view.

Description The structure view

The structure view shows the contents of a PL7 application. It is used to navigate 
within an application and provides direct access:
l to configurations,
l to the program,
l to the DFBs contained in the application,
l to the data,
l to the animation tables,
l to certain parts of the documentation file (general information, title pages),
l to tools such as runtime screens.
Section execution order corresponds to display order, and this order can be modi-
fied.

The function view

The function view is a representation of the application split up into functional mod-
ules.
This split does not take the order of their execution by the PLC into account.

Note: the default PL7 application directory is called STATION. This name can be 
modified in the Application propertiesdialog box.

WARNING

Only PL7 PRO can be used to set up functional modules on TSX/PMX/
PCS57 PLCs.

Failure to observe this precaution can result in severe injury or 
equipment damage.
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Navigation 
between function 
view and 
structure view

The different browser application icons

Application 
properties

The Properties function (which can be accessed from the Functional View of the 
Application Browser by right clicking on the application directory) at application 
level is used to:
l provide the user with information on the current application,
l manage certain application parameters.

General tab
l application name (the application’s default name is STATION),
l type of processor used (cannot be modified),
l version number (0 to 127) and revision number (0 to 255) manually managed by 

the user or automatically managed by the system on each save when a modifica-
tion has been made

l comments,
l save.

Protection tab
l application protection.

Identification tab
l creation date,
l date of last update,
l application ID.

Diagnostics tab
If the box is checked, the alarms generated by the diagnostics DFBs are saved in 
the diagnostics buffer and can be viewed with the runtime screen viewer.

  Is used to display the application structure view.

  Is used to display the application function view.

  Is used to display the structure and function views in series.

  Is used to display the structure and function views in parallel.
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Identification, 
application IDs

This information can be accessed via theIdentification tab.

The application is identified by a series of 8 numbers between 0 and 65535. Each of 
these represents the signature of an application segment.
These signatures, which are automatically generated by the system, are used to au-
thenticate a given status of the application.
Each development of the application results in the modification of one or more sig-
natures.

Numbers and designations:

Number Designation

0 Station ID (global application).

1 Local I/O configuration ID.

2 Remote I/O configuration ID.

3 PL7 application ID (code).

4 Reserved.

5 ID of constants.

6 Reserved.

7 Reserved.
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Creating or importing an LD, IL, ST section

At a Glance Creating a section is authorized in offline and online mode with the PLC in Run or 
Stop mode.

Importing a section is authorized in offline and online mode with the PLC in Stop 
mode.

Section 
properties

A section’s properties are as follows:
l section name,
l associated task (only the MAST task supports Grafcet language),
l programming language used,
l execution condition (modifiable),
l comments,
l name of any associated functional module for PL7 Pro.

Display or 
modify a 
section’s 
properties

 Carry out the following steps:

Note: 
l the language can be modified if the section is not programmed,
l the language for a Grafcet section cannot be modified.

Step Action

1 go to the section (in the Application Browser of the Structure view) and se-
lect the Properties contextual menu (right click).

2 Carry out any necessary modifications.

3 Click on OK.
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Creating a 
section

Carry out the following actions:

Importing a 
section

Carry out the following actions:

Step Action

1 Left click on the Section directory for the required task or position the cursor 
over it using the arrow keys.

2 Via the contextual menu or using the Shift+F10 keys select Create.

3 Fill in the name: maximum 16 characters.

4 Select the language you would like to use to program the section.

5 Specify the Type of Protection:
l no protection,
l write protection,
l read/write protection.

6 Establish or if applicable modify the execution condition.

7  Where applicable select the functional module to be associated.

8 Where applicable enter the comment (250 characters max.).
This comment can be modified from a section’s "Properties" dialog box.

9  Click on OK.

Step Action

1 Left click on the Section directory of the required task or position the cursor 
over it using the arrow keys.

2 Via the Context menu, the File menu or Shift+F10, select Import.

3 Select the file relating to the section to be imported.

4 Confirm with Open.
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Creating or importing a Grafcet section

At a Glance A Grafcet section can be created in offline and online mode with the PLC in Run or 
Stop mode.

Importing a section is authorized in offline and online mode with the PLC in Stop 
mode.

By default the creation of a Grafcet section generates three directories. These cor-
respond to:
l preliminary processing (Prl),
l sequential processing (Chart),
l posterior processing (Post).

The creation of a macro-step generates an additional directory.

PRL, POST 
Properties

The properties are as follows:
l name,
l associated task,
l associated section,
l name of any associated functional module for PL7 Pro,
l programming language used (the language can be modified if the module is not 

programmed),
l programmed attribute.

CHART, XM 
Properties

The properties of a Grafcet module or macro-step are as follows:
l module or macro-step name,
l number of steps configured (during software configuration),
l programmed status (if the graph or macro-step are programmed),
l called status if the macro-step is called in the Chart,
l name of any associated functional module for PL7 Pro,
l a comment (max. 250 characters) visible while editing the documentation file.

For a macro-step:
l macro-step address and symbol,
l a comment associated with the macro-step (defined using the variable editor).
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Creating a 
section

Carry out the following actions:

Notes:
A Grafcet section may not be created if the configuration is in the process of being 
modified.

A Grafcet section may not be deleted:
l  if a section module is in the process of being edited,
l or if the configuration is in the process of being modified.

Importing a 
section

Carry out the following actions:

Step Action

1 Position the cursor over the section directory for the MAST, or FAST task using 
a left mouse click or the arrow keys.

2 Using the contextual menu or the Shift+F10 keys select Create.

3 Enter the Name, 16 characters maximum.

4 Select the language Grafcet (non modifiable).

5 Specify the type of protection:  
l no protection,
l write protection,
l read/write protection.

6 Establish or if applicable modify the execution condition.

7 Where applicable select the functional module to be associated.

8 Where applicable enter a comment (250 characters max.).
This comment can be modified from the Properties dialog box of a section.

9 Click on OK.

Step Action

1 Position the cursor over the section directory for the MAST, or FAST task using 
a left mouse click or the arrow keys.

2 Using the File menu, the contextual menu or the Shift+F10 keys, select Im-
port.

3 Select the file relating to the section to be imported.

4 Confirm with Open.
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Creating or importing a subroutine (SR)

At a Glance Creating a subroutine is authorized in offline and online mode with the PLC in Run 
or Stop mode.

Importing a subroutine is authorized in offline and online mode with the PLC in Stop 
mode.

SR properties The properties are as follows:
l name,
l associated task,
l programming language used (the language can be modified if the module is not 

programmed),
l programmed attribute,
l called or non-called attribute in the task,
l a comment associated with the subroutine (defined using the variable editor).

Creating a 
subroutine

Carry out the following actions:

Importing a 
subroutine

Carry out the following actions:

Note A subroutine can be called from any section of its associated task, or from other sub-
routines of that task.

Step Action

1 Left click on the SR directory of the required task or position the cursor over it 
using the arrow keys.

2 Using the contextual menu or the Shift+F10 keys select Create.

3 Select the language in which the SR is to be programmed. 

4 Click on OK.

Step Action

1 Left click on the SR directory of the required task or position the cursor over it 
using the arrow keys.

2 Using the contextual menu, the File menu or the Shift+F10 keys select Import.

3 Select the file relating to the SR to be imported.

4 Confirm with Open.

5 Enter the SR number.

6 Click on OK.
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Creating or importing an event

At a Glance Event creation is authorized in offline and online mode, with the PLC in Stop mode.

Importing an event is only authorized in offline mode.

Event Properties The properties are as follows:
l name,
l associated task,
l name of any associated functional module for PL7 Pro,
l programming language used (the language can be modified if the module is not 

programmed),
l programmed attribute,
l called or non-called attribute in the task.

Creating an 
event

Carry out the following actions:

Importing an 
event

Carry out the following actions:

Step Action

1 Left click on the Event directory or position the cursor over it using the arrow 
keys.

2 Using the contextual menu select Create.

3 Select the language in which the event is to be programmed. 

4 Where applicable select the functional module to be associated.

5 Click on OK.

Step Action

1 Left click on the Event directory or position the cursor over it using the arrow 
keys.

2 Using the contextual menu or the File menu, select Import.

3 Select the file relating to the event to be imported.

4 Confirm with Open.

5 Enter the event number.

6 Where applicable select the functional module to be associated.

7 Click on OK.
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Editing/emptying/suppressing a section, an event or a sub-program

Editing Carry out the following:

Emptying Carry out the following:

Suppressing Carry out the following:

Note:
It is not possible to perform a suppression operation on an event task.

Step Action

1 Select the module (section, sub-program, event) required using the mouse or 
the arrow keys. 

2 Edit the module using the command contextual menu Open or double click or 
key ENTER.

Step Action

1 Select the module (section, sub-program, event task) required using the 
mouse or the arrow keys.

2 Select Edit/Empty, or use the command contextual menu Empty, or 
(Shift+F10) Empty.

3 Confirm with YES.

Step Action

1 Select the module (section, sub-program) required using the mouse or the ar-
row keys.

2 Select Edit/Suppress, or on the command contextual menu key Suppress, or 
(Shift+F10) Suppress.

3 Confirm with YES.
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Modifying the section execution order

Principles This action can be carried out from within the same task from the structure view.

It is done in offline or online mode with the PLC in Stop mode. 

Procedure Carry out the following actions:

Step Action

1 Left click (keeping the button held down) on the icon of the section to be 
moved.

2 Move the section to the desired place.

WARNING

Running the program.

The program runs in the order shown in structure view.

The distribution of the sections, events and Grafcet modules in the var-
ious functional modules has no impact on the running of the program. 

Failure to observe this precaution can result in severe injury or 
equipment damage.
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Accessing the runtime screens editor

At a Glance Using PL7 you can access the runtime screens editor.

How to access 
the runtime 
screens editor

There are two potential scenarios:
l The application does not contain runtime screens:
Do the following:

l The application already contains runtime screens:
First scenario:

Step Action

1 Open the Application Browser.

2 Double click on the Runtime screens directory from the structure view:
Result: The Runtime screens editor opens on a blank page, ready for the cre-
ation of a new screen or message.

Step Action

1 Open the Application Browser.

2 Double click on the Runtime screens directory from the structure view.
Result: the editor appears, displaying the last screen open before the previous 
save: 

Runtime Screens: BLEND_PRODUCTS - Product - Blend - Titration

1

0

1

0

ie_1 Tré

eur

Screens Messages Objects

7 - System bit
6 - Grafcet

3 - Read_me

DFB BEHAVIOR

2 - Screen_ monitoring

4 - DFB_Screen - behavior
5 - Information_on_DFB_Debug

8 - Monitoring_mixer
DIAGNOSTICS_APPLICA

TITRATION_PRODUCTS

SYSTEM INFORMATION

Screen
WELCOME!

1 - Welcome_screen

0 - Product_Blend_Titration
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Second scenario:

Step Action

1 Open the Application Browser.

2 Double click on the desired screen or message from the structure or func-
tion view.
Result: the editor displays the desired element immediately: 

Runtime Screens: TITRATION_PRODUCTS - Product - Blend - Titration

1

0

1

0

ie_1 Tré

eur

Screens Messages Objects

7 - System bit
6 - Grafcet

3 -Read_me

DFB BEHAVIOR

2 - Screen_monitoring

4 - DFB_Screen - behavior
5 - Information_on_DFB_Debug

8 - Monitoring_mixer
DIAGNOSTICS_APPLICATION

TITRATION_PRODUCTS

SYSTEM INFORMATION

Screen
WELCOME!

1 - Welcome_screen

0- Product_Blend_Titration
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Programming in LD rung language
Introduction

Subject of this
chapter

This chapter reminds you of the structure of a program in rung language.

It describes: 
l How to create a program.
l How to use the different functions offered by the editor.
l How to manage the different modules making up the application.

What’s in this 
Chapter?

This Chapter contains the following Maps:

Topic Page

Structure of a program in Ladder language 117

Creating a Ladder program 119

Specific input 121

Modifying a network of contacts 122

Displaying variables as symbols or addresses 127

Information box 129

 Online symbolization 130

Input of a predefined function block (Ladder editor) 131

Function library 134

Operate block entry 136

Horizontal and vertical block entry 138

Assisted entry of a library function or of an instance of DFB type (Ladder editor) 139

Direct access to a subroutine 142

Replacing a variable in the application 143

Cross Referencing a variable in an application 145
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 Programming in rung language
Animation of the Ladder program elements 148

Printing of a program 149

Export/Import of source files 150

Topic Page
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 Programming in rung language
Structure of a program in Ladder language

Principal  A program written in ladder language is composed of a series of networks executed 
sequentially by the PLC.

Laid out between two potential bars, a network is a group of graphical elements 
linked to each other by horizontal and vertical links. These elements represent:
l The PLC’s inputs/outputs (push-buttons, sensors, relays, indicators…).
l Automation functions (timers, counters…).
l Arithmetic and logical operations and transfer operations.
l The PLC’s internal variables.

Each network (known as a Rung) is made up of:
l A  label input area (cell situated in the top left of the rung).
l A comment input area (first line to the right of the label).
l A (Test and Action) input area for graphical elements:

l 7 lines and 11 columns (maximum size) for a level L1 application.
l 16 lines and 11 columns (maximum size) for a level L2 application

The Test area (columns 1 to 10) accommodates:
l Contacts.
l Function blocks.
l Comparison  blocks.

The Action (column 11) accommodates:
l Coils.
l Operate blocks.
Operate modes manual 09/2000 117



 Programming in rung language
Example Network (Rung). 

S.F3 S.F4 S.F5S.F2F12F11F10F9 F7 F6 F4 F3 F2
P S R OPER COHP COHP

H V
 F5

N

%I 1.1

 F8

%1 (*Verifying start group authorization*)
CommentLabel

2- Place element
     on the input grid

1- Select element from the
     graphics palette
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Creating a Ladder program

Procedure Carry out the following actions:

Step Action

1 Creating or importing an LD, IL, ST section, p. 105.

2 Enter the label %Li (optional).
Double click on the label area, or put the cursor in the area and press the 
Space bar, then confirm using Enter.

3 Enter the comment (optional).
Double click on the comment area, or put the cursor in the area and press the 
Space bar, then confirm using Enter.

4 Enter the graphical elements:

Using the mouse:
1.  Click on the graphical element situated in the graphical palette.
2.  Click on the grid at the required place.
3.  Enter the corresponding variable (by default enter with comment mode is 
active) and confirm using ENTER. 

Using the keyboard:
1. Move the cursor over the grid to the required place.
2.  Press the function key corresponding to the graphical element situated in 
the graphical palette to be inserted.
3.  Enter the corresponding variable (by default enter with comment mode is 
active) and confirm using ENTER.

4.  Confirm the networks of contacts using the ENTER key, or using the com-

mand Edit/Confirm or using the icon  

 F4 F3 F2
P

 F5
N

  F9 F10 F11
S

F12
R

I F2
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Moving within 
the editor

The possible moves are:
l From cell to cell: arrow keys.
l To the first column of the Rung: Home key.
l To the last column of the Rung: End key.
l To the next page: Page Down key.
l To the previous page: Page Up key.
l To the start of the module: Ctrl+Home keys.
l To the end of the module: Ctrl+End keys.

Notes The software offers 2 input modes for a network of contacts:
l Without comments:  allows you as a first step to build the network of contacts 

without commenting the graphical elements and to comment them once the 
graphics are completed.

l With comments: menu Edit/Enter with comments. 

If an error is detected during validation, the rung stays red, if none are detected, the 
variables associated to the graphical elements are blue.
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Specific input

Input/Deletion of 
the vertical links.

Select the cell situated at the top and to the right of the connection then click on the 

key F7 or click on the icon  and position the cursor in the created cell

Input/Deletion of 
horizontal 
connections

Input: 
Select the cell where the link must be positioned and then click on the key F6 or F8 

or click on the icons  and position the cursor in the created cell.
Deletion:
select the required cell or cells then press the key Del or on the Contextual menu 
choose the command Delete.  

Inputting the 
codes: HALT, 
RETURN and 
CALL

Inputting instructions HALT (end of program), RETURN (return to the calling pro-
gram), CALL (subroutine call) operates following the procedure:

Step Action

1 Click on the icon  positioned in the graphic palette, the choice window appears.

2 Select the required code and confirm with ENTER.

3 Place the cursor symbolizing the chosen code in the zone Action and click (in 
the case of a keyboard entry, the cursor should be positioned in the Action 
zone beforehand).

4 With codes, confirmation is direct HALT and RETURN. For the call, input the 
SR number (sub-routine created beforehand) and confirm with ENTER.

HALT
CALL
RETURN
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Modifying a network of contacts

Accessing a 
network (Rung)

The program module being displayed, select the command Edit/Go to/Rung 

(Crtl+A) or the icon .
The possible choices are as follows:

The  Move zone allows a movement relative to TOP/BUTTOM/%Li.

Selecting one or 
several 
networks (Rung)

The possible choices are as follows:

Note:
The display of each selected rung is implemented by means of a rectangle equipped 
with 8 handles.

Select in the label field… position…

TOP at the beginning of the program module.

BUTTOM at the end of the program module.

%Li at the corresponding label number.

Select… by… or…

one network positioning the cursor over the Rung 
and selecting the command Edit/
Rung selection mode.

by clicking to the left of the gray ver-
tical bar.

several net-
works

1. positioning the cursor on the first 
or the last Rung to be selected and 
by selecting the command Edit/
Rung selection mode.

2. then by moving the mouse while 
keeping the left button down to se-
lect the other rungs.

by clicking to the left of the gray ver-
tical bar.

by pressing the SHIFT key and the 
arrow, Page Up or Page Down keys.
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Selecting one or 
several graphical 
elements

This function supports operations on elements such as cut, copy, paste, move, de-
lete, initialize an animation table or initialize a table of cross references.
The possible choices are as follows:

Note:
Acknowledgement of an element is shown by a rectangle equipped with 8 handles.

Modifying a 
network (Rung)

Modifying a variable:

Select… by… or…

an element left mouse click on the element positioning the cursor over it using 
the arrow keys.

a group of ele-
ments

a left mouse click on the start cell 
(keep the mouse button down) then 
move the cursor towards the end 
cell,

Step Action

1 Position the cursor over the variable to be modified then press the Space bar 
or double click on the variable to be modified (except for SRs and DFB types).

2 Enter the modification (Escape cancels the current modification) and confirm 
the entry using ENTER.

3

Confirm the modification using the keys (CTRL+W) or click on the icon . 
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Modifying a contact in a network:

Canceling a modification:
To cancel a current modification on a network of contacts, select the command Edit/

Cancel modifications or click on the icon .

Deleting an element from a rung:
The command Edit/Delete or the Delete key deletes the element and/or rung se-
lected.

Moving to a current modification which is not visible on the screen:
Select the command Edit/ Go to current modification .

Step Action

1 Using the keyboard:
Position the cursor over the cell containing the element to be modified.

Using the mouse:
Select the graphical element in the graphical palette by clicking on the required 
element.

2 Using the keyboard:
Select the graphical element in the graphical palette using the keys F2 to F12 
and SHIFT+F2 to F8 and confirm the entry using ENTER.

Using the mouse:
Position the cursor over the cell containing the element to be modified and con-
firm using ENTER.

3 Confirm using ENTER or select the command Edit/Confirm (CTRL+W)  or 

click on the icon .
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Moving an 
element in a 
network (Rung)

Carry out the following actions:

Cutting/Copying/
Pasting one or 
several graphical 
elements

Carry out the following operations:

Step Action

1 Using the keyboard:
Position the cursor over the cell containing the element to be moved.

Using the mouse:
Select the element to be moved, and maintain the selection.

2 Using the keyboard:
Select Move using keyboard from the Edit menu or CTRL+L then move the 
cursor by means of the arrow keys towards the destination cell(s) and confirm 
using ENTER.

Using the mouse:
Move the element’s ghost to the required cell.

3 Confirm using ENTER or select the command Edit/Confirm (CTRL+W) or 

click on the icon 

To… you must… the selection…

copy one or several 
consecutive objects

select the element(s) to be copied and select 
the command Edit/Copy (CTRL+C) 

is placed on the Win-
dows clipboard.

paste one or several 
consecutive ele-
ments contained on 
the clipboard

select the cell which is the start point from 
which the element(s) contained on the clip-
board are to be pasted and select the com-
mand Edit/Paste (CTRL+V) 

is kept on the Win-
dows clipboard.

cut one or several 
consecutive ele-
ments and place 
them on the clip-
board

select the element(s) to be cut and  select the 
command Edit/Cut (CTRL+X) 

is placed on the Win-
dows clipboard.
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Cutting/Copying/
Pasting one or 
several 
consecutive 
networks 
(Rungs)

Carry out the following operations:

Note:
The Cut/Copy/Paste function works in the same way for a selection of multi-Rungs 
and between program modules.

Inserting a 
network (Rung)

To insert a rung between two networks of contacts (the inserted network is placed 
on top) or to place a rung at the top of the program module (TOP), after displaying 
the program module carry out the following actions:

To… you must… the selection…

copy one or several 
consecutive Rungs

select the Rung(s) to be copied and select the 
command Edit/Copy (CTRL+C)

is placed on the Win-
dows clipboard.

paste one or several 
consecutive Rungs 
contained on the 
clipboard

select the Rung which is the start point from 
which the Rung(s) contained on the clipboard 
are to be pasted and select the command 
Edit/Paste (CTRL+V)

is kept on the Win-
dows clipboard.

cut one or several 
consecutive Rungs 
and place them on 
the clipboard

select the Rung(s) to be cut and  select the 
command Edit/Cut (CTRL+X)

is placed on the Win-
dows clipboard.

Step Action

1 Select the command Edit/Select rung or point directly to an element of the 
rung using the mouse.

2 Select the command Edit/Insert rung (CTRL+l).

3

Enter the rung and confirm using CTRL+W or click on the icon .
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Displaying variables as symbols or addresses 

Procedure Carry out the following actions:

Note:

It is possible to run the language editor from the Options menu in:
l addresses view,
l symbols view,
l symbols&addresses view (for the Ladder editor only).

Example of 
display

Ladder editor used with the 3 views.  

Step Action

1 Open the program module with right click + Open or with a double click.

2 Select the command:
l View/Addresses to display the variables as addresses.
l View/Symbols to display the variables as symbols.
l View/Symbols&addresses to display the variables as symbols/addresses 

(Ladder editor only).
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Note If a symbol or address has more than 8 characters, the display can be truncated. 
Select the element, which is then displayed in full in the status bar. You can also use 
the Information box.

The View/Collapsed command is used to reduce the size of the window whilst 
maintaining the same level of information.

The View/Normal command allows you to return to the normal sized window.
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Information box

Functions This box, which can be accessed from all language objects, displays the symbols, 
address and comments for the selected object (except for the operate blocks and 
horizontal comparison) in an integrated format.

Display table according to object:

How to access 
the object 
information box

 Carry out the following steps:

Note The information box remains visible when it is not explicitly closed by the user. The 
contents of the  Information box is updated according to the current selection.

Single object  Complex object (operate 
block, comparison and hori-
zon block)

l symbolic format in blue
l constructor name in black,
l associated comments in 

green.

l symbolic format in blue
l constructor address in black,

Step Action

1 In the LD language editor, select the object.

2 Click on the right mouse button (contextual menu) and then select Informa-
tion, or select theView → Informationcommand.
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 Online symbolization

Principal Online symbolization allows you, at the time of input of a Ladder, List, Structured 
Text program, to immediately (without opening the data editor) associate: 
l an address to a new symbol,
l a symbol to a non symbolized address.

Procedure With the Ladder editor, start at Step 1, with the Structured Text or List editors, go 
straight to step 2.

Step Action

1 Select the cell where the variable is situated.

2 Select the variable (highlight it).

3 Right mouse click on the variable and select Associate Symbol&Address.

4 Enter the address or symbol and the comment.
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Input of a predefined function block (Ladder editor)

Procedure From within the language editor, carry out the following actions:

Step Action

1 Using the mouse:

From the graphical palette, select the element .
Using the keyboard:
Select the destination cell with the help of the arrow keys, and press the keys 
(Shift+F7).

2 Using the mouse:
Select the item SFB (only TSX Premium), and select the required function 
block, then click in the destination cell (Test zone) to position the function block. 
Using the keyboard:
Select the item SFB with the help of the arrow keys and accept with ENTER 
(only TSX Premium), then select the function block using the arrow keys and 
accept with ENTER.

3 Input the number of the function block and confirm with ENTER .
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Function blocks The different function blocks are:

Function blocks Syntax

PL7-3 timer (%Ti) Timer block: 

TP/TON/TOF timer (%TMi) Timer block: 

Up/Down counter (%Ci) Block Up/down counter 
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Monostable (%MNi) Monostable block: 

Register of FIFO/LIFO words (%Ri) Register block: 

Drum-DRUM (%Dri) Drum controller block: 

Function blocks Syntax
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Function library

Introduction The functions library brings together all the associated information and utilities con-
cerning functional elements (EFtab) and DFB function blocks (DFB tab).
Two access modes exist:
l in consult mode,
l by calling a function from the editor.

Consulting an EF To access the library, select Library from the Tools menu then choose the EF tab 
(default selection).
The functions library screen presents:
l The list of available families defined by:

l family name,
l the library version Lib.V,
l the version of families used in the current application App V (open station 

only).
l The list of functions associated with each family defined by:

l function name,
l comments.

Note: In order to display an entire set of truncated comments (>>symbol at the end 
of the line), double click on the function or place the cursor above and use the 
Space bar. 
l  The parameters of the selected function, defined by:

l  name,
l type (eg: DWORD),
l kind,
l comments,
l the result of a function (if there is one).

Note: In order to display the parameters of a function and its possible result, select 
Parameters in the Function Information field.
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Consulting a 
DFB

To access the library, select Library from the Tools menu then choose the DFB 
tab.
For each DFB instance, the library screen presents: 
l The list of DFBs in the application and defined by:

l the DFB name,
l the version (which is automatically incremented with the confirmation of each 

modification),
l comments.

l The list of the instance for a given DFB(Select the instance),
l The DFB parameters selected defined by: 

l the  nameof the parameters,
l type (eg: DWORD),
l kind,
l comments.

Note: It is only possible to consult a DFB with TSX Premiums.

Note: A new instance can be created from the screen for The list of the instance 
for a given DFB.
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Operate block entry

Introduction There are various ways of selecting an operate block:
l using the mouse,
l using the keyboard,
With PL7 there is also help to enter the contents of an operate block.

Select an operate 
block with the 
mouse

 Carry out the following steps:

Select an operate 
block using the 
keyboard

 Carry out the following steps:

Operate block 
entry help

The principles described below are illustrated using an example: 
%MWO:=ABS(%MW1).

To enter a function call, carry out the following steps:

Step Action

1 Click on the graphics element which corresponds to the operate block in the 
graphics palette at the bottom of the editor.

2 Click in the target cell ( Action zone) to position the operate block.

3 Enter the instruction string and confirm with  Enter.

Step Action

1 Select the target cell with the arrow keys.

2 Press the key combination  Shift+F3.

3 Enter the instruction string and confirm with  Enter.

Step Action

1 Enter the instruction as far as the function call (example %MWO=).

2 Select the contextual menu Enter a function call (right click or SHIFT+F8).
The "Parameters" option must be selected from the Function Information head-
ing.

3 Select the  EF group using the mouse or Tab and arrow keys (example: Single 
length integer).

4 Select thefunction name (example: ABS).

5 Enter the function variables and the entered function is displayed in the  Call 
Display field.
136 Operate modes manual 09/2000



 Programming in rung language
Modifying the 
function call

 Carry out the following steps:

Note: 
l some functions have additional entry screens which are accessed using the  De-

tail button,
l when the function syntax is known, enter the syntax directly into the editor,
l it is possible to directly enable assisted entry on a given function by selecting 

the function name and then selecting the Service → Enter the function call 
command or right click,

l Tabulation and line feed characters are represented by $T and $N respectively, 
they must be entered in $$T and $$N format.

Step Action

1 Place the cursor on the function (example ABS).

2 Select the context menu (right click) Modify the call.
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Horizontal and vertical block entry

Introduction There is the option of entering the comparison blocks in different ways:
l using the mouse,
l using the keyboard,

Entering a 
comparison 
block with the 
mouse 

 Carry out the following steps:

Entering a 
comparison 
block using the 
keyboard

 Carry out the following steps:

Step Action

1 Click on the required graphic element in the graphics palette.

2 Click on the target cell ( Test zone) in order to position the selected comparison 
block.

3 Enter the comparison instruction and then confirm with Enter.

Step Action

1 Select the target cell with the arrow keys.

2 Press the key combination  Shift+F4 or  Shift+F5.

3 Enter the comparison instruction and then confirm with Enter.
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Assisted entry of a library function or of an instance of DFB type (Ladder editor)

Entry procedure 
for a library 
function

The instruction to be entered is: 
Example below: 

Perform the following actions to make an entry:

Step Action

1 Using the mouse:
Select the command SHIFT+F8.
Using the keyboard:
Select the destination cell with the arrow keys (Action zone).

2 Using the mouse:
Click in the destination cell (Action zone) to position the text function block.
Using the keyboard:
Press  SHIFT+F8.

3 Select the tab  EF (selection by default). The "Parameters" option must be se-
lected under the heading Function Information.

4 Select the (EF) function family required (e.g.: Character string).

5 Select the (EF) function name (e.g. CONCAT).

6 Enter the (EF) function variables (%MB4:6; %MB14:9). The function entered 
can be viewed in the Display the call field.

7 Using the mouse:
Confirm the selection with  OK or ENTER .
Using the keyboard:
Select OK then confirm the selection with ENTER

8 With EFs, enter the variable to be associated with the function.%MB30:14:=

9 Click on ENTER.
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Notes:

Certain functions offer extra screens for parameter entry (e.g.: human-machine in-
terface functions). These parameters are accessed with the Detail button that then 
appears at the bottom of the screen.

When the function syntax is known, enter syntax directly into the editor.

It is possible to directly enable assisted entry on a given function by selecting the 
function name then selecting the command Service/Enter function call 
(SHIFT+F8).

Procedure for an 
instance of DFB 
type

Perform the following actions to make an entry:

Step Action

1 Using the mouse:

In the graphics palette click on the element 
Using the keyboard:
Select the destination cell  (Test Zone) with the arrow keys.

2 Using the mouse:
Select DFB.
Using the keyboard:
Press on the key combination, (SHIFT+F7).

3 Using the mouse:
Select the DFB type required.
Using the keyboard:
Select DFB using the arrow keys then enable with ENTER.

4 Using the mouse:
Select the required instance from Choice of instance or create a new instance 
(name + possible comment) and confirm with Create.
Using the keyboard:
Using the Tab or arrow keys, select the required function block. 

5 Using the mouse:
Click on OK.
Using the keyboard:
Select the required instance in  Choice of instance or create a new instance 
(name + possible comment), select Create then confirm withENTER.

6 Using the mouse:
Click in the destination cell (Test zone) to position the DFB type.
Using the keyboard:
Select OK then confirm with ENTER.
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Note:

Two instances of the DFB type connected in series must be separated  by at least 
2 columns.

WARNING

For EFs displayed in red:

EFs which are displayed in red in the function entry help screen cannot 
be used in the application. This limitation is encountered in the following 
instances:
l when an earlier version of the EF is already used in the application,
l when the EF name is used as a variable linked symbol, and only con-

cerns the EF ROUND (family of single precision reals).

Failure to observe this precaution can result in severe injury or 
equipment damage.
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Direct access to a subroutine

Procedure To access the input/display window of a sub-routine during the input/display of a 
sub-routine call, carry out the following. 

Step Action

1 Select the  subroutine call coil: SRi.  

2 Select the command Facility/Open or select in the Contextual menu Open. 
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Replacing a variable in the application

Introduction Finding and replacing an application variable as an address or a symbol (excluding 
variables used in operating screens). The replacement in the application may be to-
tal or partial, automatic or manual.

Replacement affects the indicated variable and its dependent objects as well (word 
extract bits…).
Exception: for Grafcet steps bits the associated activity times (e.g. %Xi.T) are not 
replaced.

Replacement is carried out at the following levels:
l Application (in all tasks).
l Tasks (MAST, FAST, Evti).
l Complete section.
l Partial section (from address i to address j).
l Replacement is also carried out at functional module level (complete functional 

module, sub-modules included).

Procedure Carry out the following actions:

Step Action

1 Select the command Tools/Replace variables or position the cursor over the 
Station directory and select Replace variables from the contextual menu.

2 Put the variable to be replaced (as an address or a symbol) in the Findfield and 
confirm with ENTER or TAB. 

3 Put the variable to be replaced (as an address or a symbol) in the Replacefield 
and confirm with ENTER.

4 Select the view:

l Structure view  

l Function view  

5 Select one or more modules:
l if replacing in all the application, go to point 8,
l if replacing in some of the modules, deselect the whole and select the mod-

ules, go to point 6,
l if replacing in one of the modules, deselect the whole and select the mod-

ule, go to point 6.
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6 Select the label (if LD, ST, IL) or the page (if G7) at the beginning of the re-
placement by positioning the pointer on the list From.
If more precision is required, use the up and down arrow keys.

7 Select the label (if LD, ST, IL) or the page (if G7) at the end of the replacement 
by positioning the pointer on the listTo.
If more precision is required, use the up and down arrow keys.

8 Select the type of replacement:
l if Replace, the replacement is carried out occurrence by occurrence,
l if Replace All, the replacement is carried out on all occurrences.
Notes:
l The status bar indicates the number of replacements carried out, and a re-

port on the replacements not carried out.
l The ESC key allows you to abort the function Replace, but the replace-

ments already carried out are kept.

Step Action
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Cross Referencing a variable in an application

Introduction This function allows you to locate in the application:
l variables in the form of labels or symbols (except those used in operating 

screens),
l DFB types (only on TSX Premium with Pl7 Junior and Pro),
l DFB instances (only on TSX Premium with Pl7 Junior and Pro),
l and to open modules/tasks/DFB types.

Principals of 
using debugging

The user realizes that the variable X is not the right value. To identify the cause he 
must therefore: 
l find the places where this variable is used,
l obtain a list of statements, rungs and expressions,
l to display and verify the activation conditions of the variable. 
Note:
In order to record the path of this search, the list elements thus visited are marked 
with an asterisk (*).

Operational 
mode for objects

A variable can be a read variable (R), a write variable (W) or a read/write variable 
(R/W).

- "R" groups together the read operational modes, indexed read, indexed word, in-
put or input/output parameter of a indexed or non-indexed function.

- "W" groups together the write operational modes, indexed write, output or input/
output parameter of indexed or non-indexed function and execution of Block Func-
tions (SFB and DFB).

Search source 
variables

Table of variables:

Other retrievable variables:

Bit %Ixi; %QXi; %Mi; %Si

Word %MWi; %MDi; %MFi; %KBi; %KWi; %KDi; KFi; %MBi; %SWi; %QWi; 
%QDi; %IWi; %IDi; %NWi

Instruction SRi; HALT

Byte variables

Word extract bits

Bit table

Grafcet bit table

Character string
Operate modes manual 09/2000 145



 Programming in rung language
Search options For an indexed variable, the variable and the index are taken into account in the list.

Table of options:

Table of words and constants

Table of double words and constants

Constant character string

Standard Block Function

Standard Block Function element

Step status

Step activity time

NANET variables

Extract Bit This option is for variables of types %MW, %KW, %IW, %NW, 
%QW.It adds to the list the variable and the referenced bits.

Table Object This option is for bit tables, word tables and immediate indexed vari-
ables.It adds to the list the immediate indexed table variables 
whose first element is the input variable.

Channel Object This option is for channel objects.It adds to the list all the objects of 
the same referenced channel, including the tables and the extract 
bits.

Network Objects This option is for the network variables.It allows you to obtain all the 
variables from the same remote module (NANET object).

FB Object This option allows you to expand the list of SFB block function ele-
ments and the DFB type elements.

FB Instance Only on TSX Premium with PL7 Junior and Pro.
This option is for DFB types.It allows you to obtain from the name 
of a DFB type the sections using its instances.
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Searching for 
cross references

Carry out the following actions:

Selecting a variable from the list:
l Select the variable from the list, the list of tasks, modules, labels is updated.
Deleting a variable from the list:
l Select the variable, enable the contextual menu (right click) then click on Delete.
Displaying in structural view or in functional view:
l Use the View menu or the  Function button.

Step Action

1

Select the icon  

2 Enter the search source variable as an address or a symbol (E.g. %M10) and 
the possible options then confirm via Search.

3 To display a module, select the module, via the Contextual menu, select Open 
or double click on the module.
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Animation of the Ladder program elements

At a Glance Refer to the "Debugging" Chapter  of the Part "Debugging, Adjustment, Docu-
mentation and Appendices"-> (see Animating program elements, p. 285 ).
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Printing of a program

Procedure Carry out the following steps:

Notes The print type depends on the type of display selected in the View menu.
l Addresses: prints variables with addresses,
l Symbols: prints variables with symbols,
l Symbols&Addresses: prints variables with symbols/addresses.

Step Action

1 Open the module with right click + Open or a double click.

2
Select the command File/Print (Ctrl+P) or click on the icon 

3 Select a print range:
l if for the entire module, go to step 6.
l if for part of a module, go to step 4.

4 Select %Li/TOP/BOTTOM (if LD, ST, IL) or start page (if G7).
If more precision is required, use the up and down arrow keys.

5 Select %Li/TOP/BOTTOM (if LD, ST, IL) or endpage (if G7).
If more precision is required, use the up and down arrow keys.

6 Confirm with OK or ENTER.
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Export/Import of source files

Refer to the "Import/Export" (See Import/Export, p. 341) Chapter of the Part "De-
bugging, Adjustment, Documentation and Appendices". 
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Programming instruction list in 
LIST language
Introduction

Subject of this
chapter

This chapter reminds you of the structure of a program in instruction list language.

It describes: 
l How to create a program.
l How to use the different functions offered by the editor.
l How to manage the different modules making up the application.

What’s in this 
Chapter?

This Chapter contains the following Maps:

Topic Page

Structure of an Instruction List program 152

Creating a program in Instruction List 153

Accessing a statement or instruction (Instruction List) 154

Displaying variables as symbols or addresses 157

Information box 158

Online symbolization 159

Input of a predefined function block (List editor) 160

Assisted entry of a library function (List editor) 161

Direct access to a subroutine 163

Replacing a variable in the application 164

Cross Referencing a variable in an application 166

Animation of List program elements 169

Printing of a program 170

Export/Import of source files 171
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 Programming instruction list in language
Structure of an Instruction List program

Principal A program written in instruction list  language is composed of a series of instructions 
executed sequentially by the PLC.
l An instruction takes up a maximum of one line.
l The instructions are organized into instruction statements (equivalent to a con-

tacts network). Each instruction statement is made up of one or several instruc-
tions.

l Each instruction statement begins with an exclamation mark (generated automat-
ically), it can include a comment and can be labeled with a label.

l A statement contains a maximum of 128 lines (instruction, comment, label).
l In the editor a statement being input is displayed in red.
l A selected statement is surrounded by a green frame. 
l The current statement is surrounded by a black frame. 
l The number of the current instruction (instruction line or label) as well as the total 

number of instructions in the module are indicated in the bottom panel of the win-
dow (status bar).

Example ! (*Drying wait*)
%L2:      ->Label
LD  %I1.0 ->Start of statement
AND %M10  ->Instruction
ST  %Q2.5 ->End of statement

Notes:
Key-words (LD, AND, ST…) are colored blue.
Comments are colored green.
The remainder is colored black.
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 Programming instruction list in language
Creating a program in Instruction List

Procedure Carry out the following actions:

Rules They are:
l At the time of confirmation, the input text is formatted giving you automatically in-

dented source code.
l If an error is detected at confirmation, the cursor is positioned over the first error 

detected, the error message is displayed at the bottom of the window.
l In the editor, a statement is displayed in redwhile being entered.
l A selected statement is surrounded by a green frame. 
l The current statement is surrounded by a black frame. 

Step Action

1 Create a List section (See Creating or importing an LD, IL, ST section, p. 105).

2 1. Enter the first statement. As input begins, the statement is displayed in red.  

2. Accept each line with ENTER.
3. Use the TAB key to separate the code from the operand.
4. On line symbolization (See Online symbolization, p. 159).

3 Confirm the input of the statement with the command Edit/Confirm  

(CTRL+W)/SHIFT+ENTER) or via the icon  
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Accessing a statement or instruction (Instruction List)

Accessing a 
statement or an 
instruction

When the program module is displayed, select the Edit/Go to (Ctrl+A) command or 

the icon  .
Access by label -> select "Label":

The Move zone is used to make a movement relative to TOP/BOTTOM/%Li.

Access by instruction -> select "instruction":

The Edit/Go to current modification command allows you to position the cursor 
on the current modification.

Selecting one or 
several 
statements

The possible choices are as follows:

In the label zone, select… position…

TOP at the start of program module.

BOTTOM at the end of program module.

%Li at the corresponding label number.

In the instruction zone, select… position…

instruction number on the corresponding instruction.

Select… by… or…

one statement positioning the cursor over the state-
ment and selecting the Edit/Select 
statement from the menu

by clicking in this zone, it is 
framed in green.
Example: 

several state-
ments

by selecting the different statements 
while holding down the left mouse but-
ton

using the keys (Shift+Arrow).

part of a state-
ment

by moving the cursor over the text to 
be selected while holding down the left 
mouse button (Shift+Arrow)

! ( * INIT  1 * )
%L2:

ST
OR
LD % I1. 0

%M0
%Q1 .0
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Modifying a 
statement

Carry out the following actions:

The deletion possibilities are as follows:

Inserting a 
statement before 
the current 
statement

Carry out the following actions:

Cut/Copy/Paste 
part of a program 
module

Carry out the following operations:

Step Action

1 Position the cursor over the point where the modification is to be made.

2 Make the modification.

3 Confirm the modification with the keys (Ctrl+W) or (Shift+Enter) or 

the Icon 

Delete… by… then by…

one statement selecting the statement to be deleted pressing the Delete key.

part of a state-
ment

selecting the part of the statement to 
be deleted

pressing the Delete key.

a piece of text and 
place it on the clip-
board

selecting the text to be cut selecting the Edit/Cut 
(Ctrl+X) command.

Step Action

1 Position the cursor on the statement before which the insertion must be made.

2 Select the Edit/Insert Statement command or (Ctrl+I). 

To….. you must… the text…

copy part of a 
statement

select the text to be copied and select 
the command Edit/Copy (Ctrl+C)

is placed on the Windows Clip-
board.

paste the contents 
of the Clipboard 
into a document

select the point from where the text 
must be pasted and select the Edit/
Paste (Ctrl+V) command

is kept on the Windows Clip-
board.

cut a piece of text 
and place it on the 
clipboard

select the text to be cut and select the 
command Edit/Cut (Ctrl+X) 

is placed on the Windows Clip-
board.
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Note:
The Cut/Copy/Paste function works in the same way for a selection of statement(s) 
and between program modules.

Canceling a 
modification

To cancel a modification carried out on an unconfirmed statement, select the Edit/

Undo changes command or the icon 

This command allows you to return the sequence to its last confirmed state.
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Displaying variables as symbols or addresses 

Procedure Carry out the following actions:

Note:

It is possible to run the language editor from the Options menu in:
l addresses view,
l symbols view,
l symbols&addresses view (for the Ladder editor only).

Example of 
display

Ladder editor used with the 3 views.  

Note If a symbol or address has more than 8 characters, the display can be truncated. 
Select the element, which is then displayed in full in the status bar. You can also use 
the Information box.

The View/Collapsed command is used to reduce the size of the window whilst 
maintaining the same level of information.

The View/Normal command allows you to return to the normal sized window.

Step Action

1 Open the program module with right click + Open or with a double click.

2 Select the command:
l View/Addresses to display the variables as addresses.
l View/Symbols to display the variables as symbols.
l View/Symbols&addresses to display the variables as symbols/addresses 

(Ladder editor only).
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Information box

Functions This box, which can be accessed from all language objects, displays the symbols, 
address and comments for the selected object (except for the operate and horizontal 
comparison blocks) in an integrated format.

Display table according to object:

How to access 
the object 
information box

 Carry out the following steps:

Note The information box remains visible if it the user does not specifically close it. The 
contents of the  Information box is updated according to the current selection.

Single object  Complex object (operate 
block, horizon comparison 
block)

l symbol format in blue
l constructor name in black,
l associated comments in 

green.

l symbol format in blue
l constructor address in black.

Step Action

1 In the LIST language editor, select the object.

2 Click on the right mouse button (contextual menu) and then select Informa-
tion, or select theView → Informationcommand.
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Online symbolization

Principal Online symbolization allows you, at the time of input of a Ladder, List, Structured 
Text program, to immediately (without opening the data editor) associate: 
l an address to a new symbol,
l a symbol to a non symbolized address.

Procedure With the Ladder editor, start at Step 1, with the Structured Text or List editors, go 
straight to step 2.

Step Action

1 Select the cell where the variable is situated.

2 Select the variable (highlight it).

3 Right mouse click on the variable and select Associate Symbol&Address.

4 Enter the address or symbol and the comment.
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Input of a predefined function block (List editor)

Procedure From within the language editor, carry out the following actions:

Function blocks The different function blocks and their instructions are: 

Step Action

1 From the Contextual or the Service menu, select the command Input a block 
function call (Shift+F7).

2 Select the SFB type (counter, monostable…) using a double click (selection 
via the keyboard is done using the Arrow keys and ENTER). The input mask is 
displayed.

Function blocks Instruction Syntax

TP/TON/TOF timer (%TMi) Start
Initialize

IN %TMi (Rising edge)
IN %TMi (Falling edge)

Up/Down counter (%Ci) Reset to 0
Set to Preset value
Increment by 1
Decrement by 1

R %Ci
S %Ci
CU %Ci
 CD %Ci

Monostable  (%MNi) Start S %MNi

Register of FIFO/LIFO words 
(%Ri) 

Reset contents
Saving in %Ri;I
Removing from %Ri,O

R %Ri
 I %Ri
O %Ri

Drum-DRUM (%DRi) Position at step 0
Change step

R %DRi
U %DRi
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Assisted entry of a library function (List editor)

Entry procedure 
for a library 
function

The instruction to be entered is:
[%MW5:=%MW30 + 100 + ROL(%MW8,2)]

To enter a function, perform the following actions

Notes Certain functions offer extra screens for parameter entry (e.g.: human-machine in-
terface functions). These parameters are accessed with the Detail button that then 
appears at the bottom of the screen.

When the function syntax is known, enter syntax directly into the editor.

It is possible to directly enable assisted entry on a given function by selecting the 
name of the function then selecting the Service/Enter call for a function command 
or performing a RIGHT MOUSE CLICK.

Step Action

1 Enter the instruction as far as the ROL function call.

2 Via the Contextual or Service menu, select the Enter call for a function com-
mand.

3 Select the required tab (default selection). For an elementary function (EF) the 
"Parameters" option must be selected in the Function Information menu.

4 Select the  (EF) function family (e.g.: Single length integer), or the required 
DFB block (only on TSX Premium with PL7 Junior and Pro).

5 Select the  (EF) function name (e.g. ROL), or the name of the DFB instance.
 An instance can be created for a DFB:
1. Select Create.
2. Enter the name.
3. Enter a comment.
4. Confirm using Create.

6 Enter the (EF) function variables or DFB type parameters in the parameter 
entry field. The function entered can be viewed in the Display the call field.

7 Confirm the selection with OK.

8 End the instruction entry (end character ]).

9 Confirm the entry with ENTER.
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WARNING

For EFs displayed in red:

EFs which are displayed in red in the function entry help screen cannot 
be used in the application. This limitation is encountered in the following 
instances:
l When an earlier version of the EF is already used in the application,
l when the EF name is used as a variable linked symbol, and only con-

cerns the EF ROUND (family of single precision reals). 

Failure to observe this precaution can result in severe injury or 
equipment damage.
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Direct access to a subroutine

Procedure To access the subroutine’s input/viewing window during the input/viewing of a sub-
routine call, carry out the following actions: 

Step Action

1 Select the subroutine call object: SRi
%L1:
LD%M0
SR1

2 Select the command Facility/Open or in the Contextual menu select  Open.
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Replacing a variable in the application

Introduction Finding and replacing an application variable as an address or a symbol (excluding 
variables used in operating screens). The replacement in the application may be to-
tal or partial, automatic or manual.

Replacement affects the indicated variable and its dependent objects as well (word 
extract bits…).
Exception: for Grafcet steps bits the associated activity times (e.g. %Xi.T) are not 
replaced.

Replacement is carried out at the following levels:
l Application (in all tasks).
l Tasks (MAST, FAST, Evti).
l Complete section.
l  Partial section (from address i to address j).
l Replacement is also carried out at functional module level (complete functional 

module, sub-modules included).

Procedure Carry out the following actions:

Step Action

1 Select the commandTools/Replace variables or position the cursor over the 
Station directory and select Replace variables from the contextual menu.

2 Put the variable to be replaced (as an address or a symbol) in the Findfield and 
confirm with ENTER or TAB. 

3 Put the variable to be replaced (as an address or a symbol) in the Replacefield 
and confirm with ENTER.

4 Select the view:

l Structure view  

l Function view  

5 Select one or more modules:
l if replacing in all the application, go to point 8,
l if replacing in some of the modules, deselect the whole and select the mod-

ules, go to point 6,
l if replacing in one of the modules, deselect the whole and select the mod-

ule, go to point 6.
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6 Select the label (if LD, ST, IL) or the page (if G7) at the beginning of the re-
placement by positioning the pointer on the listFrom.
If more precision is required, use the up and down arrow keys.

7 Select the label (if LD, ST, IL) or the page (if G7) at the end of the replacement 
by positioning the pointer on the listTo.
If more precision is required, use the up and down arrow keys.

8 Select the type of replacement:
l if Replace, the replacement is carried out occurrence by occurrence,
l if Replace All, the replacement is carried out on all occurrences.
Notes:
l The status bar indicates the number of replacements carried out, and a re-

port on the replacements not carried out.
l The ESC key allows you to abort the function Replace, but the replace-

ments already carried out are kept.

Step Action
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Cross Referencing a variable in an application

Introduction This function allows you to locate in the application:
l variables in the form of labels or symbols (except those used in operating 

screens),
l DFB types (only on TSX Premium with Pl7 Junior and Pro),
l DFB instances (only on TSX Premium with Pl7 Junior and Pro),
l and to open modules/tasks/DFB types.

Principals of 
using debugging

The user realizes that the variable X is not the right value. To identify the cause he 
must therefore: 
l find the places where this variable is used,
l obtain a list of statements, rungs and expressions,
l to display and verify the activation conditions of the variable. 
Note:
In order to record the path of this search, the list elements thus visited are marked 
with an asterisk (*).

Operational 
mode for objects

A variable can be a read variable (R), a write variable (W) or a read/write variable 
(R/W).

- "R" groups together the read operational modes, indexed read, indexed word, in-
put or input/output parameter of a indexed or non-indexed function.

- "W" groups together the write operational modes, indexed write, output or input/
output parameter of indexed or non-indexed function and execution of Block Func-
tions (SFB and DFB).

Search source 
variables

Table of variables:

Other retrievable variables:

Bit %Ixi; %QXi; %Mi; %Si

Word % MWi; %MDi; %MFi; %KBi; %KWi; %KDi; KFi; %MBi; %SWi; %QWi; %QDi; 
%IWi; %IDi; %NWi

Instruc-
tion

SRi; HALT

Byte variables

Word extract bits

Bit table

Grafcet bit table

Character string
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Search options For an indexed variable, the variable and the index are taken into account in the list.

Table of options:

Table of words and constants

Table of double words and constants

Constant character string

Standard Block Function

Standard Block Function element

Step status

Step activity time

Manet variables

Extract Bit This option is for variables of types %MW, %KW, %IW, %NW, 
%QW. It adds to the list the variable and the referenced bits.

Table Object This option is for bit tables, word tables and immediate indexed vari-
ables. It adds to the list the immediate indexed table variables 
whose first element is the input variable.

Channel Object This option is for channel objects. It adds to the list all the objects of 
the same referenced channel, including the tables and the extract 
bits.

Network Objects This option is for the network variables. It allows you to obtain all the 
variables from the same remote module (nanet object).

FB Object This option allows you to expand the list of SFB block function ele-
ments and the DFB type elements.

FB Instance Only on TSX Premium with PL7 Junior and Pro.
This option is for DFB types. It allows you to obtain from the name 
of a DFB type the sections using its instances.
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Searching for 
cross references

Carry out the following actions:

Selecting a variable from the list:
l Select the variable from the list, the list of tasks, modules, labels is updated.
Deleting a variable from the list:
l Select the variable, enable the contextual menu (right click) then click on Delete.
Displaying in structural view or in functional view:
l Use the View menu or the  Function button.

Step Action

1

Select the icon  

2 Enter the search source variable as an address or a symbol (E.g. %M10) and 
the possible options then confirm via Search.

3 To display a module, select the module, via the Contextual menu, select Open 
or double click on the module.
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Animation of List program elements

At a Glance Refer to the "Debugging" Chapter of the Part "Debugging, Adjustment, Docu-
mentation and Appendices"-> (see Animating program elements, p. 285 ).
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Printing of a program

Procedure Carry out the following steps:

Notes The print type depends on the type of display selected in the View menu.
l Addresses: prints variables with addresses,
l Symbols: prints variables with symbols,
l Symbols&Addresses: prints variables with symbols/addresses.

Step Action

1 Open the module with right click + Open or a double click.

2

Select the command File/Print (Ctrl+P) or click on the icon  

3 Select a print range:
l if for the entire module, go to step 6.
l if for part of a module, go to step 4.

4 Select %Li/TOP/BOTTOM (if LD, ST, IL) or start page (if G7).
If more precision is required, use the up and down arrow keys.

5 Select %Li/TOP/BOTTOM (if LD, ST, IL) or endpage (if G7).
If more precision is required, use the up and down arrow keys.

6 Confirm with OK or ENTER.
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Export/Import of source files

Refer to the "Import/Export" (See Import/Export, p. 341) Chapter of the Part "De-
bugging, Adjustment, Documentation and Appendices". 
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8
Programming in Structured Text 
ST language
Introduction

Subject of this 
chapter

This chapter reminds you of the structure of a program in Structured Text language.

It describes: 
l How to create a program.
l How to use the different functions offered by the editor.
l How to manage the different modules making up the application.

What’s in this 
Chapter?

This Chapter contains the following Maps:

Topic Page

Structure of a program in Structured Text language. 174

Creating a program in Structured Text (ST) 175

Modifying a Structured Text program 176

Displaying variables as symbols or addresses 179

Information box 180

Online symbolization 181

Input of a predefined function block (ST editor) 182

Assisted entry of a library function (ST editor) 183

Direct access to a subroutine 185

Replacing a variable in the application 186

Cross Referencing a variable in an application 188

Animation of Structured text program elements 191

Printing of a program 192

Export/Import of source files 193
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 Programming in Structured Text language
Structure of a program in Structured Text language.

Introduction Structured Text (ST) can be used on PLCs TSX Premium (V>=V1.0) and on the TSX 
Micro (V>=V1.5).

Structured Text is supported by software products PL7 Junior and PL7 Pro.

Principal A module written in Structured Text language is composed of a series of statements 
executed sequentially by the PLC.
l Each statement begins with an exclamation mark (generated automatically), it 

can include one or several comments, one or several instructions and can be 
marked with a label.

l A statement contains a maximum of 128 lines of 300 characters (instructions, 
comments, label).

l In the editor a statement being input is displayed in red.
l A selected statement is surrounded by a green frame.
l The current statement is surrounded by a black frame.
l The line number and the column number as well as the number of the current 

statement are written in the bottom panel of the window (status bar).

Example ! (*Initialisation*)
%L2: (*Label*)
%MW0:=0; (* Init Index *)
%MW2:=%MW99:2; (* length of table *)
IF (%MW2 REM 2=0) THEN DEC %MW0;
END_IF;
(* while the index is < the length of the table    carry out 
shift *)
WHILE(%MW0<%MW2)DO
 %MW100[%MW0]:=(SHR(%MW100[%MW0],8))OR(SHL(%MW101[%MW0],8));
 INC %MW0;
END_WHILE;

Notes :
Key-words (example AND, OR, IF…) are colored blue.
Comments are colored green.
The rest is colored black.
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Creating a program in Structured Text (ST)

Introduction Structured Text can be used on PLCs TSX Premium (V>=V1.0) and on the TSX Mi-
cro (V>=V1.5).

Structured Text is supported by software products PL7 Junior and PL7 Pro. 

Procedure Carry out the following actions:

Rules They are:
l When confirming the statement, superfluous spaces are ignored.
l If an error is detected at confirmation, the cursor is positioned over the first error 

detected, the error message is displayed at the bottom of the window.
l In the editor, a statement is displayed in redwhile being entered.
l A selected statement is surrounded by a green frame. 
l The current statement is surrounded by a black frame. 

Step Action

1 Creating or importing an LD, IL, ST section, p. 105

2 1. Enter the first statement. As input begins, the statement is displayed in red.  

2. Accept each line with ENTER.

3. Use the TAB key to indent the code.

4 .Online symbolization, p. 159

3 Confirm the input of the statement with the command Edit/Confirm 

(CTRL+W)/(SHIFT+ENTER) or via the icon .
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Modifying a Structured Text program

Accessing a 
statement or 
instruction

The program module being displayed, select the command Edit/Go to (Ctrl+A) or 

the icon  .

The possible choices are as follows:

The Move zone allows a movement relative to TOP/BOTTOM/%Li.

The command Edit/ Go to current modification allows you to position the cursor 
on the statement which is currently being modified.

Selecting one or 
several 
statements

The possible choices are as follows:

Select in the label field… position…

TOP at the beginning of the program module.

BOTTOM at the end of the program module.

%Li at the corresponding label number.

Select… by… or…

one statement positioning the cursor 
over the statement 
and selecting the 
menuEdit/Select 
statement 

by clicking in this area, the latter is framed 
in green. 

several statements move the mouse over 
the different state-
ments while keeping 
the left button down

by using the keys (SHIFT+Arrow).

a part of a state-
ment

by moving the cursor 
over the text to be se-
lected while keeping 
the left mouse button 
down (SHIFT+Ar-
row).

! ( * INIT * )
%L1:

SR2;
IF Mode-Auto_manu

END_IF;

THEN
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Modifying one 
statement

Carry out the following actions:

The deletion possibilities are as follows:

Inserting a state-
ment before the 
current 
statement

Carry out the following actions:

Cut/Copy/Paste a 
part of a program 
module

Carry out the following operations:

Note:

Step Action

1 Position the cursor over the point to be modified.

2 Carry out the modification

3 Confirm the modification with the keys CTRL + W or SHIFT+ ENTER or the 

icon  

Delete… by… then by…

one statement selecting the statement to 
delete

pressing the key Delete.

a part of a statement selecting the part of the 
statement to delete

pressing the key Delete.

a piece of text and place it on 
the clipboard

selecting the text to be cut selecting the command Edit/
Cut (CTRL+X).

Step Action

1 Position the cursor on the statement before which the insertion must be carried 
out.

2 Select the command Edit/Insert statement or (Ctrl+I).

To… you must… the text…

Copy a part of a statement select the text to be copied 
and select the command 
Edit/Copy (Ctrl+C) 

is placed on the Windows 
clipboard.

Paste the contents of the 
clipboard into a document

select the start point from 
which the text must be past-
ed and select the command 
Edit/Paste (CTRL+V) 

is kept on the Windows clip-
board.

Cut a piece of text and place 
it on the clipboard

select the text to be cut and 
select the command Edit/
Cut (CTRL+X) 

is placed on the Windows 
clipboard.
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The Cut/Copy/Paste function works in the same way for a selection of statement(s) 
and between program modules.

Canceling a 
modification

To cancel a modification carried out on an unconfirmed statement, select the com-

mand Edit/Undo changes or the icon .  
This command allows you to return the statement to its last confirmed state. 
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Displaying variables as symbols or addresses 

Procedure Carry out the following actions:

Note:

It is possible to run the language editor from the Options menu in:
l addresses view,
l symbols view,
l symbols&addresses view (only for the Ladder editor).

Example display Ladder editor used with the 3 views.  

Note If a symbol or an address has more than 8 characters, the display can be truncated. 
Select the element displayed in this way in the status bar. You can also use the In-
formation box.

The command View/Reduced allows you to reduce the size of the window while 
keeping the same level of information.

The command View/Normal allows you to return to the normal sized window.

Step Action

1 Open the program module by right mouse click + Open or double mouse 
click.

2 Select the command:
l View/Addresses to display the variables as addresses.
l View/Symbols to display the variables as symbols.
l View/Symbols&Addresses to display the variables as symbols/addresses 

(only Ladder editor).
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Information box

Functions This box, which can be accessed from all language objects, displays the symbols, 
address and comments for the selected object (with the exception of the operate and 
horizontal comparison blocks) in an integrated format.

Display table according to object:

How to access 
the object 
information box

 Carry out the following steps:

Note The information box remains visible if it the user does not specifically close it. The 
contents of the  Information box is updated according to the current selection.

Single object  Complex object (operate 
block, horizon comparison 
block)

l symbol format in blue
l constructor name in black,
l associated comments in 

green.

l symbol format in blue,
l constructor address in black,

Step Action

1 In the ST language editor, select the object.

2 Click on the right mouse button (contextual menu) and then select Informa-
tion, or select theView → Informationcommand.
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Online symbolization

Principal Online symbolization allows you, at the time of input of a Ladder, List, Structured 
Text program, to immediately (without opening the data editor) associate: 
l an address to a new symbol,
l a symbol to a non symbolized address.

Procedure With the Ladder editor, start at Step 1, with the Structured Text or List editors, go 
straight to step 2.

Step Action

1 Select the cell where the variable is situated.

2 Select the variable (highlight it).

3 Right mouse click on the variable and select Associate Symbol&Address.

4 Enter the address or symbol and the comment.
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Input of a predefined function block (ST editor)

Procedure From within the language editor, input at the cursor position one of the instructions 
presented below corresponding to the desired function block.

Function blocks The different function blocks and their instructions are: 

Function blocks Instruction Syntax

PL7-3 timer(%Ti) Start
Stop
Reinitialize

START %Ti;
STOP %Ti;
PRESET %Ti;

TP/TON/TOF timer (%TMi) Start
Initialize

START %TMi;
DOWN %TMi;

Up/Down counter  (%Ci) Reset to 0
Set to Preset value
Increment by 1
Decrement by 1

RESET %Ci;
PRESET %Ci;
UP %Ci;
DOWN %Ci;

Monostable  (%MNi) Start START %MNi;

Register of FIFO/LIFO words 
(%Ri) 

Reset contents
Saving in %Ri;I
Removing from %Ri,O

RESET %Ri;
PUT %Ri;
GET %Ri;

Drum-DRUM (%DRi) Position at step 0
Change step

RESET %DRi;
UP %DRi;
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Assisted entry of a library function (ST editor)

Procedure The instruction to be entered is:
%MD5:=%MD30 AND 100 AND ROL(%MD8,2);

Perform the following actions to make an entry:

Notes Certain functions offer extra screens for parameter entry (e.g.: human-machine in-
terface functions). These parameters are accessed with the Detail button that then 
appears at the bottom of the screen.

When the function syntax is known, enter syntax directly into the editor.

It is possible to directly enable assisted entry on a given function by selecting the 
name of the function then selecting the Service/Enter call for a function command 
or performing a RIGHT MOUSE CLICK.

 Tabulation and Line Feed characters are represented by $T and $N respectively. 
They must be entered in $$T and $$N format.

Step Action

1 Enter the instruction as far as the ROL function call.

2 Via the Contextual or Service menu, select the Enter call for a function com-
mand.

3 Select the required tab (default selection). For an elementary function (EF) the 
"Parameters" option must be selected in the Function Information menu.

4 Select the  (EF) function family (e.g.: Double length integer, or the required 
DFB block (only on TSX Premium with PL7 Junior and Pro).

5 Select the (EF) function name(e.g. ROL), or the name of the DFB instance.
 An instance can be created for a DFB:
1. Select Create.
2. Enter the name.
3. Enter a comment.
4. Confirm using Create.

6 Enter the (EF) function variables or DFB type parameters in the parameter 
entry field. The function entered can be viewed in the Display the call field.

7 Confirm the selection with OK.

8 End the instruction imput (end character ;).

9 Confirm the entry with ENTER.
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WARNING

For EFs displayed in red:

EFs which are displayed in red in the function entry help screen cannot 
be used in the application. This limitation is encountered in the following 
instances:
l when an earlier version of the EF is already used in the application,
l the EF name is used as a variable linked symbol, and concerns the 

EF ROUND (family of single precision reals).

Failure to observe this precaution can result in severe injury or 
equipment damage.
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Direct access to a subroutine

Procedure To access the input/display window of a sub-routine during the input/display of a 
sub-routine call, carry out the following actions:

Step Action

1 Select the subroutine call object:  SRi
%L1:
IF %M0 THEN SR1;
END_IF;

2 Select the command Service/Open or select Open from the contextual menu.
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Replacing a variable in the application

Introduction Finding and replacing an application variable as an address or a symbol (excluding 
variables used in operating screens). The replacement in the application may be to-
tal or partial, automatic or manual.

Replacement affects the indicated variable and its dependent objects as well (word 
extract bits…).
Exception: for Grafcet steps bits the associated activity times (e.g. %Xi.T) are not 
replaced.

Replacement is carried out at the following levels:
l Application (in all tasks).
l Tasks (MAST, FAST, Evti).
l Complete section.
l  Partial section (from address i to address j).
l Replacement is also carried out at functional module level (complete functional 

module, sub-modules included).

Procedure Carry out the following actions:

Step Action

1 Select the commandTools/Replace variables or position the cursor over the 
Station directory and select Replace variables from the contextual menu.

2 Put the variable to be replaced (as an address or a symbol) in the Findfield and 
confirm with ENTER or TAB. 

3 Put the variable to be replaced (as an address or a symbol) in the Replacefield 
and confirm with ENTER.

4 Select the view:
l Structure view
l Function view

5 Select one or more modules:
l if replacing in all the application, go to point 8,
l if replacing in some of the modules, deselect the whole and select the mod-

ules, go to point 6,
l if replacing in one of the modules, deselect the whole and select the mod-

ule, go to point 6.
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6 Select the label (if LD, ST, IL) or the page (if G7) at the beginning of the re-
placement by positioning the pointer on the listFrom.
If more precision is required, use the up and down arrow keys.

7 Select the label (if LD, ST, IL) or the page (if G7) at the end of the replacement 
by positioning the pointer on the listTo.
If more precision is required, use the up and down arrow keys.

8 Select the type of replacement:
l if Replace, the replacement is carried out occurrence by occurrence,
l if Replace All, the replacement is carried out on all occurrences.
Notes:
l The status bar indicates the number of replacements carried out, and a re-

port on the replacements not carried out.
l The ESC key allows you to abort the function Replace, but the replace-

ments already carried out are kept.

Step Action
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Cross Referencing a variable in an application

Introduction This function allows you to locate in the application:
l variables in the form of labels or symbols (except those used in operating 

screens),
l DFB types (only on TSX Premium with Pl7 Junior and Pro),
l DFB instances (only on TSX Premium with Pl7 Junior and Pro),
l and to open modules/tasks/DFB types.

Principals of 
using debugging

The user realizes that the variable X is not the right value. To identify the cause he 
must therefore: 
l find the places where this variable is used,
l obtain a list of statements, rungs and expressions,
l to display and verify the activation conditions of the variable. 
Note:
In order to record the path of this search, the list elements thus visited are marked 
with an asterisk (*).

Operational 
mode for objects

A variable can be a read variable (R), a write variable (W) or a read/write variable 
(R/W).

- "R" groups together the read operational modes, indexed read, indexed word, in-
put or input/output parameter of a indexed or non-indexed function.

- "W" groups together the write operational modes, indexed write, output or input/
output parameter of indexed or non-indexed function and execution of Block Func-
tions (SFB and DFB).

Search source 
variables

Table of variables:

Other retrievable variables:

Bit %Ixi; %QXi; %Mi; %Si

Word % MWi; %MDi; %MFi; %KBi; %KWi; %KDi; KFi; %MBi; %SWi; %QWi; 
%QDi; %IWi; %IDi; %NWi

Instruction SRi; HALT

Byte variables

Word extract bits

Bit table

Grafcet bit table

Character string
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Search options For an indexed variable, the variable and the index are taken into account in the list.

Table of options:

Searching for 
cross references

Carry out the following actions:

Table of words and constants

Table of double words and constants

Constant character string

Standard Block Function

Standard Block Function element

Step status

Step activity time

Manet variables

Extract Bit This option is for variables of types %MW, %KW, %IW, %NW, 
%QW. It adds to the list the variable and the referenced bits.

Table Object This option is for bit tables, word tables and immediate indexed vari-
ables. It adds to the list the immediate indexed table variables 
whose first element is the input variable.

Channel Object This option is for channel objects. It adds to the list all the objects of 
the same referenced channel, including the tables and the extract 
bits.

Network Objects This option is for the network variables. It allows you to obtain all the 
variables from the same remote module (nanet object).

FB Object This option allows you to expand the list of SFB block function ele-
ments and the DFB type elements.

FB Instance Only on TSX Premium with PL7 Junior and Pro.
This option is for DFB types. It allows you to obtain from the name 
of a DFB type the sections using its instances.

Step Action

1

Select the icon  

2 Enter the search source variable as an address or a symbol (E.g. %M10) and 
the possible options then confirm via Search.

3 To display a module, select the module, via the Contextual menu, select Open 
or double click on the module.
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Selecting a variable from the list:
l Select the variable from the list, the list of tasks, modules, labels is updated.
Deleting a variable from the list:
l Select the variable, enable the contextual menu (right click) then click on Delete.
Displaying in structural view or in functional view:
l Use the View menu or the  Function button.
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Animation of Structured text program elements

At a Glance Refer to the "Debugging" Chapter of the Part "Debugging, Adjustment, Docu-
mentation and Appendices"-> (see Animating program elements, p. 285 ) .
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Printing of a program

Procedure Carry out the following steps:

Notes The print type depends on the type of display selected in the View menu.
l Addresses: prints variables with addresses,
l Symbols: prints variables with symbols,
l Symbols&Addresses: prints variables with symbols/addresses.

Step Action

1 Open the module with right click + Open or a double click.

2

Select the command File/Print (Ctrl+P) or click on the icon 

3 Select a print range:
l if for the entire module, go to step 6.
l if for part of a module, go to step 4.

4 Select %Li/TOP/BOTTOM (if LD, ST, IL) or start page (if G7).
If more precision is required, use the up and down arrow keys.

5 Select %Li/TOP/BOTTOM (if LD, ST, IL) or endpage (if G7).
If more precision is required, use the up and down arrow keys.

6 Confirm with OK or ENTER.
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Export/Import of source files

Refer to the "Import/Export" (See Import/Export, p. 341) Chapter of the Part "De-
bugging, Adjustment, Documentation and Appendices". 
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Programming in  Grafcet language
Introduction

Subject of this
chapter

This chapter reminds you of the structure of a program in grafcet language.

It describes:
l How to create a program.
l How to use the different functions offered by the editor.
l How to manage the different modules making up the application.

What’s in this 
Chapter?

This Chapter contains the following Maps:

Topic Page

Designing a program in Grafcet language 196

Structure of a Grafcet page 197

Grafcet graphic objects 198

Creating a Grafcet module 203

Modifying a Grafcet program 216

Replacing a variable in the application 219

Cross Referencing a variable in an application 221

Animation of Grafcet program elements 224

Printing of a program 225

Export/Import of source files 226
195
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Designing a program in Grafcet language

Principal Gracet language (GR7) allows the sequential operation of automation to be repre-
sented graphically and in a structured way.

This description is carried out with help from single graphical objects (See Grafcet 
graphic objects, p. 198) representing:
l the steps with which the actions can be associated (except the OUT step),
l the macro-steps, (onlyTSX/PCX/PMX57)
l the transitions with which the receptivity is associated,
l the positioned links connecting a step to a transition or a transition to a step. 

The graph is input by Grafcet pages (See Structure of a Grafcet page, p. 197) ad-
dressed from 0 to 7 in the status bar.

Example Grafcet editor: 

F11F8F7F6F5F4F3F2 F10 F12

2 M0 0

1F2F9

1 2) Place the element on
the input grid

1) Select object from the 
graphics
palette 
196 Operate modes manual 09/2000



Programming in  Grafcet language
Structure of a Grafcet page

Principles The Grafcet page is displayed in the form of a matrix made up of 14 lines and 11 
columns defining 154 cells.

Each cell can receive a graphic object (See Grafcet graphic objects, p. 198).

There are two types of line:
l step lines where steps, macro steps and connectors are entered,
l transition lines where the transitions and source connectors are entered.

Comments can be entered.  These are independent graphic objects, which are not 
attached to steps or transitions.

A program module is made up of 8 Grafcet pages, and a Grafcet page is accessed 

via the Edit/Go to command, or the icon 

There are two Grafcet page viewing modes offered, which can be accessed from the 
View menu:
l normal view (default display),
l collapsed view.

Example Grafcet page: 

0

1 4

2

3

5 Step line

Transition line
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Grafcet graphic objects

Steps Number of possible steps by PLC type:
l TSX37-10 Max: 96,
l TSX37-20 Max: 128,
l TSX/PCX/PMX57 Max: 250.
Type of steps:

Macro-steps Only enabled on TSX/PCX/PMX57, Max: 64.

Can be accessed from the graphics palette using the (Shift+F2) keys or the icon 

Can be accessed from the graphics palette using the F3 and F4 keys or the icons 

Initial Example: Defines the initial situation of 
the PLC,
i= 0 to 63.

Standard Example: Defines the stable PLC state.
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Macro-Step 
steps

Only enabled on TSX/PCX/PMX57, Max: 250 per Macro-Step plus IN and OUT step.
Types of Macro-step steps:

Can be accessed from the graphics palette using the keys F3, F4, (Shift+F2), (Shift+F3), 
(Shift+F4) or the icons .

Initial Example: Defines the initial situation of 
the PLC,
i= 0 to 63.

Standard Example: Defines the stable PLC state.

IN Example: Macro-Step input step.

OUT Example: Macro-Step output step.
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Step + Transition Step/Transition:

Transitions Number of possible transitions by PLC type:
l TSX37-10 Max: 192,
l TSX37-20 Max: 256,
l TSX/PCX/PMX57 Max: 1024.
Type of transition:

Can be accessed from the graphics palette using the (F2) key or the icon .

Step + Transition Example: Simultaneously lays down a 
step with a number and tran-
sition.

Can be accessed from the graphics palette using the keys F6, F8, F9, F10 and F11 or the 
icons 

Standard Example: Allows the transition from 
one step to another.

AND divergence Example: Allows the simultaneous acti-
vation of a maximum of 11 
steps.
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Connectors Connector types:

AND convergence Example: Allows the simultaneous de-
activation of a maximum of 
11 steps.

OR divergence Example Allows you to create a branch 
to a maximum of 11 steps.

OR convergence Example Allows you to close a branch 
from a maximum of 11 steps.

Can be accessed from the graphics palette via the F5, and F7 keys or the icons .

Destination Example: n = destination step number.

Origin Example: n = origin step number.
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Oriented links Link types:

Comments Can be accessed from the graphics palette via the F12 key or the icon .

Can be accessed via the graphics palette via the F9key, or the icon .

Up Example: Allows the loop iteration of a 
chart (arrow keys).

Down Example: 

Left or right Example: 
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Creating a Grafcet module

Procedure Carry out the following actions:

Open the Grafcet 
module (chart)

Carry out the following actions from the Grafcet section previously created.

Step Action

1 Create a Grafcet section (See Creating or importing a Grafcet section, p. 107).

2 Open the Grafcet module (chart). (See Open the Grafcet module (chart), p. 
203)

3 Enter the following graphical elements:
l entering a step, a transition, a connector. (See Entering a step, an action, a 

connector, p. 204)
l entering a macro-step (See Entering a Macro-Step, p. 205) (only TSX 57).
l carrying out an AND divergence (See Carrying out an AND divergence, p. 

205).
l carrying out an AND convergence (See Carrying out an AND convergence, 

p. 207).
l carrying out a Step -> Transition link (See Carrying out a Step -> Transition 

link, p. 208).
l carrying out a Transition -> Step link. (See Carrying out a Transition -> Step 

link., p. 209)
l carrying out loop iteration. (See Carrying out a loop iteration, p. 211)

4 Program actions. (See Programming actions, p. 213)

5 Program the transition conditions. (See Programming the transition conditions, 
p. 214)

6 Enter comments. (See Entering comments, p. 215)

Step Action

1 Put the cursor on the Chart module in the Grafcet section.

2 Open the Chart module using the command Services/Open or using the con-
textual menu Open.
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Entering a step, 
an action, a 
connector

Carry out the following actions:

Step Action

1 Using the mouse:
Click on the graphical object situated in the graphical palette.
Using the keyboard:
Position the cursor on the grid at the required place (using the arrow keys).

2 Using the mouse:
Click on the grid at the required place, for:
l a step, a number is offered by default, modify it if applicable, then confirm it 

using ENTER.
l a step+transition, a number is fixed by default.
Using the keyboard:
Press the function key corresponding to the graphical object situated in the 
graphical palette to be inserted, for:
l a step, a number is proposed by default, modify it if applicable.
l a step+transition, a number is fixed by default.

3 Using the mouse or the keyboard:
Proceed in the same way for the other graphical objects.

4 Using the mouse:

Confirm the chart by clicking on the icon  or by using the command Edit/
Confirm.
Using the keyboard:
Confirm the chart using the ENTER key, or using the command Edit/Confirm.
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Entering a 
Macro-Step

A macro-step must be:
l defined in order to be inserted in a Grafcet module (chart or macro-step),
l created (using the application browser) in order to be entered in a Grafcet module 

(chart + macro-step),
l completed (number of the corresponding macro-step) in order to be validated.
Carry out the following actions:

Note:
When a chart is confirmed, the display changes:
l the graphical objects change from red to black, 
l the page border becomes gray.

Carrying out an 
AND divergence

An AND divergence starts with a transition and goes to a step. 

Step Action

1 Using the mouse:
Click on the graphical object situated in the graphical palette.
Using the keyboard:
Position the cursor on the grid at the required place (using the arrow keys).

2 Using the mouse:
Click on the grid at the required place.
Using the keyboard:
Press the function key corresponding to the Macro-step object (Shift +F2)

3 Using the mouse or the keyboard:
Enter a macro-step number, then confirm with ENTER.

4 Using the keyboard:
Confirm the chart using the ENTER key, or using the command Edit/Confirm.
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Carry out the following actions:

Note:
An AND divergence is always represented from left to right, the segment represent-
ed by a double line cannot be cut by another link. 

Step Action

1 Using the mouse:
Click on the graphical object situated in the graphical palette (F11).
Using the keyboard:
Put the cursor on the start transition or on the pre-existing divergence segment 
[A] (in the case of multiple divergence) using the arrows.

2 Using the mouse:
Click on the start transition or on the pre-existing divergence segment [A] (in 
the case of a multiple divergence).
Using the keyboard:
Press (F11).

3 Using the mouse:
Draw the link by clicking on the break points of the line [B] (change of direction) 
in the transition lines.
Using the keyboard:
Draw the link using the arrow keys.

4 Using the mouse:
Double click on the last break point or click again on the graphical object situ-
ated in the graphical palette (F11).
Using the keyboard:
Press F11 again on the last break point. If the destination cell is empty, a step 
is automatically created.

5 Using the mouse or the keyboard:
Modify the step number if applicable, then confirm using ENTER.
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Carrying out an 
AND 
convergence

An AND convergence starts with a step and goes to a transition. 

Carry out the following actions:

Notes:
The segment represented by a double line cannot be cut by another link.
An AND convergence can only be entered from right to left.

Step Action

1 Using the mouse:
Click on the graphical object situated in the graphical palette (F10).
Using the keyboard:
Put the cursor on the start step using the arrow keys.

2 Using the mouse:
Click on the start step [A].
Using the keyboard:
Press (F10).

3 Using the mouse:
Draw the link by clicking on the break points of the line [B] (change of direction) 
in the transition lines.
Using the keyboard:
Draw the link using the arrow keys. 

4 Using the mouse:
If the destination cell is empty, double click on the last break point or click again 
on the graphical object situated in the graphical palette to create the transition.
Using the keyboard:
If the destination cell is empty, press (F10) again on the last break point to cre-
ate the transition.
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Carrying out a 
Step -> 
Transition link

A step -> transition link starts with a step and goes to a transition. 

Carry out the following actions:

Step Action

1 Using the mouse:
Click on the graphical object situated in the graphical palette (F8).
Using the keyboard:
Put the cursor on the start step or on the pre-existing step -> transition link seg-
ment [A] (in the case of multiple link) using the arrows.

2 Using the mouse:
Click on the start step or on the pre-existing step -> transition link segment [A] 
(in the case of a multiple link).
Using the keyboard:
Press (F8).

3 Using the mouse:
Draw the link by clicking on the break points of the line [B] (change of direction) 
in the transition lines.
Using the keyboard:
Draw the line using the arrow keys.

4 Using the mouse:
If the cell is empty, double click on the break point or click again on the graph-
ical object situated in the graphical palette to create the transition.
Using the keyboard:
If the destination cell is empty, press (F8) again on the last break point to create 
the transition.
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Carrying out a 
Transition -> 
Step link.

A transition -> step link starts with a transition and goes to a step.  

Carry out the following actions:

Step Action

1 Using the mouse:
Click on the graphical object situated in the graphical palette (F9).
Using the keyboard:
Put the cursor on the start transition or the source connector using the arrow 
keys.

2 Using the mouse:
Click on the start transition or the source connector [A]
Using the keyboard:
Press (F9).
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3 Using the mouse:
Draw the link by clicking on the break points of the line [B] (change of direction) 
in the transition lines.
Using the keyboard:
Draw the link using the arrow keys as far as the step or the destination connec-
tor.

4 Using the mouse:
If the destination cell is empty, double click on the last break point or click again 
on the graphical object situated in the graphical palette to create the step.
Using the keyboard:
If the destination cell is empty, press (F9) again on the last break point to create 
the step.

5 Using the mouse or the keyboard:
Modify the step number if applicable, then confirm using ENTER.

Step Action
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Carrying out a 
loop iteration

Two types of loop iteration are available to complete a chart: 

Using directed links:

Step Action

1 Using the mouse:
Click on the graphical object situated in the graphical palette (F9).
Using the keyboard:
Put the cursor on the start transition [A] using the arrow keys.

2 Using the mouse:
Click on the end of chart transition [A].
Using the keyboard:
Press (F9).

3 Using the mouse:
Draw the link by clicking on the break points of the line [B] (change of direction) 
in the transition lines.
Using the keyboard:
Draw the link using the arrow keys as far as the step or the destination connec-
tor.

4 Using the mouse:
Double click on the step to be linked or click again on the graphical object sit-
uated in the graphical palette to validate the object.
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Using connectors:

Example of loop iteration using connectors: 

Step Action

1 Using the mouse:
Click on the graphical object situated in the graphical palette (F5 or F7)
Using the keyboard:
Place the cursor in the required place.

2 Using the mouse:
Click on the grid at the required place.
Using the keyboard:
Select the required graphical object by pressing (F5 or F7).

3 Using the mouse:
Complete the source or destination step number, then confirm using ENTER.
Using the keyboard:
Complete the source or destination step number, then confirm using ENTER
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Programming 
actions

Carry out the following actions:

Step Action

1 Using the mouse:
Select the step with a right click.
Using the keyboard:
Put the cursor on the step using the arrow keys, then confirm the selection by 
using the command (Shift+F10).

2 Using the mouse:
Select the type of action associated with the step (activation action, continuous 
action or deactivation action).
Using the keyboard:
Use the arrow keys to select the type of action associated to the step that is to 
be modified, then confirm with ENTER.

3 Using the mouse:
Select the type of language:
l ladder language LD,
l instruction list language IL,
l structured text language ST,
and confirm withOK
Using the keyboard:
Select the type of language using the arrow keys:
l ladder language LD,
l instruction list language IL,
l structured text language ST
and confirm with OK.

4 Complete the programming.
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Programming 
the transition 
conditions

Carry out the following operations:

Limitations:
l in ladder language (LD) only the follow elements can be used:

l test graphical elements: contacts (Bi, I/O, Ti, D…), comparison blocks,
l action graphical elements: only "transition condition" coils (other coils not be-

ing relevant in this case). 
l in instruction list language (IL) the following objects are prohibited:

l no labels (%L),
l no action instructions (bit objects, words or function blocks),
l no jumps, sub-routine calls.

l in structured text language (ST) the following objects are prohibited:
l no labels (%L),
l no action statements, conditional statements or iterative statements,
l no actions on bit objects,
l no jumps, sub-routine calls,
l no transfers, no action instructions on blocks.

step Action

1 Using the mouse:
Select the transition with a right click.
Using the keyboard:
Put the cursor on the transition using the arrow keys, then confirm the selection 
by using the Service/Open command.

2 Using the mouse:
Select Open
Using the keyboard:
Select the type of language using the arrow keys:
l ladder language LD,
l instruction list language IL,
l structured text language ST,
and confirm with ENTER.

3 Using the mouse:
Select the type of language:
l ladder language LD,
l instruction list language IL,
l structured text language ST
and confirm with OK
Using the keyboard:
Complete the programming.

4 Using the mouse:
Complete the programming.
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Entering 
comments

Carry out the following actions:

Notes:
Comments are not mandatory.

They are stored on the PLC, as a consequence they take up memory.

Step Action

1 Using the mouse:

Click on the graphical object situated in the graphical palette . 
Using the keyboard:
Position the cursor on the grid at the required place (using the arrow keys).

2 Using the mouse:
Click on the grid at the required place.
Using the keyboard:
Press the function key (F12).

3 Enter the comment (access the second line using (CTRL+ENTER).

4 Confirm with ENTER.
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Modifying a Grafcet program

Introduction  A Grafcet module (Graphic object, Step number, Macro-step (TSX 57 only), Com-
ment), is modified in the same way as it is created.

Actions and transition conditions are modified in the same way as they are created.

Rules for 
modifying a chart

A modification is authorized on any Grafcet page if:
l no other modification is in progress in the editor,
l no language editor is open on a transition condition or action module. 

Modifications can only be entered on the page in the process of being modified 
(chart displayed in red).

Modifications can be only made in Offline or Online mode, with the PLC in STOP 
mode.

Modifications cannot be made:
l in step by step program,
l when a breakpoint is set in the program.

Modifying a 
graphic object, 
comment, step 
number or 
connector

Carry out the following actions:

Step Action

1 Put the cursor on the required Grafcet page (See Structure of a Grafcet page, 
p. 197).

2 Using the mouse:
Left double click on the element to be modified (the chart goes into modification 
mode, and is displayed in red). 
Using the keyboard:
Put the cursor on the element to be modified.

3 Using the mouse:
Make the modification.
Using the keyboard:
Press the space bar (the chart goes into modification mode, and is displayed 
in red).

4 Using the mouse:
Confirm with ENTER.
Using the keyboard:
Make the modification.

5 Using the keyboard:
Click on ENTER.
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Modifying a 
Macro-Step

The procedure for modifying a macro-step or a macro-step number is the same as 
the procedure for modifying a step or a step number.

A macro-step can be accessed by selecting the macro-step in the application brows-
er or by selecting the macro-step object in the Grafcet page.

Modifying an 
action:

Carry out the following actions:

Modifying a 
transition 
condition

Carry out the following actions:

Step Action

1 Put the cursor on the required Grafcet page (See Structure of a Grafcet page, 
p. 197)

2 Using the mouse:
Select the action to be modified by right clicking on the associated step.
Using the keyboard:
Using the arrow keys, put the cursor on the associated step then confirm the 
selection by using the  Service/Open command.

3 Using the mouse:
Select the type of action associated to the step that is to be modified. 
Using the keyboard:
Use the arrow keys to select the type of action associated to the step that is to 
be modified, then confirm with ENTER.

4 Make the modification.

Step Action

1 Put the cursor on the required Grafcet page (See Structure of a Grafcet page, 
p. 197).

2 Using the mouse:
Select the transition condition to be modified by right clicking on the associated 
step.
Using the keyboard:
Using the arrow keys, put the cursor on the associated step then confirm the 
selection by using the  Service/Open command.

3 Using the mouse:
Select Open.
Using the keyboard:
Make the modification.

4 Using the mouse:
Make the modification.
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Cut/Copy/Paste/
Move one or 
more 
consecutive 
objects.

These actions can be performed on graphic objects and any programs associated 
with them. They can be made in offline and online mode, with the PLC in Stop mode.
Carry out the following actions:

To….. you must…

copy one object or several con-
secutive objects

l 1. Select the object or objects to be copied.
l 2. Select Copy from the Edit menu or press 

CTRL+C (keyboard shortcut) and the Grafcet ob-
jects are placed on the Windows clipboard.

paste one object or several con-
secutive objects from the clip-
board

l 1. Select the cell where the object or objects on the 
clipboard are going to be pasted.

l 2. Select Paste from the Edit menu or press 
CTRL+V (keyboard shortcut) and the ghosted selec-
tion appears.

l 3. Click on the ghost or press ENTER to make the 
pasted objects appear. 

cut (delete) one object or several 
consecutive objects and place 
them on the clipboard

l 1. Select the object or objects to be cut.
l 2. Select Cut from the Edit menu or press CTRL+X 

(keyboard shortcut) and the Grafcet objects are 
placed on the Windows clipboard.

move one object or several con-
secutive objects

l 1. Select the object or objects to be moved.
l 2. According to your choice:

l Left click (keeping the button held down) on the 
selected cell or cells then move the cursor to-
wards the destination cell or cells.

l Select Move from the Edit menu or CTRL+L 
(keyboard shortcut) then using the arrow keys 
move the cursor towards the destination cell(s).
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Replacing a variable in the application

At a Glance Finding and replacing an application variable in the form of an address or a symbol 
(excluding variables used in runtime screens). Replacement in the application may 
be total or partial, automatic or manual.

Replacement concerns the variable indicated and its dependent objects (word ex-
tract bits etc.).
Exception: for Grafcet step bits the associated activity times (e.g. %Xi.T) are not re-
placed.

Replacement is carried out at the following levels:
l Application (in all tasks).
l Tasks (MAST, FAST, Evti).
l Complete section.
l  Partial section (from address i to address j).
l Replacement is also carried out at functional module level (complete functional 

module, sub-modules included).

Procedure Carry out the following actions:

Step Action

1 Select the commandTools/Replace variables or position the cursor over the 
Station directory and select Replace variables from the contextual menu.

2 Indicate the variable to be replaced (as an address or a symbol) in the Find 
zone and confirm with ENTER or TAB.

3 Indicate the replacement variable (as an address or a symbol) in the Replace 
field and confirm with ENTER.

4 Select the view:

l Structure view

l Function view

5 Select one or more modules:
l if replacing throughout application, go to point 8,
l if replacing in some of the modules, deselect all, select the modules, and go 

to point 6,
l if replacing in one of the modules, deselect all and select the module, and 

go to point 6.
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6 Select the label (if LD, ST, IL) or the page (if G7) at the beginning of the re-
placement by positioning the pointer on the listFrom.
If more precision is required, use the up and down arrow keys.

7 Select the label (if LD, ST, IL) or the page (if G7) at the end of the replacement 
by positioning the pointer on the listTo.
If more precision is required, use the up and down arrow keys.

8 Select the type of replacement:
l if Next, the replacement is carried out occurrence by occurrence,
l if Replace All, the replacement is carried out on all occurrences.
Notes:
l The status bar indicates the number of replacements carried out, and a re-

port on the replacements not carried out.
l The ESC key is used to abort the function Replace, but the replacements 

already carried out are retained.

Step Action
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Cross Referencing a variable in an application

Introduction This function allows you to locate in the application:
l variables in the form of labels or symbols (except those used in operating 

screens),
l DFB types (only on TSX Premium with Pl7 Junior and Pro),
l DFB instances (only on TSX Premium with Pl7 Junior and Pro),
l and to open modules/tasks/DFB types.

Principals of 
using debugging

The user realizes that the variable X is not the right value. To identify the cause he 
must therefore: 
l find the places where this variable is used,
l obtain a list of statements, rungs and expressions,
l to display and verify the activation conditions of the variable. 
Note:
In order to record the path of this search, the list elements thus visited are marked 
with an asterisk (*).

Operational 
mode for objects

A variable can be a read variable (R), a write variable (W) or a read/write variable 
(R/W).

- "R" groups together the read operational modes, indexed read, indexed word, in-
put or input/output parameter of a indexed or non-indexed function.

- "W" groups together the write operational modes, indexed write, output or input/
output parameter of indexed or non-indexed function and execution of Block Func-
tions (SFB and DFB).

Search source 
variables

Table of variables:

Other retrievable variables:

Bit %Ixi; %QXi; %Mi; %Si

Word % MWi; %MDi; %MFi; %KBi; %KWi; %KDi; KFi; %MBi; %SWi; %QWi; %QDi; 
%IWi; %IDi; %NWi

Instruc-
tion

SRi; HALT

Byte variables

Word extract bits

Bit table

Grafcet bit table

Character string
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Search options For an indexed variable, the variable and the index are taken into account in the list.

Table of options:

Table of words and constants

Table of double words and constants

Constant character string

Standard Block Function

Standard Block Function element

Step status

Step activity time

Manet variables

Extract Bit This option is for variables of types %MW, %KW, %IW, %NW, 
%QW. It adds to the list the variable and the referenced bits.

Table Object This option is for bit tables, word tables and immediate indexed vari-
ables. It adds to the list the immediate indexed table variables 
whose first element is the input variable.

Channel Object This option is for channel objects. It adds to the list all the objects of 
the same referenced channel, including the tables and the extract 
bits.

Network Objects This option is for the network variables. It allows you to obtain all the 
variables from the same remote module (nanet object).

FB Object This option allows you to expand the list of SFB block function ele-
ments and the DFB type elements.

FB Instance Only on TSX Premium with PL7 Junior and Pro.
This option is for DFB types. It allows you to obtain from the name 
of a DFB type the sections using its instances.
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Searching for 
cross references

Carry out the following actions:

Selecting a variable from the list:
l Select the variable from the list, the list of tasks, modules, labels is updated.
Deleting a variable from the list:
l Select the variable, enable the contextual menu (right click) then click on Delete.
Displaying in structural view or in functional view:
l Use the View menu or the  Function button.

Step Action

1

Select the icon  

2 Enter the search source variable as an address or a symbol (E.g. %M10) and 
the possible options then confirm via Search.

3 To display a module, select the module, via the Contextual menu, select Open 
or double click on the module.
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Animation of Grafcet program elements

At a Glance Refer to the "Debugging" Chapter of the Part "Debugging, Adjustment, Docu-
mentation and Appendices"-> (see Animating program elements, p. 285 ) .
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Printing of a program

Procedure Carry out the following steps:

Notes The print type depends on the type of display selected in the View menu.
l Addresses: prints variables with addresses,
l Symbols: prints variables with symbols,
l Symbols&Addresses: prints variables with symbols/addresses.

Step Action

1 Open the module with right click + Open or a double click.

2 Select the command File/Print (Ctrl+P) or click on 

the icon 

3 Select a print range:
l if, the whole module, then go to step 6.
l if for part of a module, go to step 4.

4 Select %Li/TOP/BOTTOM (if LD, ST, IL) or start page (if G7).
If more precision is required, use the up and down arrow keys.

5 Select %Li/TOP/BOTTOM (if LD, ST, IL) or endpage (if G7).
If more precision is required, use the up and down arrow keys.

6 Confirm with OK or ENTER.
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Export/Import of source files

Refer to the "Import/Export" (See Import/Export, p. 341) chapter within "Debug-
ging, Adjustment, Documentation and Appendices". 
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10
Editing variables
Introduction

What’s in this 
chapter

This chapter describes how to use the variables editor.

What’s in this 
Chapter?

This Chapter contains the following Maps:

Topic Page

Accessing the variables editor 228

Input/Modification/Suppression of symbols and comments 229

Objects associated with a variable 231

Presymbolization 232

Sorting variables by symbols or addresses 234

Displaying variables in the editor 235

Cutting/Copying/Pasting variables in a variables editor 237

Entering/Modifying constants 238

Parametrizing predefined function blocks (FB) 239

Printing variables 243

Exporting/Importing variables 244
227



Editing variables
Accessing the variables editor

Introduction The editor allows the input/modifation/display of all the variables with their parame-
ters and attributes. 

Accessing the 
editor

Carry out the following:

Step Action

1 Open the application browser and on the repertoire select Variables menu 
Edit/Select.

2 Left click on the directory Variables.

3 Open the editor on the type of variables required with a double left click or via 
the Open contextual menu or by pressing ENTER.
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Input/Modification/Suppression of symbols and comments

Introduction The variables editor allows the input/modification/display/suppression of all the 
variables with their parameters and attributes.

Input/Modifica-
tion procedure

Carry out the following:

Step Action

1 Open the application browser.

2 Double left click on the Variables directory or  select this and then press the 
right arrow.

3 Select the variable type:
l MEMORY OBJECTS,
l SYSTEM OBJECTS,
l CONSTANTS,
l GRAFCET OBJECTS,
l PRE-DEFINED FB,
l I/O,
l DFB INSTANCES (only on Premium TSX with Junior and Pro PL7)

4 Select the variable format:
l EBOOL (bit): example %M1,
l BYTE (octet): example %MB25,
l WORD (16 bit word): example %MW0,
l DWORD (32 bit word): example %MD2,
l REAL (real 32 bit word): example %MF14,
l CHART: example: %X0,
l Macro module: example %XM0 (only Premium TSX with Junior and Pro 

PL7,
l FB: example %TM0,
l DFB type: example: Day_counter (only Premium TSX with Junior and Pro 

PL7).
With inputs/outputs select the module position:
l  I/O: 0...710,
l FIP: \adrUC.channel no. Point of connection no.\ module no.

5 Select the variable to be informed and make the entry:
l either directly into the symbol and comments field,
l or in an entry field (accessed by clicking on the entry field option).

6 Enter the symbol and press ENTER.

7 Enter the comment and press ENTER.
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Select the whole 
line

Click on the rectangle to the left of the variable address or press the keys 
(SHIFT+SPACE).

Suppression 
procedure

Carry out the following actions:

Step Action

1 Select the symbol, the comment or the whole line with the (Shift+Space) keys 
or left click on the line.

2 Select the command Edit/Suppress or press the Del key.
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Objects associated with a variable

Procedure In the variables editor, if the variable is preceded by the symbol "+", in order to know 
which objects are associated with the variable you must:

Step Action

1 In the variables editor select the type of variables you require. 

2 Select the command View/Variables sorted by address if the display is in 
symbols.

3 Select the variable.

4 Select the command Edit/Expand or double click on the "+", the list of all the 
objects (bits, words..) associated with the variable is displayed.

5 To close the list of objects associated with the variable, select the command 
Edit/Contract or double click on the "-" associated with the variable.
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Presymbolization

Introduction Presymbolization allows automatic association of constructive suffixes for a chan-
nel level (%Chxy.i) module language object with prefixes defined by the user.

The prefix defined by the user is the generic symbol given to the %Chxy.i channel 
(12 characters maximum).

The constructive suffix is the part of the symbol which corresponds to the bit object 
or %Chxy.i channel word (20 characters maximum).

The presymbolization function automatically generates a constructive comment. 
This succinctly reminds you of the role of the object.

Setting up Carry out the following actions:

Step Action

1 Open the variables editor (See Accessing the variables editor, p. 228). In the I/
O variable type.

2 Double left click on the  "T" associated with the channel object that is to be 
symbolized or position yourself on the channel object and select the  Edit/ Pr-
esymbolize command.

3 Three illustrations can be displayed:
l The channel object is not symbolized.

l Enter the prefix.
l The channel object is already symbolized (symbol of less than 12 

characters).
l If necessary modify the prefix.

l The channel object is already symbolized (symbol of more than 12 
characters).
A dialogue box shows:
l the actual channel symbol.
l the prefix used (limited to 12 characters).

If necessary modify the prefix.
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Suppressing 
presymboliza-
tion.

Cancelling presymbolization for a given logic channel is done to suppress all the ob-
ject symbols described in the presymbolization file.
Carry out the following actions:

Actions Step

1 Double left click on the  "T" associated with the channel object that is to be 
symbolized or position yourself on the channel object and select the  Edit/ Pr-
esymbolize command.

2 Only two options are suggested:
l Erase all presymbols.

No prefix is chosen, all the symbols are erased (including those which the 
user would have modified directly in the editor).

l Erase the prefixed presymbols.
The user indicates the prefix (example ANA) of the symbols to be erased: 
in this case only the symbols of objects with the entered prefix are erased.
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Sorting variables by symbols or addresses

Procedure To classify variables in:
l ascending order of address numbers, select the command View/Variables sort-

ed by addresses.
In the case of I/Os, the variables are classified according to the type of module 
configured.

l alphanumeric order of symbols, select the command View/Variables sorted by 
symbols.
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Displaying variables in the editor

Displaying 
variables used in 
the application

The variables used in the application (sections, subroutines, sequential tasks) are 
viewed in bold characters in the variables editor.

For this, input the Options\Variables editor\Usage in the application command 
before opening the variables editor.  

Example: 

Display of 
variables with 
overlapping

Overlapping is possible on the following variables: 
l %MB,
l %MW,
l %MD,
l %MF,
l %KB,
l %KW,
l %KD,
l %MF.

Example:
If %MW1 is used in the application, the overlapping is effective for:
l %MD1,
l %MF1,
l %MB2,
l %MB3.

Variables

MEMORY

%MD0
%MD1
%MD2
%MD3
%MD4
%MD5
%MD6
%MD7
%MD8
%MD9
%MD10
%MD11
%MD12
%MD13

DWORD
DWORD

Presel_trem1_a
Address Type Symbol

DWORD
DWORD
DWORD
DWORD
DWORD
DWORD

DWORD
DWORD
DWORD
DWORD
DWORD
DWORD

Presel_trem2_c

Presel_trem1_b

Presel_melang

Litres_tremie1

Litres_tremie2

Litres_melangeur

%MD0

parameters DWORD
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The overlapping is represented by displaying the variables in red characters and it 
is managed providing that:
l the variables are used in the application program (Sections, subroutines, events),
l the Options\Variables editor\Overlapping command has been selected before 

opening the variables editor. 
Example: 

Simultaneous display of the variables used in the application with overlapping is 
possible by selecting the commands:
l Options\Variables editor\Overlapping,
l Options\Variables editor\Usage in the application.
Example: 

Variables

MEMORY

%MD0
%MD1
%MD2
%MD3
%MD4
%MD5
%MD6
%MD7
%MD8
%MD9
%MD10
%MD11
%MD12

DWORD
DWORD

Presel_trem1_a
Variable Type Symbol

DWORD
DWORD
DWORD
DWORD
DWORD

DWORD
DWORD
DWORD
DWORD
DWORD
DWORD

Presel_trem2_c

Presel_trem1_b

Presel_melang

Litres_tremie1

Litres_tremie2

Litres_melangeur

%MD0

parameters DWORD

Variables

MEMORY

%MD0
%MD1
%MD2
%MD3
%MD4
%MD5
%MD6
%MD7
%MD8
%MD9
%MD10
%MD11
%MD12

DWORD
DWORD

Presel_trem1_a
Variable Type Symbol

DWORD
DWORD
DWORD
DWORD
DWORD

DWORD
DWORD
DWORD
DWORD
DWORD
DWORD

Presel_trem2_c

Presel_trem1_b

Presel_melang

Litres_tremie1

Litres_tremie2

Litres_melangeur

%MD0

parameters DWORD
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Cutting/Copying/Pasting variables in a variables editor

Introduction PL7 gives the option of Cutting or Pasting a selection of variables, within the vari-
ables editor.

How to Copy/
Paste a block of 
variables in a 
variables editor.

 Carry out the following steps:

How to Cut/Paste 
a block of 
variables in a 
variables editor

 Carry out the following steps:

Step Action

1 Select a block of variables by clicking and dragging from the first variable of the 
block through the whole block, keeping the Shiftkey held down, in the far left 
hand column of the variables editor.

2 Right click on the selection (contextual menu) and select Copy.

3 Place the cursor on the first variable in the block where the copied variables 
are to be pasted.

4 Right click (contextual menu) and select Paste.
Result: the following window appears. 

All the variables duplicated in this way should be renamed before you Paste 
them.

Paste

OK Cancel

Please modify all symbols before confirming

%M56
%M57

Trig_sect_remp
Trig_sect_vidan_mix_a Validation condition

Validation condition
CommentSymbolAddress

Step Action

1 Select a block of variables by clicking and dragging from the first variable of the 
block through the whole block, keeping the SHIFTkey held down, in the far left 
hand column of the variables editor.

2 Right click (contextual menu) on the selection and select Cut.

3 Place the cursor on the first variable in the block where you want to paste the 
copied variables.

4 Right click (contextual menu) and select Paste.
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Entering/Modifying constants

Introduction The variables editor is used to enter/modify/display  all the variables with their pa-
rameters and attributes.

Procedure Carry out the following operations:

Step Action

1 Open the application browser.

2 Double left click on the Variables repertoire or select this with the arrows and 
then press the right arrow.

3 Select the "CONSTANTS" variable type.

4 Select the variable format:
l BYTE (octet): example %KB26,
l WORD (16 bit constant): example %KW0,
l DWORD (32 bit constant): example %KD2,
l REAL (real 32 bit word): example %KF14.

5 Select the variable to be informed: example: %KW0.

6 Enter the symbol and press ENTER.

7 Enter the comment and press ENTER.

8 Select the Parameters option.

9 Select the entry/display base (optional):

10 Enter the value and press ENTER.
The syntax of the value automatically updates the associated base (e.g.: if 
16#AA is entered -> the base goes to hexadecimal). 
In the case of %KB messages:
l enter the chain of characters in quotes then press ENTER (e.g.: "Number 

of parts"),
l To modify a message, select the %KB byte with the base ’Begin Mess.’.

11 Deselect the parameter option to close the parameter entry window.
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Parametrizing predefined function blocks (FB)

Introduction The predefined  function blocks are: 
l %TMi timer FB,
l %Ti Series 7 timer FB,
l %MNi Monostable FB.
l %Ci Counter/down counter FB,
l %Ri Register FB,
l %DRi Drum FB.

The  %Ti, %MNi and %DRi  FBs must be declared in advance in software configu-
ration.

The editor is used to enter/modify/display all the variables with their parameters 
and attributes.

Procedure Carry out the following actions:

Step Action

1 Open the application browser.

2 Double left click on the Variables repertoire or  select this with the arrows and 
then press the right arrow.

3 Select the type: PRE-DEFINED FB .

4 Select the type of FB to be parametrized:
l Parametrizing %TMi (See Parametrizing %TMi, p. 240),
l Parametrizing %Ti (See Parametrizing the %Ti, p. 240),
l Parametrizing %MNi (See Parametrizing the %MNi, p. 240),
l Parametrizing %Ci (See Parametrizing the %Ci, p. 241),
l Parametrizing %Ri (See Parametrizing the %Ri, p. 241),
l Parametrizing %DRi (See Parametrizing the %DRi, p. 241),
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Parametrizing 
%TMi

Carry out the following actions:

Parametrizing 
the %Ti

Carry out the following actions:

Parametrizing 
the %MNi

Carry out the following actions:

Step Action

1 Select the variable to be informed (e.g.: %TM0).

2 Enter the symbol and press ENTER.

3 Enter the comment and press ENTER.

4 Select the "parameters" option.

5 Enter the PRESET value (%TMi.P: 0 to 999) and press ENTER.

6 Select the operating mode of the block: TP,TON,TOF.

7 Select the value of the time base TB.

8 Select the Reg option depending on the case (Adjusting by terminal).

Step Action

1 Select the variable to be informed (e.g.: %T0).

2 Enter the symbol and press ENTER.

3 Enter the comment and press ENTER.

4 Select the "parameters" option.

5 Enter the PRESET value (%Ti.P) and press ENTER.

6 Select the value of the time base TB.

7 Select the Reg option depending on the case (Adjusting by terminal).

Step Action

1 Select the variable to be informed (e.g.: %MN0).

2 Enter the symbol and press ENTER.

3 Enter the comment and press ENTER.

4 Select the "parameters" option.

5 Enter the PRESET value (%MNi.P) and press ENTER.

6 Select the value of the time base TB.

7 Select the Reg option depending on the case (Adjusting by terminal).
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Parametrizing 
the %Ci

Carry out the following actions:

Parametrizing 
the %Ri

Carry out the following actions:

Parametrizing 
the %DRi

Carry out the following actions:

Step Action

1 Select the variable to be informed (e.g.: %C0).

2 Enter the symbol and press ENTER.

3 Enter the comment and press ENTER.

4 Select the "parameters" option.

5 Enter the PRESET value (%Ci.P) and press ENTER.

6 Select the Reg option depending on the case (Adjusting by terminal).

Step Action

1 Select the variable to be informed (e.g.: %R0).

2 Enter the symbol and press ENTER.

3 Enter the comment and press ENTER.

4 Select the "parameters" option.

5 The length (1<LEN<255) of the registers can be modified in the software con-
figuration.

6 Select the operating mode of the block: LIFO,FIFO.

Step Action

1 Select the variable to be informed (e.g.: %DR0).

2 Enter the symbol and press ENTER.

3 Enter the comment and press ENTER.

4 Select the "parameters" option.

5 Select the number of steps NB (1 to16).

6 Select the value of the time base TB.

7 Select the STEPS field to define the bit status for each step.
1.  Allocate a variable %Qi.j or %Mi to each bit.
2. Show the value of variable for each step by clicking on the value 0 or 1 (flip 
flop).
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Editing variables
Cop/Paste the 
pre-defined 
function block 
parameters

This function is used to Copy/Paste the parameters of one function block into one 
or more other function blocks of the same family to avoid tiresome entering.

Carry out the following actions:

Note:

The Paste function can only be done with consecutive objects.

Step: Actions:

1 From the variables editor select the PRE-DEFINED FB type.

2 Select the desired FB family.

3 Select the FB to be copied by clicking to the left of the name (the line goes to 
reverse video).

4 Select the Edit\Copy SFB parameters command or, using the contextual 
menu Copy SFB parameters.

5 Select the target FB(s) by:
l clicking to the left of the name (for one FB),
l clicking to the left of the name + pressing the Shift key, and move the mouse 

up or down (for several FBs).

6 Select the Edit\Paste SFB parameters command or, using the contextual 
menu Paste SFB parameters.
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Printing variables

Introduction This heading is use to print the list(s) of variables with their parameters.

Procedure Carry out the following actions:

Step Action

1 In the variables editor select the type of variables you require.

2 Select the ascending order of printing with the command View → Variables 
sorted by address or View → Variables sorted by symbols.

3 Configure printing using the command File → Configuring printing.

4 Select the command  File → Print.

4 Select:
l "All" to print all the variables configured in the application with the various 

parameters.
l "Current type" to print the variables of the selected type.

5 Confirm printing with OK.
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Exporting/Importing variables

Refer to the "Debugging, adjusting, documentation and appendix" part Chapter 
heading "Importing and exporting": 
l See: Exporting variables, p. 357.
l See: Importing variables, p. 358.
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Function modules
Presentation

Object This chapter describes the function modules.

What’s in this 
Chapter?

This Chapter contains the following Maps:

Topic Page

Function modules 246

Properties of a function module 247

Creating a functional module 248

Programming a functional module 249

Debugging a functional module 250

Detaching/Deleting a functional module 251

Export of a functional module 254

Importing a functional module 255

Creating, deleting, moving, dragging and dropping an animation table in a 
functional module  

256
245



Function modules
Function modules

Definition l A function module is a group of program elements )sections, sub-programs, mac-
ro steps, animation tables, operating screens…) used to carry out a PL7 function.

l A function module can itself be broken down into lower level function modules.  In 
relation to the principle function these modules assume one or more PL7 sub-
functions.

Attributes of a 
function module

A function module is composed of:
l  a short name : 8 characters (e.g.: TR371), this name must be unique in the ap-

plication,
l a long name : 16 characters (e.g.: Continue/Withdraw for BT371),
l  function sub-modules : these are lower level function modules,
l associated program code modules. sections, events, grafcet module (Prl, 

Chart, macro steps Xm, Post),
l a descriptive form (with no maximum number of characters), stored in the PL7,
l associated animation tables,
l operating screens.
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Function modules
Properties of a function module

Properties to be 
defined

List of different properties to be defined:
l the short name: composed of 8 characters (e.g.: TR371), this name must be 

unique in the application,
l the optional long name composed of 16 characters (e.g.: Continue/Withdraw for 

BT371),
l the optional descriptive form stored in the PL7.

How to display or 
modify the 
properties

Carry out the following steps:

Step Action

1 Right click on the function module, in the  Function view of the Application 
browser.

2 Click on Properties.

2 Carry out the modifications.

3 Click on OK.

Note: The Apply button confirms the modifications without closing the window.
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Function modules
Creating a functional module

At a Glance A functional module can be created offline, with the PLC in Stop or in Run.

It can be created at Station level or at the level of each existing functional module.

How to create a 
functional 
module

 Carry out the following actions:

How to create a 
lower level 
functional 
module

 Carry out the following actions:

Moving a 
functional 
module

A functional module can be moved offline, with the PLC in Stop or in Run (this has 
no effect on the execution of the application). The movement only corresponds to a 
modification in the functional architecture of the application (a module is linked di-
rectly to theStation directory level or to another functional module).

To move a functional module:

Step Action

1 From the functional view, right click on the Station directory, or on the directory 
of an existing functional module, or place the cursor on this directory and then 
press Shift+F10.

2 Select Create.

3 Fill in the short name, the long name, the comment and confirm with OK.

Step Action

1 Right click on the "higher level" module or position the cursor on it and press 
Shift + F10.

2 Select Create.

3 Fill in the short name, the long name, the comment and confirm with OK.

Step Action

1 Left click (keeping the button held down) on the module to be moved,

2 Move the module to the desired position.
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Function modules
Programming a functional module

Introduction to 
programming a 
functional 
module

A functional module has aprogram directory which may contain:
l LD, ST, or IL sections, 
l events,
l of a Chart, Prl, Post, Macro-Steps module.

Several scenarios are possible during functional module programming:
l 1st scenario: the section, event and graph already exist in structure view (See 

Introducing the application browser, p. 102),
l 2nd scenario: the section, event, and graph are created from function view (See 

Introducing the application browser, p. 102),
l  3rd scenario: the section, event and graph must be created from structure view.

1st scenario: the 
section, event 
and graph 
already exist in 
structure view,

The section has already been created in structure view;

2nd scenario: 
creating the 
section, event, or 
graph from 
function view

The principle is the same as for creating a section from structure view:

Rules Take the following rules into account: 

Step Action

1 Select the section.

2 Move the section to the functional module.

Step Action

1 Right click on theProgram directory or place the cursor on the Program direc-
tory and then press Shift+F10,

2 Select Create,

3 Select the Section, Event or Macro step tab,

4 Fill in the various headings in the same way as for creating a section from the 
structure view. The name of the function module is stored at the structure view 
level.

1 A Grafcet section can only be created offline and only in the Mast task.

2 A macro step or an event can only be created offline.

3 The other actions can be carried out offline, with the PLC in Stop or in Run.

4 Module protection applies to all sections linked to the functional module.
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Function modules
Debugging a functional module

At a Glance The organization of a functional module and the distribution of sections events and 
Grafcet modules in the different modules has no effect on the execution of the pro-
gram. The program is executed in the order shown in the structure view. To debug 
a functional module there are:
l standard debugging functions,
l additional functions allowing incremental debugging of the application, functional 

module by functional module.

Deactivating all 
sections linked 
to a functional 
module

 This function is used to force to 0 all the execution conditions of the module sec-
tions.

Activating all 
sections linked 
to a functional 
module

 This action is used to force to 1 all the execution conditions of the module sections.

Canceling the 
forcing of all 
sections linked 
to a functional 
module

 This action is used to unforce all the execution conditions of the module sections.

Step Action

1 Select the functional module.

2 From the contextual menu, select the Activation condition for the included 
sections -> Force to 0command.

Step Action

1 Select the functional module.

2 From the contextual menu, select the Activation condition for the included 
sections -> Force to 1command.

Step Action

1 Select the functional module.

2 From the contextual menu, select the Activation condition for the included 
sections -> Unforcecommand.
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Function modules
Detaching/Deleting a functional module

Detaching one or 
more functional 
module(s)

Detaching a functional module involves severing the links between a functional mod-
ule and the associated objects (code modules and animation tables),
l the sections contained in the module are not deleted, only detached,
l the animation tables associated with the modules are not deleted but only de-

tached from the module.

To detach one or more of the functional modules, carry out the following steps:

Introduction to 
deleting a 
functional 
module

There are several different ways of deleting:
l deleting one or more functional modules without deleting the code modules and 

the animation tables,
l deleting a functional module and deleting the code modules and animation ta-

bles,
l deleting all the functional modules and deleting the code modules and animation 

tables,
l  deleting a section, a macro-step or an event in a functional module.

Deleting one or 
more functional 
modules without 
deleting the code 
modules and 
animation tables

 To delete a functional module without deleting the code modules and animation ta-
bles, you must: 

Step Action

1 Select the corresponding Station, Functional module, Program, Section, Event, 
or Animation Table directory in the Function View of the Application Brows-
er.

2 Select the Detach or Detach All Included Elements contextual menu.

3 Confirm with Yes.

Note: this action is allowed in offline and in online mode, with the PLC in Stop or 
in Run.

Step Action

1 Detach the module and its sub-modules.

2 Delete the module or modules by right clicking (contextual menu) and selecting 
Delete.

Note: you must be in offline mode.
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Deleting a 
functional 
module and 
deleting the 
modules and 
animation tables

Carry out the following actions:

Deleting all the 
functional 
modules and 
deleting the code 
modules and 
animation tables

Carry out the following actions: 

CAUTION

Deleting the module entails deleting the submodules.

- the sections contained in the module are deleted,
- the animation tables associated with the module are deleted.

Failure to observe this precaution can result in injury or equip-
ment damage.

Step Action

1 Select the module.

2 Select Delete.

3 Confirm with Yes.

Note: this action is authorized in offline mode, with the PLC in Stop and is not au-
thorized in Run.

CAUTION

Deleting the module entails deleting the submodules.

- the sections contained in the modules are deleted,
- the animation tables associated with the modules are deleted.

Failure to observe this precaution can result in injury or equip-
ment damage.

Step Action

1 Select the Station directory.

2 Select Delete All Functional Modules.

3  Confirm with Yes.

Note: this action is authorized in offline mode, with the PLC in Stop and is not au-
thorized in Run.
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Function modules
Deleting a 
section, a 
macro-step or an 
event in a 
functional 
module

Carry out the following actions:

Rules Please observe the following rules

CAUTION

A section or a macro-step can be deleted in a functional module. They 
are then deleted in the module and in the associated task. Deleting an 
event only results in it being detached from the functional module be-
cause an event cannot be deleted from the application.

Failure to observe this precaution can result in injury or equip-
ment damage.

Step Action

1 Select the desired section.

2 Select Delete.

3 Confirm with Yes.

1 Deletion is authorized in offline mode with the PLC in Stop, but it is not autho-
rized in Run.

2 A Grafcet section or a macro-step can only be deleted in offline mode.

3 A PRL, Chart or POST module cannot be deleted, only detached. 
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Export of a functional module

Exporting a func-
tional module

See Exporting a functional module, p. 362 from the section "Debugging, Docu-
mentation and Annexes" chapter "Import/Export" 
254 Operate modes manual 09/2000



Function modules
Importing a functional module

Importing a  
functional 
module

See Importing a functional module, p. 364 from the section "Debugging, Adjust-
ment,  Documentation and Annexes" chapter "Import/Export".
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Creating, deleting, moving, dragging and dropping an animation table in a 
functional module  

Introduction In a functional module, you can create, delete, move and drag and drop the anima-
tion table.

Creating an 
animation table

 Steps to follow: 

Deleting an 
animation table

 Carry out the following actions:

Moving an 
animation table

Steps to follow:

If the table… Then…

already exists l select the animation table,
l move the animation table to a functional module on the Anima-

tion table directory’s level.

is to be created via the 
function view

l right mouse click on the module’s Animation table directory or 
put the cursor on this and press Shift+F10,

l select Create.

is to be created via the 
structure view

it is also necessary that you specify the functional module it is to be 
associated with. 

Step Action

1 Select the table.

2 Select the Delete contextual menu.

If using… Then…

the drag and drop func-
tion

l left mouse click (and hold the mouse button down) on the table 
to be moved,

l move the table to the desired place.

the Properties contex-
tual menu

l select the table,
l select the Properties contextual menu.
l select the module’s name in the localization zone.
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Detaching an 
animation table

Steps to follow:

If using the… Then…

Detach contextual 
menu

l select the animation table,
l select the contextual menu,
l confirm with Yes.

Properties contextual 
menu

l select the table,
l select the Properties contextual menu.
l select "none" in the localization zone.
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DFB function blocks
Presentation

What’s in this 
chapter

This chapter describes how to set up DFB function blocks.

What’s in this 
Chapter?

This Chapter contains the following Maps:

Topic Page

DFB types 260

Creating a DFB type 261

Programming a DFB type 262

DFB type instance 265

Running a DFB instance 267

Entering a DFB instance 268

How to protect a DFB 269

How to Import/Export a DFB type or an application containing DFB types 270
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DFB function blocks
DFB types

At a Glance DFB types (Derived Function Block) are function blocks which can be programmed 
by the user in Structured Text or Ladder language.

These DFBs are used in an application to:
l simplify program design and entry,
l improve program readability,
l facilitate debugging (all variables manipulated by the DFB type are identified on 

its interface),
l reduce the volume of code generated (the code corresponding to the DFB is only 

loaded once, regardless of the number of calls to the DFB).

PL7 Pro software is needed to create a DFB type.

A DFB type can be used with PL7 Pro or PL7 Junior on a TSX/PCX/PMX 57 type 
PLC.

A DFB type is called in an editor (LD, IL or ST) via an Instance of the DFB type that 
is the image of the DFB type.

A DFB type instance can be used several times in a single application. 

How to gain 
access to the 
DFB types’ 
properties

Carry out the following actions:

The properties of a DFB type can be accessed by two tabs:
l The "General" tab which gives the following information:

l version,
l date of last modification,
l programming language used,
l protection.

l The "Information" tab which gives the following information:
l number of elements (Inputs, Outputs, Inputs/Outputs, etc.),
l size of data,
l number of instances used in the application.

Step Action

1 Select the DFB Type directory in the application browser.

2 From the contextual menu select the Properties command.
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DFB function blocks
Creating a DFB type

Presentation  A DFB type can be made up in several steps:
l creating the DFB type (empty structure),
l DFB type parameters,
l DFB type programming (Code).

Creating the DFB 
type

Carry out the following actions:

Note:

The choice of language Ladder or Structured text for the DFB code can be modi-
fied as long as the code is not entered.

Setting the 
parameters for 
the DFB type

This is done using the DFB type editor.  It consists of declaring:
l the input, input/output and output interfaces,
l the public variables,
l the private variables,
l and documenting the description file.

DFB type 
programming

Programming a DFB is done using the DFB code editor which can be accessed 
from the DFB editor.

Step Action

1  Open the application browser.

2 Right click with the mouse on the DFB type directory and select Create from 
the context-sensitive menu.

3 Enter the name of the new DFB type.

4 Select the language Ladder or Structured tex.t.

5 Click on OK.
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DFB function blocks
Programming a DFB type

Principles The code defines the processing that the DFB type must carry out depending on the 
declared interfaces.

All language instructions are permitted except for:
l calling up standard function blocks,
l calling up other DFB types,
l jumping to a label (JUMP),
l calling up a subroutine,
l instructions using input/output module variables (e.g. READ_STS, SMOVE etc.).

The code of the DFB type may only use:
l input/output objects (%I, %Q..),
l global application objects (%MW,%KW...) excluding %S and %SW bits and sys-

tem words.

There are functions specific to development of a DFB type such as:
l the timer functions, FTON, FTOF, FTP, FPULSOR, which can be used instead of 

timer function blocks,
l the instructions, LW, HW, COCATW which are used to handle double words,
l the instructions, LENGTH_ARW, LENGTH_ARD, LENGTH_ARR, which are 

used to calculate table lengths.

Programming 
rules

DFB instances can be used in various parts of the application, which use the lan-
guages LD, IL or ST (apart from in event tasks).
l sections,
l subroutines.

The programming rules are as follows:
l All table type input parameters and input/output parameters must be entered.
l Unconnected input parameters keep the value of the previous call or the initial-

ization value if the block has never been called with this entered or connected in-
put.

l All the objects assigned to input, output and input/output parameters must be of 
the same type as those entered at the time DFB Type creation,

l Only BOOL and EBOOL types can be mixed for input or output parameters.
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DFB function blocks
Entering and 
modifying code

Carry out the following steps:

Note:

DFB type code can only be entered or modified on an unprotected DFB type.

Code that has not been confirmed (in the process of being created or modified) is 
indicated by a red dash in the left hand margin of the editor.

Search/Replace: 
to find or replace 
an object in the 
code

This function is used to search for and/or replace an object (interface or variable) in 
the DFB code.

Searching for an object:

Search/Replace: to find/replace an object:

Step Action

1 Click on Code in the DFB editor or select Utilities/Open then click on ENTER 
to open the DFB code editor.

2 Enter the code.

3 Confirm the code.
Any confirmation made at DFB editor level is global.

Step Action

1 Select Search/Replace... from the Edit menu

2 In the Search zone indicate the object to be searched for (e.g.: Input0).

3 Select Next to go to the different occurrences in the order in which they appear.

Step Action

1 Select Search/Replace... from the edit menu.

2 In the Search zone indicate the object to be searched for (e.g.: Input0).

3 In the Replace zone indicate the object to be replaced (e.g.: Input1).

4 Select:
l Next to go to the first occurrence,
l Replace to replace only the current occurrence,
l Replace All to replace all occurrences.
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Confirming a 
DFB type

Confirming a DFB type is a global operation which can be used to confirm the inter-
faces, the variables, descriptive form and the code.

Carry out the following actions:

Note:

To confirm a DFB type, it must have at leastone Boolean input.

The DFB editor cannot be closed until the DFB type has been confirmed or can-
celed.

How to access a 
line of code

This function is used to go to a line of code within the code of a given DFB type by 
entering its numeric position.
Carry out the following steps to access a line of code:

Errors If there is an interface, variable or code error, the DFB type cannot be confirmed, 
and the system then positions itself at the first error.

You must:
1. Correct the error(s).
2. Reconfirm.

To confirm a DFB from… you must…

DFB editor

click on the icon  or select Edit/Confirm then 
press ENTER.

DFB code editor

click on the icon  or select Edit/Confirm DFB 
type then press ENTER.

Step Action

1 When the code is displayed, select the Edit → Go to command.

2 Enter the line number then click OK.
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DFB type instance

Presentation A DFB type instance is a named copy of a validated DFB type.

The same instance can be used several times in an application.

One DFB type can have several instances, in this case the Input/Output interfaces, 
the public variables and the private variables are duplicated (one duplication per in-
stance). The DFB code is not duplicated.

The name given to an instance cannot be:
l a PL7 reserved word,
l a symbol,
l an EF (elementary function),
l the name of a DFB type.

Creating an 
instance from an 
application 
browser

Carry out the following actions:

Creating an 
instance from the 
function library

Carry out the following actions:

Step Action

1 From the application browser, right click on the sub-directory DFB Variables/
Instances DFB.

2 Select the command Open.

3 Select the DFB type to be instanced using the mouse or the Tab and arrow 
keys.

4 Enter the name of the new instance in the last line of the Name field (32 char-
acters maximum).

5 Enter a comment in the Comments field (80 characters maximum).

6 Click on ENTER.

Step Action

1 Select Library from the Tools menu then select the DFB tab.

2 Select the type of DFB to be instanced in a line of the Name field.

3 Click on the button Create.

4 Enter the name of the new instance (32 characters maximum).

5 Enter any comments.

6 Click on Create.
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Modifying an 
instance

An instance is modified if its name and/or comments are modified.

Modifying the name of an instance:
l leads to the automatic updating of its sub-objects,
l can only be carried out if it is not referenced.

Deleting an 
instance

Carry out the following actions:

Step Action

1 From the application browser, right click on the sub-directory DFB Variables/
Instances DFB.

2 Select the command Open.

1 If the instance is not referenced in the application:
Select the instance to be deleted in the Name column and delete it.
If the instance is  referenced in the application:
1. Delete it in the corresponding language editor.
2. Select the instance to be deleted in the Name column and delete it.
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Running a DFB instance

Rules Running a DFB instance is done in the following order:

1. Loading the input and input/output parameters using the actual parameters.
Any input left free takes on the initialization value defined in the DFB type when be-
ing initialized or starting from cold, then the current value of the parameter.
The input parameters (except for table types) are sent by value, the input/output pa-
rameters are sent by address.

2. Running the text code, or ladder.

3. Writing the output parameters.
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Entering a DFB instance

Presentation Entering a DFB instance is done from:
l the ladder editor,
l the list editor,
l the structured text editor.

From the ladder 
editor

Carry out the following actions

From the list or 
structured text 
editor.

Carry out the following actions:

Step Action

1

Click on the graphic element in the graphics palette.

2 Select DFB.

3 Select the type of DFB required.

4 Select an instance required in Choice of instance or create a new instance 
(name and any comments then click on Create.

5 Click on OK.

6 Click on the destination cell (Test zone)  to set the type of DFB.

Step Action

1 Select the command Service/Enter function call or SHIFT+F8.

2 Select the DFB tab.

3 Select the required DFB block.

4 Select the required instance or create a new instance (any name + comments) 
then click on Create.

5 Enter the DFB type parameters in the entry field parameters.

5 Confirm your selection by OK.

6 Confirm your selection by ENTER.
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How to protect a DFB

Presentation There are two protection levels for a DFB type:
l modification protection which limits access to the DFB type editor to read only,
l expertise protection which prevents access to the DFB type code and to its pri-

vate variables.

Protection is only applicable on a validated DFB type.  It is managed by a password.

Protecting a DFB 
type

 Carry out the following actions:

Modifying 
protection type 
for a DFB type

 Carry out the following actions:

Modifying the 
password

 Carry out the following actions:

Step Action

1 Open the DFB type editor.

2 Select Edit/Properties of the type.

3 Select the protection type.

4 Enter a password (8 characters maximum).

5 Confirm by entering the password again.

6 Click twice on OK.

Step Action

1 Open the DFB type editor.

2 Select Edit/Properties of the type.

3 Select the new protection type.

4 Enter the password.

5 Click on OK.

Step Action

1 Open the DFB type editor.

2 Select Edit/Properties of the type.

3 Select Change.

4 Enter the current password.

5 Enter the new password (8 characters maximum).

6 Confirm by entering the password again.

7 Click on OK.
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How to Import/Export a DFB type or an application containing DFB types

Exporting/
Importing a DFB 
type

Refer to the "Import/Export" Chapter of the Part  "Debugging, Adjustment, Doc-
umentation and Appendices".

See Exporting a standard format DFB type, p. 376.

See Export of a binary format DFB type, p. 377.

See Importing a DFB type in binary format, p. 378.

See Importing a DFB type in binary format, p. 378.

Exporting/Im-
porting an 
application 
containing DFB 
types.

Refer to the "Import/Export" Chapter of the Part  "Debugging, Adjustment, Doc-
umentation and Appendices".

See Exporting an application with DFB, p. 380.

See Importing an application with DFBs, p. 382.
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III
 Debugging, adjustment, 
documentation and appendices
Introduction

Subject of this 
section

This section gives information about the application context and describes how to:
l Debug an application.
l Diagnose an application.
l Export/Import application modules. 

What’s in this 
part?

This Part contains the following Chapters:

Chapter Chaptername Page

13 Debugging 273

14 Adjustment of variables 309

15 Diagnostic functions 321

16 Documentation 333
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Debugging
Introduction

Subject of this 
chapter

This chapter describes the PL7 debugging functions. 

What’s in this 
Chapter?

This Chapter contains the following Maps:
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Debugging
Introduction to the PLC debugging screen

How to access 
the PLC 
debugging 
screen

 Carry out the following steps: 

PLC Debugging 
screen

ThePLC debugging screen offers different functions and information, which are di-
vided up into zones:

PLC debugging screen : 

l Designation (See CPU screen designation zone, p. 276) zone,
l Information (See Information zone, p. 277) zone, 
l Task (See Task Zones, p. 278) zone, 
l Operating mode (See Operating mode zone, p. 280) zone,  
l Event (See Event zone, p. 281) zone, 
l Last stop (See Last stop zone, p. 282) zone, 
l Real time clock (See Realtime clock zone, p. 283) zone.

Step Action

1 Click on the Debug menu on the PL7 task bar.

2 Click on the Access PLC debugging screen sub-menu. 

Note: To access the debugging functions you need to be in online mode (PLC → 
Connect).

 Designation: PROCESSOR TSX P 57352

 Task

 Operating mode

 Last stop  Realtimeclock

 Events

Time:

Number of events:
Status: 

Date:

Wednesday
Wednesday

Cause

Outputs in fallback mode

Network address: Number of forced bits:
Processor version:

TSX 57352  [RACK 0    POSITION 0]

 Information

10:16:3323/02/

Change to stop

Output fallback Warm Restart
Cold Start

Active STOP Error Bit error reset
0

OK

Cancel
Update

23/02/
10:27:08

TSX 57352
SYS

3.7(88)
0

IO DIAG...ERRRUN

Debugging

Period
Set

Min.
Duratio

Current
Duration

Max.
Durati

Cycle time
Fipio 

Watch
Dog

Opera-
ting

Stat
us

Cmd Enable 
task

Error Init
duratio

Reset
Def

MAST
FAST

CYCLIC
0 0 0 0 0 0 Not 

2 6 6 0 250 STOP a Run Deactivate Def Init Reset

Processor present:
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Debugging
CPU screen designation zone

At a Glance This zone allows you to find out the execution status of an application in the PLC.
Designation Zone: 

Description Elements and their functions:

RUN

 Designation: PROCESSOR TSX P 57352

IO ERR DIAG...

Element Function

The RUN 
indicator 

This indicates the state of the PLC:
l it is constant when the PLC is in RUN,
l it blinks when the PLC is in STOP.

The I/O in-
dicator

Red light indicating the errors on another module in the station or a configura-
tion error.

The ERR 
indicator 

Red light indicating the errors relating to the processor and its on-board devic-
es (PCMCIA memory card and PCMCIA communication card). 

The DIAG 
button

It gives access to diagnostics information. 
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Debugging
Information zone

At a Glance This zone provides miscellaneous information:
Information zone: 

Description Fields and their function:

Processor present:
 Information

TSX 57352

Network address: SYS

Processor Version:

Number of forced bits:

3.7(88)

0

Field Function

Processor present Provides information about the type of processor in the PLC. 

Network Address Provides information about the PLC network address.

Processor version Gives the version of the processor which is in the PLC.

Number of forced 
bits

Indicates the number of forced bits.
Operate modes manual 09/2000 277



Debugging
Task Zones

At a Glance This zone gives access to the various FAST task and MAST task execution com-
mands:
l RUN/STOP commands, 
l Activate/Deactivate Task commands,
l setting periods,
l Period Initialization command,
l Error Management commands.
Task Zone: 

MAST or FAST 
task RUN/STOP 
command

The RUN/STOP buttons associated with the MAST and FAST tasks are used to 
switch to RUN or STOP mode. 
In RUN mode the inputs are read, the program is executed and the outputs are re-
freshed. 
In STOP mode the inputs are read, the program is not executed and the outputs are 
not refreshed.

MAST or FAST 
task Activate/
Deactivate 
command

The Activate/Deactivate buttons associated with the MAST and FAST tasks are 
used to activate or deactivate a task.
When a task is activated, the code is scanned and executed. The inputs/outputs are 
refreshed.
When a task is deactivated, the code is neither scanned nor executed. The inputs/
outputs are still refreshed.  

Tasks
Current
Duration

40
FAST 5
MAST

Period
Set

10
1

Minimum
Duration

4
1

Cycle time
Fipio network

Maximum
Duration

4
3 0

55

CmdWatch
Dog

250
100

Operating
Mode
RUN
RUN

Status

a
a

Enable
task

Stop
Stop

Deactivate
Deactivate

Fault

Fault
Fault

Init
duration

Init
Init

Reset
Fault
Reset
Reset

Note: These functions are also accessible via the Debug menu.

Note: The Status field informs you of the status of a task:
l a: for active (the system bits %S30 and %S31 are set at 1),
l i: for inactive (the system bits %S30 and %S31 are set at 0).
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Debugging
Setting periods In periodic operation, the "Period set" column is used to set the task period. This set-
ting is lost on cold start. The value entered in the configuration is then taken into ac-
count. It is possible to save the period set using theUtility → Save task periods 
command.

Error initializa-
tion command

The minimum, current and maximum durations are provided by the PLC.
The Init button in the Init column restores these values in order to carry out new 
measurements (except the current duration). 

Error 
management 
commands

Buttons and functions:

Note: The Utility → Restore task periods command replaces the period set with 
the period defined in the configuration.

Button Function

Fault bit Enables any errors in the corresponding task to be viewed.

Reset Is used to reset the system bits associated with the task errors to zero, in order 
to be sure that the error(s) is/are still valid.
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Debugging
Operating mode zone

At a Glance This zone gives access to various modeling buttons:
l Warm restart,
l Cold start,
l Output fallback.
Operating Mode Zone: 

Description Buttons and functions:

 Operating mode

Output fallback

Cold startOutputs in fallback mode

Warm restart

Button Function

Warm Restart Click on this button to simulate a warm PLC restart.
This sets the %S1 bit to 1, which for example is used to command a partial 
initialization program.

Cold start Click on this button to simulate a cold PLC start.
This initializes the data, the system, and sets the %S0 bit to 1 which (in this 
case) is used for example to command a specific initialization program.

Output fall-
back

Is used to switch the outputs into fallback mode.
When the outputs are in fallback, the Output fallback button becomes Main-
tain outputs. It is therefore used to exit the fallback mode.
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Debugging
Event zone

At a Glance Event processing can be globally enabled or inhibited by the application program by 
means of the %S8 system bit or a terminal command (program debugging function). 
If one or several events occur whilst they are inhibited, the associated processing is 
lost.
The Event zone gives access to different functions.
Event Zone: 

Description Elements and functions:

Status:

 Events

RUN inactive Reset Fault BitFault

0Number of events:

Element Function

Number of 
events

Indicates the number of events executed.

Default button Is used to view the default bits and to access the events diagnostics pro-
gram.

Reset fault bit 
button

Is used to reset the fault bits associated with the execution of events to zero.

Status field Informs about the status of an event (active/inactive, RUN/STOP).

Icon Is used to activate/deactivate events.
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Debugging
Last stop zone

At a Glance This zone gives the diagnostics on the last stop of the PLC.
 Last stop zone: 

Description Fields and functions:

Change to Stop

29/02/2000 09:31:59

 Last stop

Cause

Tuesday,

Date: Time:

Field Function

Cause 
field

Gives the causes for the last stop of the PLC.

Date field Gives the date of the last stop of the PLC.

Time field Gives the time of the last stop of the PLC.
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Debugging
Realtime clock zone

At a Glance This zone gives access to the realtime clock settings.
Realtime clock zone: 

Description Buttons and functions:

Tuesday,

 Realtimeclock

29/02/2000 OK

11:09:49 Cancel
Update

Button Function

OK button Is used to confirm once the date and the time have been set using the double 
arrows.

Update 
button

Updates the realtime clock according to the date and time of the terminal.

Cancel 
button

Cancels all modifications if the PLC update has not been confirmed.
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Debugging
Modification of the program in Run mode

Introduction The program editor authorizes the modification of the application in RUN mode, ex-
cept for the Grafcet structure part.

Principals Modification of program elements LD, IL, ST PLC in RUN, is possible at the level of 
a LD rung, of an IL statement or of an ST instruction, except if the contents are con-
tained in an event processing (EVTi).

 The situation with Grafcet: only the processing linked to steps and transitions can 
be modified, Grafcet can not be modified. 

The operate 
modes

The operate modes are the same as for modification in PLC local mode or connect-
ed mode in STOP mode. However some modifications are applied:
l no jump on an undefined label, 
l not to be in step by step mode or have set a breakpoint, 
l the PLC must not be at default, 
l the multi-rung functions are not authorized, 
l it is impossible to add a function block which is not already represented in the ap-

plcation.

CAUTION

For security reasons, you are advised to start the PLC programming at 
the stopSTOP. Modification in RUNmode must be used for program 
modifications which do not require the application to be stopped and are 
under the responsibility of the user.

Failure to observe this precaution can result in injury or equip-
ment damage.
284 Operate modes manual 09/2000



Debugging
Animating program elements

At a Glance The animation of the parts of the program when the PLC is in RUN (rungs Ladder, 
instruction LIST sequence, Structured text sequence, Grafcet) is carried out directly 
in the language editors by activating the animation function when PL7 is connected 
to a PLC.

Ladder rung 
animation

The editor animates the following elements:
l the rungs are highlighted when they are running, 

l the coils are highlighted when the associated bit is set to 1, 

l the FB outputs are highlighted when they are set to 1. Some internal parameters 
are animated by the display of their numerical value inside the block.

Animation of List 
sequences

The editor carries out animation in the following way:
l a variable at 1 is indicated by a black rectangle,
l a variable set at 0 is indicated by a white rectangle,
l a forced variable is indicated by an F.

Example: 

Note: A forced variable is indicated by F.

%M12

%M12

R

LDN
ST
LD
ST

%M0
%M1
%M2
%M3
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Debugging
Animation of 
Structured text 
sequences (PL7 
Junior, PL7 Pro)

The editor animates by linking itself to the Animation tables tool in the following way:

Select the Option → Animation by tables, command after having started the Struc-
tured Text sequence editor, and the tool is then placed next to the editor.

Each language element displayed on the editor screen is entered in the table, keep-
ing to the limit of 40 possible variables.

Animation of the 
Grafcet steps

The editor carries out animation in the following way:
l an active step is indicated by a black rectangle, 
l an inactive step is indicated by a white rectangle, 
Example: 

Animation of 
macro-steps

A  macro-step is animated (highlighted) if at least one of these steps is active.

Animation of 
DFB code

If the DFB type has not been code protected, it is possible to view the code dynam-
ically using animation tables.
Select a call interface in a section then select the Opencontextual menu.

Note: For a table type variable, only the first element in the table is taken into ac-
count. It is therefore possible to add other elements from the table which may be 
important in the context of the application.

22

11
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Debugging
Animation 
commands

Commands and functions:

Com-
mand

Function

Utility → 
Stop Ani-
mation

Suspends animation.

Utility → 
Animate

Restarts animation.

Utility → 
Freeze

The animation is frozen, the variables change but the display is no longer re-
freshed.

Note: 
l the animation is synchronous with the end of the MAST task cycle.
l for all indexed objects, if index overflow occurs, there may be inconsistency in 

the animation.
Example:
LD %M[%MW10]  animation = status of indexed object even in the case of index 
overflow.
ST %M1  animation = status of %M0 if there is index overflow.
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Debugging
Grafcet debugging 

At a Glance Grafcet debugging allows you to:
l control charts in order to facilitate debugging,
l perform maintenance actions.
This makes it possible to check that the synchronization of operating modes and the 
coordination of tasks is being carried out correctly (forcing command).

When an installation is switched to manual mode, either for adjustment or because 
of an error, the context of the graph is saved (freeze command) and it is then possi-
ble to resume the cycle at the same place once the adjustment is finished or the fault 
has been acknowledged. 

How to gain 
access to the 
Grafcet 
debugging bar

 Carry out the following steps:

Step Action

1 Click on the debugging bar icon .

2 The following bar appears: 

PRG RUN aFrozen
 Chart status  Actions on chart  Prepositioning  Mast

Error
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Debugging
Grafcet 
debugging bar

The following illustration shows the arrangement of the command buttons in the de-
bugging bar. 

The animation of the Grafcet section’s activity condition is displayed on the far left 
of the debugging bar.

The  button is used to switch from the Grafcet debugging bar to the program 
debugging bar.

Zone Functions

Chart status Provides information about the chart status:
l Frozen:indicates whether or not the chart is frozen,
l Error: indicates whether there is an error in the chart,
l Button: can be activated when there is an error, is used to create an 

information box with the list of active errors.

Actions on chart Contains buttons which are used to:
l Freeze/Unfreeze the chart.

On Freeze, the active steps remain active and continuous actions 
only are executed.
On Unfreeze, the operating cycle resumes from the same place.

l Initialize the chart on these initial steps. It develops from these steps 
and continues in its current operating mode.

l Position the chart in an empty location with no step on the chart be-
ing active.

Prepositioning Contains buttons which are used to:
l Position the chart on the steps to be prepositioned that are selected 

from the grafcet editor.
Prepositioning is indicated by a full stop to the left of the step.

l Delete configured prepositions.
To delete the prepositioning of a step, select the step from the editor 
and the Delete prepositioning command from the contextual menu.

Mast Provides information on the task status:
l RUN a: Mast task active in Run,
l STOP a: Mast task active in Stop,
l RUN i: Mast task inactive in Run,
l STOP i: Mast task inactive in Stop,
l STEP: Step by Step program in progress,
l ERR: execution error.

PRG RUN aFrozen
 Chart status  Actions on chart  Prepositioning  Mast

Error
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Debugging
How to gain 
access to the 
Grafcet 
debugging 
screen

 Carry out the following steps:

The Grafcet 
debug browser

The Grafcet debug browser can be accessed from the Grafcet editor or from the ap-
plication browser’s Grafcet section using the contextual menu. 

This screen gives a hierarchical view of the chart with the nesting of the CHART 
module and macro-steps.

This view is animated in online mode with the animation indicated by the absence 
or presence of a token (an active macro-step is shown by the presence of a green 
circle). 
A certain number of operations are possible via:
l the contextual menu at the bottom of the screen,
l the contextual menu on an item describing a macro-step:

l deactivating a macro-step,
l activating a macro-step,
l editing a macro-step.

Step Action

1 In the Application browser in the  Structure view, look at the Program direc-
tory and right click (contextual menu) on the G7 icon. 

2 The following screen appears: 

Prl
Chart

Macro0
Macro1

Post

Grafcet Debug Browser

LDLD

G7G7

G7G7

operate

G7G7

Prl
Chart

Macro0
Macro1

Post

Grafcet Debug Browser

LDLD

G7G7

G7G7

operate

G7G7
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Debugging
Executing the programme

At a glance Executing an application on a PLC can be controlled using the functions:
l RUN, STOP, INIT PLC,
l RUN, STOP at the level of a task (MAST or FAST),
l breakpoint and step by step,
l Grafcet debugging.

Finding out the 
confirmation 
conditions of a 
section

 Carry out the following steps:

Accessing the 
contents of a 
section

 Carry out the following steps:

Operating the 
programme

In runtime:
l a  green circle indicates that the section is confirmed,
l a red circle indicates that the section is not confirmed (confirmation bit at zero).

Forcing the 
confirmation 
values of the 
section

 Carry out the following steps:

Step Action

1 In the Application Browser of the structure view, choose the section.

2 Right click (contextual menu) and select Properties.

Step Action

1 Go to the Application Browser of the Structure View.

2 Double click on the section icon.

Step Action

1 In the Application Browser in the  structure view, choose the section.

2 Select the contextual menu (right click)  Force the activation condition to 0 
orForce the activation condition to 1, this is indicated by a F on the green 
circle.
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Debugging
Task properties

Task 
configuration

The MAST task may feature:
l cyclical execution (default selection),
l periodic execution.

In cyclic operation, the task executions follow on directly from one another.
In periodic operation, the task executions are sequencced at a period set by the us-
er.

Whatever the operating mode: whether periodic or cyclic, the task is controlled by a 
watch dog device which is used to detect an abnormal period in the application pro-
gram. If overrun occurs, the S% system bit is positioned at t 1 and the application is 
declared in blocking fault mode for the PLC.

Task debugging The Operating mode zone indicates the status of the task execution.
The Duration zone indicates the execution time of the MAST and  FAST tasks.
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Debugging
Executing the MAST task

Introduction In this procedure, only the MAST task is executed.

How to put the 
MAST task into 
RUN

There are several ways in which the MAST task can be put into RUN:
l select the Debug → Run Mastcommand,
l select the Debug → Access the PLC debugging screen command and click on 

the RUN button associated with the MAST task.

How to put the 
MAST task into 
STOP

There are several ways in which the MAST task can be put into STOP:
l select the Debug → Stop Mastcommand,
l select the Debug → Access the PLC debugging screen command and click on 

the STOP button associated with the MAST task.
l click on the  STOP icon on the general panel.

Duration 
adjustment

In periodic operation, the "Adjusted Period" column is used to adjust the task period. 
This adjustment is lost on cold start, it is the value entered in the configuration which 
is taken into account in this case, it is possible to save the adjusted period using the 
Services → Save the Set Period command.

Note: The execution status of the task is shown in the debugging bar:
l STOP, RUN,
l a: the task is active (the %S30 system bit is at 1),
l i: the task is inactive (the %S30 system bit is at 0),
l Non Pr: the task is not programmed,
l STEP: step by step function in progress,
l ERR: execution error.

Note: The Service → Restore periods command replaces the period set with the 
period defined in the configuration.
The mimimum, current, maximum durations are provided by the PLC, the duration 
button Init in the column Init resets these values in order to carry out new process 
values.
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Debugging
Task 
activation-Fault 
management

The Activation/Deactivation button on theUC debugging screen is used to acti-
vate the MAST task when the latter is in RUN.

The Err button on theUC debugging screen displays the MAST task errors and the 
Reset button is used to reset the system bits associated with task errors to zero to 
ensure that the error(s) is/are still valid.
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Debugging
Executing the FAST task

Introduction In this procedure, only the FAST task is executed.

How to put the 
FAST task into 
RUN

There are several options for putting the FAST task into RUN:
l select the Debub → Run Fastcommand,
l select the Debug → Access the UC debugging screen command and click on 

the RUN button associated with the FAST task.

How to put the 
FAST task into 
STOP

There are several options for putting the FAST task into STOP:
l select the Debug → Stop Fastcommand,
l select the Debug → Access the UC debugging screen command and click on 

the STOP button associated with the FAST task.
l click on the  STOP icon on the general panel.

Duration 
adjustment

In periodic operation, the "Adjusted Period" column is used to adjust the task period. 
This adjustment is lost on cold start, it is the value entered in the configuration which 
is taken into account in this case, it is possible to save the adjusted period using the 
Services → Save the Set Periodcommand.

Note: The execution status of the task is shown in the debugging bar:
l STOP, RUN,
l a: the task is active (the %S30 system bit is at 1),
l i: the task is inactive (the %S30 system bit is at 0),
l Non Pr: the task is not programmed,
l STEP: step by step function in progress,
l ERR: execution error.

Note: The Service → Restore periods command replaces the period set with the 
period defined in the configuration.
The mimimum, current, maximum durations are provided by the PLC, the duration 
button Init in the column Init resets these values in order to carry out new process 
values.
Operate modes manual 09/2000 295



Debugging
Task 
activation-Fault 
management

The Activation/Deactivation button on theUC debugging screen is used to acti-
vate the MAST task when the latter is in RUN.

The Err button on theUC debugging screen displays the FAST task errors and the 
Reset button is used to reset the system bits associated to task errors to zero in or-
der to ensure that the error(s) present are still correct.
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Debugging
Execution of a program with breakpoint

At a Glance The software manages a single breakpoint which can be set in on-line mode on any 
program element (LD rung or IL, ST, DFB sequence) that is contained in the MAST, 
FAST, or SR tasks.
Setting these breakpoints is one of the functions of the debug bar.

How to access 
the debug bar

 Carry out the following steps:

Setting a 
breakpoint

Breakpoint are positioned directly from the languages editors.
Carry out the following actions:

Step Action

1 Click on the Debug menu on the PL7 task bar.

2 Click on the Debug bar sub-menu.
Result: the following bar appears at the bottom of your PL7 screen 

Step: Action:

1 Place the cursor on the program element (LD rung or IL, ST statement) that is 
to be the breakpoint.
Example: 

2

Select the Debug/Set the breakpoint command or click on the button  
on the debug bar.
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Debugging
With Structured Text:

Note:

Setting a new breakpoint deletes any existing breakpoint.

Executing the 
program

Execute the PLC/Run, Debug/Run Mast, Debug/Run Fast program if the PLC is 
not already in Run.
The program is executed until the rung, the statement or the instruction line (with 
Structured Text in line mode) associated with the point is reached. The statement, 
instruction line or the rung is not executed.
The breakpoint is displayed in yellow (step in progress), so it is possible to execute 
the program in step by step mode.

Accessing the 
breakpoint

To place the cursor directly on the breakpoint set in the application (without first ac-
cessing the program module), select the Debug/Show Breakpoint Inserted com-

mand or click on the button . 

Accessing the 
step in progress

To place the cursor directly on the step in progress in the application (without first 
accessing the program module), select the Debug/Show Current Step command 

or click on the  button on the debug bar.

Deleting the 
breakpoint

Select the Debug/Remove breakpoint command or click on the button  on the 
debug bar.

Step: Action:

1

 Select the Debug/Line mode command or click on the button  on the 
debug bar.

2 Place the cursor at the position on the instruction line at which the breakpoint 
is to be set,

3

Select the Debug/Set breakpoint command or click on the  button  on 
the debug bar.
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Debugging
With DFBs A breakpoint cannot be directly inserted into the code of a DFB type (accessible in 
read mode).

It is recommended that you set the breakpoint directly on the calling code element, 
then enter the instance code via the Call Module menu.

Module Call 
Stack

For an error diagnosed in a SR or in a DFB, the  Debug/Set up module call stack  
command is used to recognize the chronological sequence of calls that have led to 
the faulty module being executed.

The dialog box contains the following information:
l the current task name,
l the module call list as well as the line/statement number which have led to the 

execution of the faulty module (the first in the list is the top of the stack).

The View button is used to view the module selected in the stack. This function is 
also accessible by double clicking on the List Box.
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Debugging
Executing a program in step by step mode.

At a Glance The program is executed rung by rung, sequence by sequence or instruction line by 
instruction line (in line mode with ST). All the active tasks are executed, the inputs 
are acknowledged and the outputs are set.
One of the functions of the debug bar is to execute the program in step by step 
mode.

How to access 
the debug bar

 Carry out the following steps:

Step by step 
program 
execution

Carry out the following actions:

Step Action

1 Click on the Debug menu on the PL7 task bar.

2 Click on the Debug bar sub-menu.
Result: the following bar appears at the bottom of your PL7 screen 

RUN aGO cc c R7cF

 Mast  Evtebug  PLC  Monit.

RUN aRUN a

 Fast

Step: Action:

1  Insert a breakpoint in a module through which the program will pass when it is 
executed in step by step mode.

2 Give the AP/Run, Debug/Run Mastand Debug/Run Fast commands in pro-
gram execution mode. 
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Debugging
Commands The commands are accessible via the debug bar or the Debug menu:

Debug bar: Debug menu:

Button: Menu/Start task (in step by step mode).

Button: Debug/Go to next rung/next sequence/next instruction line  (execute 
the program element at the position at which it stopped and stop at the 
beginning of the following program element). With a SR call, this function 
does not enter the SR body and executes all of it.

Button: Debug/Call module (access SR module).

Button: Debug/Exit module (return to calling module).

Button: Debug/Abort Step by Step (the breakpoint is deleted and the task re-
starts).

Button: Debug/Show Current Step(move directly onto the current application 
step, without accessing the program module beforehand).

WARNING

With alarm relay:

At each step the alarm relay (or safety output) controlled by the PLC 
momentarily changes its status. At the end of the cycle, the outputs are 
refreshed for approximately 1 ms. To avoid these effects on the alarm 
relay and the physical outputs, the %S9 bit can be set at 1, which will 
force the physical outputs into fallback.

Failure to observe this precaution can result in severe injury or 
equipment damage.
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Debugging
Forcing TOR input

Introduction You must be in connected mode to access the forcing of TOR input .

How to force 
TOR inputs

Carry out the following steps:

To delete the forcing of a channel click on Unforce (select the channel then the con-
textual menu Command.

To delete the forcing of all of the module’s channels, click on the Global unforcing 
button.

Step Action

1 Select the command  AP →  Connect.

2 In Application Browser in the structure view, click on the Configuration direc-
tory, then double click (or contextual menu) on the Hardware configuration di-
rectory.

3 Select the module and then double click (or contextual menu).
Each channel is viewed:
l channel: input or output channel number, 
l symbol: symbol set by the user linked to the channel,
l parametering: memory, event…

4 Next select the channel and right click, then click on Command.                        

5 Select the commandForce to 0(state F0) or Force to 1 (state F1).
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Debugging
Forcing analog inputs, TSX Micro

Introduction You must be in connected mode to access the forcing tools. 

How to force 
analog inputs

Carry out the following steps:

Forcing an input When an analog input is forced, the value present in the module’s input is not avail-
able. The forced value is indicated in the  Value and Forcing fields on the screen.   
The forcing of inputs is active whether the PLC is in RUN or in STOP mode.

Forcing an 
output

When an analog output is forced, the value present in the module’s output is indicat-
ed in the Forcing field on the screen. The value calculated by the application re-
mains displayed in the screen’s Value field .

Deleting forcings To delete the forcing of a channel, select it and then press the Unforce button.

To delete the forcing of all of the module’s channels, click on the Global unforcing 
button.

Step Action

1 Select the command  AP →  Connect.

2 In Application Browser in the structure view, left mouse click on the Config-
uration directory then double click on the Hardware configuration directory.

3 Select the position of the module then double click on it.

4 Select the channel.

5 Select the forcing value.

6 Click on the Force button.

Note: When a channel is forced, the information  F appears in the value’s display 
zone.
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Debugging
Forcing analog inputs, TSX Premium

Introduction You must be in connected mode to access the forcing tools. 

How to force 
analog inputs

Carry out the following steps:

Forcing an input When an analog input is forced, the value present in the module’s input is not avail-
able. The forced value is indicated in the  Value and Forcing fields on the screen.   
The forcing of inputs is active whether the PLC is in RUN or in STOP mode.

Forcing an 
output

The forcing is only possible if the task associated to the output is in RUN mode. If 
the task is in STOP mode the output is put into fallback/maintain.
When an analog output is forced, the value present in the module’s output is indicat-
ed in the Forcing field on the screen.  The value calculated by the application re-
mains displayed in the Forcing on the screen field. The value calculated by the 
application remains displayed in the Value field on the screen.

Deleting forcings To delete the forcing of a channel, select it and then press the Unforce button.

To delete the forcing of all of the module’s channels, click on the Global unforcing 
button.

Step Action

1 Select the command  AP →  Connect.

2 In Application Browser in the structure view, left mouse click on the Config-
uration directory then double click on the Hardware configuration directory.

3 Select the position of the module then double click on it.

4 Select the channel.

5 Select the forcing value.

6 Click on the Force button.

Note: When a channel is forced, the information  F appears in the value’s display 
zone.
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Debugging
Adjustment of the application specific functions

Introduction You must be in connected mode to access the adjustment of the application specific 
functions.

How to adjust the 
application 
specific 
functions

Carry out the following steps:

In local: the input parameters correspond to the initial parameters (value of the pa-
rameters during the first start or during a cold re-start).

In connected: the input parameters correspond to the current parameters (they are 
lost during a cold re-start if they have not been saved beforehand).

The commands Commands and functions:

Step Action

1 Select the command  AP →  Connect. 

2 In the structural view’s Application browser selectConfiguration → Hard-
ware configuration.

3 Select the module position to be debugged then select the contextual menu 
(right click) Open the moduleor double click on the module.
The attainable functions are:
l viewing the parameters, 
l adjusting the selected channel.

4 Select the adjustment option to start the adjustment functions.

Command Function

Service → Save pa-
rameters

Allows you to save the current parameters (replacing the initial val-
ues with the current values) if the application is in RAM memory.

Service → Restore 
parameters

Allows you to replace the current values with the initial values. 

Note: the functions and the commands which are available depend upon the ap-
plication specific module which you are using.
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Debugging a functional module

At a Glance The organization of a functional module and the distribution of Grafcet sections, 
events and modules in the different modules has no effect on the execution of the 
program.  

The program runs in the order shown in structure view.

In order to debug a functional module, the user can use of the following functions:
l standard debugging functions. Refer to the "Access to debugging functions" 

heading of the " Debugging" Chapter  of the Part "Debugging, Adjustment, 
Documentation and Annexes".

l additional functions allowing incremental debugging of the application, functional 
module by functional module.

Execution 
condition of the 
sections

The execution condition is used to validate or inhibit a section by program.

The section is active if the condition is at 1 and it is inhibited if it is at 0 (on cold start, 
the execution conditions are at 0).

A section can be activated or deactivated by the user insofar as the condition is for-
cable.
Types of objects accepted as conditions:

Objects: Forcable:

%Si

%Mi X

Grafcet Objects

%MW:Xj X

%SW:Xj

%KW:Xj

%Mi[%MWj

%Mi[%SWj]

%Mi[%KWj]
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Debugging
Deactivation of 
all sections 
linked to a 
functional 
module

 Action used to force to 0 all the execution conditions of the module sections.

Activation of all 
sections linked 
to a functional 
module

 Action used to force to 1 all the execution conditions of the module sections.

Cancellation of 
the forcing of all 
sections which 
are linked to a 
functional model

 Action used to unforce all the execution conditions of the module sections.

Step: Action:

1 Select the desired functional module.

2 From the contextual menu, select the Activation condition for the included 
sections command.

3 Select the Force to 0 command.

Step: Action:

1 Select the desired functional module.

2 From the contextual menu, select the Activation condition for the included 
sections command.

3 Select the Force to 1 command.

Step: Action:

1 Select the desired functional module.

2 From the contextual menu, select the Activation condition for the included 
sections command.

3 Select the  Unforce command.
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Debugging
Debugging DFBs

Procedure Refer to the section "Debugging, Adjustment, Documentation and Annexes" 
Chapter "Debugging" headings: 
l see : Animating program elements, p. 285,
l see : Execution of a program with breakpoint, p. 297,
l see : Executing a program in step by step mode., p. 300, 
l see : Animation and modification of the variables: DFBs, p. 314.
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Adjustment of variables
Introduction

Subject This chapter describes how to adjust variables. 

What’s in this 
Chapter?

This Chapter contains the following Maps:

Topic Page

Animation of variables: creating Animation tables 310

Working with animation tables 312

Animation and modification of the variables: DFBs 314

Modification of the variables: 316

List of forced bits 317
309



 Adjustment of variables
Animation of variables: creating Animation tables

At a Glance The software is used to create animation tables containing lists of variables and is 
used to ascertain the value of the variables using various display types and to force 
the bit variables. The variables tables can be created in offline or in online mode.

It is possible:
l to create an animation table automatically,
l to create an animation table manually,
l to enter a table of variables of the same type.

Automatically 
creating an 
animation table

The software is used to automatically create animation tables by selecting one or 
more rungs LD (Ladder), statements  IL (Instruction List), instructions ST (Structured 
Text), or a DFB in the language editors and by activating a utility which initializes a 
new table with all the objects contained in the selected program element.
Procedure:

Manually 
creating an 
animation table

 Procedure:

Step Action

1 Access the program module of the structure or function views, on which the ta-
ble is to be created. 

2 Select the rung, the statement, the instruction and the DFB then select the Ini-
tialize Animation Table contextual menu. The tables which are automatically 
created in this way can then be modified by deleting or adding new variables.

Step Action

1 Select Animation Table in the application browser.

2 Select Edit/Create or use the contextual menu.

3 Enter the variables in address or symbol format and confirm with ENTER. The 
current value of the variables is displayed.

4 When the table is created, close the entry box.

5 Specify the name of the table, enter any comments and confirm with ENTER 
or Confirm As.
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Entering a table 
of variables of 
the same type

 Procedure:

Accessing an 
existing 
animation table

 Carry out the following steps:

Animation table 
properties

Animation table properties are:
l Table name: it is possible to modify the name, if the table is not open.
l Location: this gives the name of any potential functional module associated with 

the animation table when using PL7 Pro. The animation table can be assigned to 
a different functional module or detached from the functional module (select 
"None").

l Comment: the comment can be entered and modified.

How to display or 
modify the 
properties of an 
animation table

 Carry out the following steps:

Step Action

1 Enter the first variable.

2 Enter the separator - to increment the position or -.. to increment the channel.

3 Enter the length.

4 Confirm with ENTER.

Step Action

1 In the Application browser go to structure view.

2 Double click on the Animation table directory.

3 Double click on the Animation table that you want to access.
Result:the animation table editor appears.

Step Action

1 Select the animation table.

2 Select the Properties contextual menu.

3 Carry out the modifications.

4 Click on OK.
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Working with animation tables

At a Glance It is possible to perform several types of operation in an animation table:
l selecting and deleting one or more lines,
l entering a value for N consecutive variables,
l changing the format of N consecutive variables,
l inserting one or more lines,
l saving the animation table on the PC,
l deleting the table,
l changing the name of the table,
l masking the "Modification, Forcing" zone.

Selecting and 
deleting one or 
more lines

Selecting
Click on the rectangle on the left of the variable address (SHIFT+SPACE) in order 
to select the line or click and drag to select more than one line (the selected lines 
are highlighted in black).

Deleting
Select the line or lines and press Delete.

Entering a value 
for 
N consecutive 
variables

 Carry out the following steps:

Changing the 
display format 
for 
N consecutive 
variables

 Carry out the following steps:

Step Action

1 Click on the first of the consecutive values in the Current value field.

2 SHIFT+Click on the last of the consecutive variables in the Current Value 
field.
Result: the selected variables are highlighted in black.

3 Enter your value in the animation table entry field and confirm with Enter.
Result: the selected variables all have the same value.

Step Action

1 Select N consecutive variables as explained above.

2 Press the F9 key until the required format is obtained.
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Inserting one or 
more lines

Select the line before which the insertion is to be made and select the Insert a line 
contextual menu.

Saving the 
animation table 
on the PC

Select the command Edit → Confirm asenter the name of the table and confirm with 
OK.

Deleting an 
animation table

 Procedure:

Changing the 
name of an 
animation table

 Procedure:

Masking the 
"Modification, 
Forcing" zone

Select the View → Command Zone command.

WARNING

Displaying digital values:

If numerical values of more than three figures are truncated, change the 
thousands separator value in the Windows Control Panel under Re-
gional Settings, numbers section.

Failure to observe this precaution can result in severe injury or 
equipment damage.

Step Action

1 Select the table in question from the application browser.

2 Select Edit → Delete from the menu or press the DELETE key or use the De-
lete contextual menu.

Step Action

1 Select the table.

2 Press the F2 key or select the Properties contextual menu.

3 Enter the new name and confirm with OK.
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Animation and modification of the variables: DFBs

Introduction With DFBs, there are several possibilities for the animation and the modification of 
the variables:
l automatic creation via a DFB code,
l automatic creation via a DFB instance call,
l automatic creation via a DFB instance code,
l contraction and expansion,
l display and modification of a character string,
l the operate mode for the tables.

Automatic 
creation via a 
DFB code

It is possible to automatically create an animation table from a DFB code. Select the 
instance in the list and confirm with OK. All the accessible variables on the animation 
table level will automatically be input.

Automatic 
creation via a 
DFB instance 
call,

Proceed according to the following cases:

Note: You can only animate the instances used in the table. 

If the DFB type… Then…

is not protected the call interface and the public variables are viewed and are modifi-
able.
These standard functions are available only for the PL7 Pro product 
to enable debugging of the DFB type.
For the PL7 Junior product, the variables are not modifiable.

is protected  the call interface and the public variables are viewed in read-only. The 
instance variables are viewed in the table according to a Contract/Ex-
pand operate mode on the DFB types.
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Automatic 
creation via a 
DFB instance 
code

It is possible to automatically create an animation table from a DFB instance code. 
The variables of the instances depend on the level of protection.
Several levels of protection are possible:

Contract/Expand If the variable in the animation table is preceded by the + symbol, to know the objects 
associated to the variable:
l select the variable,
l select the Edit → Expand command or double click on the +, so the list of asso-

ciated variables is displayed.

To contract the list of objects associated to the variable, select the Edit → Contract 
command or double click on the -.

Displaying/
Modifying a 
character string

All the displayable ASCII characters (eg: 1,2,A,B,+,…) are displayed only in anima-
tion and the non-displayable ones are replaced by a vertical dash. The NULL char-
acter shows the end of the chain.  It is not displayed. In animation, only the first 10 
characters are displayed. 

To Display/Modify a whole string, you can:
l double click on the concerned cell,
l select the Display → Modify menu (as a contextual menu or on the menu bar).

Modification: all the objects whose attributes are mandatory inputs (objects whose 
attributes are by reference) are not modifiable.

The operate 
mode for the 
tables

According to the type of table chosen in the DFB editor (static or dynamic), the An-
imation tables tool offers:
l static tables:  Contract/Expand expand to the same level as the number of the 

element,
l dynamic tables: (in connected mode with the PLC in RUN) Contract/Expand ex-

pand when the instance is executed and the number of elements is known.

If the DFB type… Then…

is not protected the parameters and the public and private variables used in the code 
are viewed and are modifiable. These standard functions are available 
only for the PL7 Pro product to enable debugging of the DFB type. For 
the PL7 Junior product, the variables are not modifiable and the private 
variables are not viewed.  

is write-protected the parameters and public variables used in the code are viewed in 
read-only.

is in know-how pro-
tection

no access is possible.
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Modification of the variables:

Introduction The software allows you to create animation tables containing lists of variables, to 
know the value of the variables with different types of display and to force the bit vari-
ables.
The variables tables can be created in local or in connected mode.

Viewing the state 
of the variables

In connected mode, you can activate (Service → Animate command) or deactivate 
a table’s animation (Service → Stop animation command). The animation is car-
ried out asynchronously: all the values of the objects are read in the processor at the 
end of the MAST task’s cycle. You can view each value on the screen in different 
display modes.  The available modes depend on the type of the object. It is also pos-
sible to individually modify the value of a variable and to force or unforce the value 
of a bit.

Modifying a 
variable

 Steps to follow:

Forcing a bit in 
an animation 
table

 Steps to follow:

Unforcing a bit in 
an animation 
table

 Steps to follow:

Step Action

1 Select the variable and put the cursor on the Current value zone.

2 Input the variable’s value and confirm with Modify.

Step Action

1 Select the variable to be forced and put the cursor on the Current value zone.

2 Select Force 0 to force the bit to zero.  The forcing is shown by the letter F.  
Select Force 1 to force the bit to 1 and the forcing is again shown by the letter 
F.

Step Action

1 Select the variable to be unforced and put the cursor on the Current value 
zone.

2 Select Unforce.
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List of forced bits

Introduction PL7 features a tool which allows you to view the list of forced bits in the PLC at any 
given time without having to go into the animation table in the usual way.

Principles The forced bits display function is available from the PLC menu in online mode only. 
Launch the forced bits search and the resulting list is displayed in the animation ta-
bles editor. The entire man-machine interface is therefore sub-processed to the an-
imation tables editor.

The " Forced bits list" tool can be broken down into 2 components:
l A component in the PLC’s OS environment, with the following functions:

l managing a forced bits trace table in order to optimize the search,
l implementing a request to read the trace table.

l A component in the PL7 environment, with the following functions:
l searching for forced bits and creating a list of forced bits,
l initializing an animation table from this list.

List of forced 
bits" tool

You must be in online mode to access this tool.
Click on PLC → List of forced bits.
There are two possible scenarios:

If… Then…

the PLC 
contains 
no forced 
bits

the following message is displayed: "No forced bits."

there are 
forced bits.

a forced bits animation table appears: 

Modify
0
1

Forcing 0
Force 1
Unforce

F3
F7
F8

F4
F5
F6

Current value Kind
9
F1
F1
F1
F1
F1
F1
F1
F1
F1

 %SW108
 %M201
 %M202
 %M203
 %M204
 %M205
 %M206
 %M207
 %M208
 %M209

10/11
Type

 Forcing

Modification

Dec.
 Display

Symbol / NameAddress
F 1

Comment

TABLE_1 (Animated)*
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When the table is open, the PLC → List of forced bits command restarts the search 
creating another forced bits animation table.

Note: the List of forced bits table displays the forced bits at a given time t in the 
PLC and this table is not refreshed. In fact, we have a static image of the data read 
in the PLC at the time at which the PLC → List of forced bits is executed. To ob-
tain the list of forced bits at any given moment t+1 another List of forced bits table 
must be launched.
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Contents of the 
"List of forced 
bits" table

The contents of a list is identical to the contents of an animation table except that the 
system word %SW108 which gives information about the number of forced bits in 
the PLC, appears at the start of the list.

Review of table fields:
l address,
l symbol,
l current value,
l kind,
l type,
l comments.

Limits and 
restrictions

A List of forced bits table has a display capacity of 32 forced bits.
If the table is full, no further new forced variables are stored and the %S108 bit sys-
tem switches to 1. In the case of additional forcing, an OS internal flag will indicate 
this overflow.

When the maximum number of forced bits is reached, the OS component saves no 
further forcing/unforcing actions in the table. However, these actions are still carried 
out and there is no change to the operating procedures at the user and PL7 end.
In this context, there is inconsistency between the table contents and the PLC mem-
ory. An information message is displayed, which could be:
l "Overflow of number of forced bits",
l "Cold start necessary to reinitialize the forced bits table",
l "OK".

The forced bits list will be displayed again following a cold start (reinitializing all the 
forced bits and the forced bits table).
Operate modes manual 09/2000 319



 Adjustment of variables
320 Operate modes manual 09/2000



Operate modes manual 09/2000
15
Diagnostic functions
Introduction

Subject of 
chapter

This chapter describes the diagnostic functions available for diagnosing the hard-
ware and the application.

What’s in this 
Chapter?

This Chapter contains the following Maps:

Topic Page

Diagnostic of the PLC’s last stop 322

Module/channel diagnostics 323

Program diagnostics 324

Module call stacks 326

Diagnostics DFBs 327

Implementation of diagnostics DFB 328

DFB diagnostics error messages 329
321



Diagnostic functions
Diagnostic of the PLC’s last stop

Introduction To access the diagnostic of the PLC’s last stop, you need to be in connected mode. 

How to access 
the diagnostic of 
the PLC’s last 
stop

The UC debugging screen  which is accessible through the Debug → Access UC 
debugging screen  command, allows you to know the cause of the last stop and 
the date when this stop happened.   
Refer to the debugging chapter, last stop zone (See Last stop zone, p. 282). 
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Diagnostic functions
Module/channel diagnostics

Introduction The software provides various diagnostics tools. You must be in online mode to ac-
cess these tools.  

How to access to 
module/channel 
diagnostics 

 Carry out the following steps:

Note: the diagnostics for the Discrete modules and for the analog modules are 
performed in the same way as those described below.

Step Action

1 Select the command PLC → Connect.

2 In the Application Browser in the structure view, select the Configuration 
directory then double click on Hardware configuration.
When a module is faulty, a red indicator appears on the module position (see 
example below).

3 Select the position of the faulty module, then right click and choose the Open 
the module command or double click on the selected position.

4 Click on the Diag button.
The Diagnostics module screen displays the errors classified by category: in-
ternal errors, external errors or other errors. 
The Channel Diagnostics screen which is accessible by the Diag button in 
the command zone is used to refine the results.
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Diagnostic functions
Program diagnostics

Introduction To access the diagnostics tools it is necessary to be in online mode. To connect, se-
lect the PLC → Connect command.

Program diagnostics is used to find out the cause and the source of the switch to 
error mode. Various types of error are signaled:
l blocking errors (which cause the execution to be stopped),
l non-blocking errors (which become blocking when the application monitoring op-

tion is selected),
l non-blocking errors.

Blocking errors 
(causing the 
execution to be 
stopped)

Blocking errors causing the execution to be stopped:
l HALT instruction,
l incomplete JUMP instruction, 
l watchdog overflow,
l Grafcet table overflow (active steps, valid transitions),
l undefined downstream step (rerouting to one step).

Non-blocking 
errors (which 
become blocking 
when the 
application 
monitoring 
option is 
selected)

Non-blocking errors which become blocking when the application monitoring option 
is selected:
l index overflow,
l division by zero,
l capacity overflow of an unsigned arithmetic calculation,
l character string error (the character string transfer zone is too small to accommo-

date this string),
l floating point calculation error (division by zero, capacity overflow, incompatibility 

with the IEEE 754 format following the overlap of the memory zones etc.).

Non-blocking 
errors

the following are non-blocking errors:
l cycle time overflow,
l task inputs/output overflow,
l capacity overflow during an arithmetic calculation.

A blocking error is signaled on the status bar. 
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Diagnostic functions
Diagnostics 
procedure for 
blocking errors

Carry out the following steps:

A dialog box provides the diagnostics details:
l click on Show source to position the cursor on the faulty module,
l click on Show Module call stack to ascertain the chronological sequence of calls 

which led to the execution of the faulty module (from the most recent to the old-
est).

Diagnostics 
procedure for 
non-blocking 
errors

These errors are indicated for each task.
Carry out the following steps:

Application 
monitoring

To refine the diagnostics, or in other words, to make this fault type blocking in order 
to isolate it, choose the monitoring option (Mon.) on the debugging bar or use the 
Application monitoring command from the Debugmenu.
Then execute the diagnostics procedure for non-blocking errors.

Step Action

1 Access the debugging screen (Debug →  Access the PLC debugging 
screen). The ERR indicator flashes.

2 Click on the Diag button or select the PLC → Diagnostics command.

Step Action

1 In the PLC debugging screen, click on the Fault button which is associated with 
the task.

2 Click on the Reset Fault Bit button (reset bits systems to 0) to confirm the 
presence of the error on the different tasks (FAST, MAST, EVT).
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Diagnostic functions
Module call stacks

Introduction The Module call stack display function lets you know the chronological chain of 
calls that have led to the execution of the faulty module (from the most recent to the 
oldest), for a diagnostics error in a SR or a DFB type.

Accessing the 
Module call stack

This function is accessible in diagnostics and in step by step program. 

Click on Debug → Show module call stack.
The dialog box contains:
l the current task’s name. It is also possible to display the other tasks (only in di-

agnostics mode),
l the modules’ call list as well as the line/phrase which have led to the execution of 

the faulty module (the first in the list is the top of the pile).

The View button allows you to view the module selected in the stack (or just double 
click on the module).  This function is also accessible by double clicking on the Liste-
Box.
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Diagnostic functions
Diagnostics DFBs

Introduction The diagnostics DFBs are accessible from PL7-Pro , and are used in the applica-
tions which run on  TSX57/PCX57/PMX57 processors.

Diagnostics DFBs consist of:
l diagnostics application DFBs which are used to set up process monitoring via the 

application program:
l PL7 equation monitoring,
l monitoring the reaction time of the process to a command,
l monitoring the inputs/outputs and the ASI bus,
l monitoring the safety conditions.

l working part control and diagnostics DFBs which are used to control and monitor 
elements of the working part (EPOs):
l monitoring sensor information,
l monitoring actuator control requests,
l monitoring the duration of a movement,
l memorizing the minimum and maximum durations of a movement, 
l  learning the duration times of a movement,
l controlling an actuator.

At a Glance The DFB diagnostics provided with PL7-Pro are:

Descriptive form Every diagnostics DFB possesses a descriptive form describing the DFB function 
and its parameters (inputs, outputs and public variables).

This form is accessed by double clicking on a DFB type in the application browser, 
then by clicking on the Descriptive form tab in the DFB editor.

DFB Functions

EV_DIA Monitoring the status of 2 bits without taking a time factor into account.

MV_DIA Monitoring the status of two bits without taking a time factor into account, 
with the option of monitoring a movement’s changes (change of bit status 
within a given time period).

NEPO_DIA
TEPO_DIA

Monitoring, checking and diagnostics for a working part element.

IO_DIA Diagnostics for all the I/O modules.

ASI_DIA Diagnostics for an ASI inputs/output module.

ALRM_DIA Interface with diagnostics buffer (error storage).
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Diagnostic functions
Implementation of diagnostics DFB

Configuration of 
the diagnostics 
buffer

 To reserve a diagnostics buffer, carry out the following actions:

Registering 
diagnostic DFBs

 Before using a DFB in the application, carry out the following actions:

Programming 
rule for 
diagnostics 
DFBs

A Diagnostic DFB:
l must be executed in the MAST task for managing operate modes.  So that it is 

executed, it is necessary that:  
l the DFB is called (the program element to which it is assigned must be exe-

cuted)
l the ED input must be at 1.

l can be instanced in any program module (Section, SR) written in Ladder lan-
guage (LD), Structured Text (ST) or Instruction list (IL).  It is strongly recommend-
ed that you only program the instance once,

l imposes a Label on the rung or the phrase containing it.

Information 
system

System words and bits acquire information relative to the diagnostics:

Step: Action:

1 Open the application’s Properties dialog box (Station directory in the applica-
tion browser).

2 Choose the Diagnostics tab.

3 Tick the Activate the diagnostics in the application box.

Step: Action:

1 Import the binary DFB file (* .UFB) using Import binary from the contextual 
menu within the PL7’s installation directory (example C:\PL7\PL7PRO33\DI-
AG).

2 Create a DFB instance (See Creating an instance from an application browser, 
p. 265) in the PL7’s variables editor.

Object Information

%S101=1 Configured diagnostics buffer. 

%S102=1 Full diagnostics buffer.  If the diagnostics buffer cannot save an error, this error 
is lost and the %S102 bit passes to 1.

%SW162 The number of errors in the diagnostics buffer.
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DFB diagnostics error messages

Display window 
for error 
messages

All the error messages appear in a window in the lower part of the runtime screens 
tool.

The size of this window can be modified with the mouse, but its position is fixed. 
However, it can be hidden.

It consists of a list of messages and has:
l a vertical scroll bar allowing you to view any obscured messages in the list,
l a horizontal scroll bar used to view the entire contents of a line.

Illustration of the 
Viewer

Integrated Viewer in PL7-Pro 

A Diagnostics viewer is also available with the CCX17 V2.5.

Structure of error 
messages

Every line displayed in the Viewer corresponds to an error and contains the following 
information:
l the message status which is indicated by an icon plus text (the message having 

to be acknowledged or not),
l the faulty DFB type,
l the geographical zone in which the source of the error is located,
l the time and date when the error appeared,
l the time and date when the error disappeared,
l the message associated with the error,
l the value of the word status at the time of the error.

The user can increase or decrease the size of the columns using the mouse. A col-
umn not displaying the information in its entirety ends in an ellipsis.

The width of each column is stored and retrieved while opening the runtime screens 
tool. 

Message StatusAppearance: 5ZoneErrorAcknowledgment Disappearance: 5
Without Ack…Ev_dia 0 01/03/2000 - 18:21:41 01/03/2000 - 18:21:46 Mixing time too short (< 5 s) 16#
Without Ack…Alrm_dia 0 01/03/2000 - 18:21:43 01/03/2000 - 18:22:16 Maximum mixer level reached: 25 liters
Not Ack... Alrm_dia 0 01/03/2000 - 18:22:16 01/03/2000 - 18:22:18 Maximum mixer level reached: 25 liters
Without Ack…Ev_dia 0 01/03/2000 - 18:22:25 01/03/2000 - 18:22:25 Mixing time too short (< 5 s) 16#
Not Ack... Alrm_dia 0 01/03/2000 - 18:22:05 01/03/2000 - 18:23:11 Maximum mixer level reached: 25 liters
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Error message 
display

The number of messages it is possible to display is limited only by the size of the 
memory buffer. When there is not enough memory, a message warns the user and 
any messages of errors that have disappeared or have been acknowledged (if nec-
essary) are then deleted.

It is possible to modify the color of the messages and the blinking associated with 
an acknowledged message.

In the viewer, it is possible to show only those messages which come from one or 
more specific zones.

The list of messages can be sorted according to each field. To do this, simply click 
on the column header containing the data on the basis of which the sort is to be car-
ried out.
A second click carries out the sort in opposite order.

By default, the error messages are inserted into the list in the chronological order in 
which they appear.

Error message 
management

Possible operations:

Operation Implementation

Navigation With the UP, Down, Page-Up, Page-Down, Home, and End keys.

Acknowledge-
ment

By using the contextual menu having selected the corresponding item.
Several messages can be acknowledged at the same time.
After an acknowledgment, an order is sent to the PLC.
The acknowledgment can come from another viewer, in which case the runt-
ime screens tool is alerted and the message is displayed as acknowledged.

Deletion By using the contextual menu having selected the corresponding item or by us-
ing the Delete key.
Only messages that have disappeared and been acknowledged (if necessary) 
are deleted.

Properties By using the contextual menu, or the Enter key.
The following information is displayed:
l the name and type of the faulty DFB instance,
l the program address containing the faulty DFB instance,
l the associated text and status bits.
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Error message 
archiving

Archiving is used to create a log file. The activation and the location of this file are 
configured in a window that can be accessed using the Service/Configure/Viewer 
tab command.

It is possible to modify the directory in which the archive file is located.  By default, 
it is kept inC:\PL7USER\NameAppli.HIS.

This file is in ASCII format, so it is easy to import it into a text editor or a spreadsheet.

To stop the file from becoming too large, it is renamed in NameAppli.BAK every 
1000 saves and a new file is created with its source name. 

Error message 
customization

Messages can be customized for every diagnostics DFB instance.

The modification is made via the DFB variable editor menu and the new message is 
entered into the comment zone. 

Note:
The diagnostics DFBs that do not support error message customization are IO_IA 
and ASI_DIA.

WARNING

If a NameAppli.BAK file already exists, it is deleted without warning.

Failure to observe this precaution can result in severe injury or 
equipment damage.
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Documentation
Presentation

What’s in this 
chapter

This chapter describes how to create the documentation file for the application.

What’s in this 
Chapter?

This Chapter contains the following Maps:

Topic Page

Contents of documentation file 334

Documentation: application documentation file 337
333



Documentation
Contents of documentation file

At a Glance The documentation file of an application contains the following different headings:
l title page,
l contents,
l configuration,
l function view,
l program,
l DFB types,
l cross references,
l animation table,
l variables,
l cartridges.

Description of 
the title page and 
the contents

Title page:
this heading gives the name of the designer and the name of the project.

Contents:
the contents table is created automatically by the software according to the selected 
options.

Description of 
the configuration 
heading

This heading has two sub-headings:
l hardware configuration,
l software configuration.

Hardware configuration:
rack configuration, module parameters.
This sub-heading allows you to print the PLC configuration as well as the different 
parameters of the input/output modules. 

Software configuration:
this sub-heading allows you to print the application software configuration.

Description of 
the Function 
View heading

This heading gives the function view contents list.
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Documentation
Description of 
the program 
heading

Choosing this heading automatically selects the existing modules in the application. 
For each language LD, IL and ST select printing in symbol or address format.
The selected mode applies to all modules in the same language.
The "With Variables Used" option allows you to print the list of the variables used 
after each rung or phrase. 

Several sub-headings are available:
l application structure,
l MAST task,
l FAST task,
l event task.

Application structure:
this heading is used to print the application software structure as well as the tree 
structure subroutine calls.

MAST Task :
this sub-heading is itself built up of sections (as well as PRL/CHART/POST modules 
if there is a GR7 section) and subroutines.

FAST Task :
this sub-heading is also built up of sections and subroutines.

All of these headings are used to print the contents of the different sections that con-
stitute the program.

Description of 
the DFB Type 
heading

The following details are given for each DFB type:
l the properties,
l the descriptive form,
l the interface and public variables,
l the code (except for Schneider diagnostics DFBs),
l the private variables.
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Description of 
the cross 
references, 
animation tables 
and variables 
headings

Cross references:
this heading allows you to print the list or lists of variable cross references.

Animation table:
this heading allows you to print the different animation tables along with the address-
es, the symbols, the types and the kind.

List of variables :
this heading is used to print the list or lists of variables and their parameters.

Description of 
the footer 
heading

Select this heading to create a footer at the bottom of the documentation page:
l the blank fields can be filled in by the user,
l the shaded fields are filled in automatically.
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Documentation: application documentation file

Accessing the 
application 
documentation 
file

To access a documentation file, double click on the documentation file icon in the 
structure view of the application browser, a documentation window then displays 
the various components of the application documentation file. 

Components of 
the application 
documentation 
file

Each element of the documentation file can be included or excluded by using the 
contextual menu: by right clicking.
The elements included in the documentation file are marked with a red square.

To build the file carry out the following actions:

Setting the 
documentation 
file parameters

Various parameter settings are available for the documentation file:
l setting the footer parameters,
l setting the variable sorting parameters,
l setting the cross reference sorting parameters,
l setting the program printing parameters,
l setting the DFB printing parameters.

Setting the footer parameters
Click on the footer icon in the documentation window and select the Parameters 
contextual menu.
l the blank fields can be filled in by the user,
l the shaded fields are filled in automatically.

Step Action

1 Select each element to be included or excluded in the file using the Include 
heading or Exclude heading contextual menus or select Edit → Exclude 
heading from the menu.

2 Set the parameters for the various elements: Program, DFB type, Cross refer-
ences, Variables, Footer.

3 Select the Build contextual menu via the general documentation file icon or se-
lect Edit → Build from the menu.
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Setting the variable sorting parameters
Carry out the following actions:

Setting the cross reference sorting parameters
Carry out the following actions:

Setting the program printing parameters
Click on the Program icon in the documentation window and select the Parame-
ters contextual menu to access the different tabs:
l Instruction List tab

Select printing in either symbol or address format.
Check the With variables used box to also print the variables of the program 
module.

l Structured Text tab
Select printing in either symbol or address format.
Check the With variables used box to also print the variables of the program 
module.

l Ladder Language tab
Check the Long Text box to print all the symbols.
Select printing in symbol and/or address format.
Check the With variables used box to also print the variables of the program 
module.

Setting the DFB printing parameters
Carry out the following actions:

Step Action

1 Click on the variables icon in the documentation window and select the Pa-
rameters contextual menu.

2 Select the variable sorting order: ascending order of symbols, ascending order 
of addresses or both.

Step Action

1 Click on the Cross references  icon in the documentation window and select 
the Parameters contextual menu.

2 Select the variable sorting order: ascending order of symbols, ascending order 
of addresses or both.

Step Action

1 Click on the DFB type icon in the documentation window and select the con-
textual Parametersmenu.

2 Select the components to be printed.
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Documentation
Printing the 
documentation 
file

Documentation file print setup 
Carry out the following actions:

Note: It is  necessary to rebuild the documentation file if the printer is changed.

Print Preview
Carry out the following actions:

Printing the documentation file
Two printing options:
l printing the documentation file,
l printing a element of the documentation file.

Printing the documentation file

Printing an element of the documentation file

Step Action

1 Select the File → Print Setup menu.
l if a printer is already configured in the Windows Print Manager as a default 

printer, it is shown in the dialog box,
l if several printers have been declared in the Windows Print Manager, select 

the required printer from the list.

2 Configure the printer by clicking on Configuration.

Step Action

1 Select the element to be displayed from the documentation file.

2 Select the Viewcontextual menu (right click).

Step Action

1 Click on the program icon in the documentation window.

2 Select Print from the contextual menu or click on the printer icon in the task 
bar.

Step Action

1 Click on icon of the element to be printed in the documentation window.

2 Select Print from the contextual menu or click on the printer icon in the task 
bar.

Note: It is possible to interrupt printing by clicking on Cancel.
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Import/Export
Introduction

Subject of this
chapter

This chapter describes : 
l The application’s source files.
l The export/import of the application’s source files. 

What’s in this 
Chapter?

This Chapter contains the following Maps:

Topic Page

General points on import/export 343

Import/Export source files 344

Exporting a Section , a Subroutine, an Event 351

Importing a Grafcet/Ladder/List/Structured text section 353

Exporting an LD, IL, ST, Grafcet source file 354

Importing an LD, IL, ST, Grafcet source file. 355

Exporting variables 357

Importing variables 358

Importing/Exporting variables in EXCEL format 360

Exporting a functional module 362

Importing a functional module 364

Importing a functional module using the wizard 366

 Exporting animation table(s) 369

Importing animation table(s) 371

Export of runtime screens 373

Import of runtime screens 375

Export of a DFB type 376

Importing a DFB type 378

Exporting an application 380
341



 Import/Export
Importing an application 382

Exporting an application in FNES format (Input/Output Neutral File) 384

Importing an application in FNES format 385

Topic Page
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General points on import/export

Introduction Import/Export functions for the PLC TSX 37 or TSX 57 applications allow you:
l to insert or to duplicate all or part of IL, LD, ST, Grafcet program module.
l to insert an IL, LD or ST section into a task (MAST, FAST, EVT...).
l to insert a DFB type into the list of DFBs.
l to insert symbolized variables in the table of variables.

File types The following file types can be imported or exported:
l  LD source denoted by *.LD.
l  IL source denoted by *.IL.
l  ST source denoted by *.ST.
l  Grafcet source denoted by *.GR7.
l  Symbols source denoted by *.SCY.
l  DFB type source denoted by *.DFB.
l  DFB type binary denoted by:  *.UFB.
l  Application source denoted by *.FEF.

Notes:
File source code is 8 bit ASCII conforming to ISO standard 8859-1.

The input of code is possible directly using WINDOWS compatible editors, such 
as Word in text format (*.TXT).

The code of a DFB type binary is not accessible (encrypted).

Possible 
commands

File/Export supports the export of:
l All or part of a LD, IL, ST or Grafcet program module.
l All or part of the symbols table.
l A DFB type.

File/Import supports the import of:
l An LD, IL, ST, G7 file.
l A DFB type.
l A symbol source.
Notes:
In order to select the directory containing the applicationsource files, use the com-
mand Options/Customize. (The file PL7.INI contains the pathname for the source 
files). The source directory becomes the current directory for import/export.
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Import/Export source files

General points A source file is composed of a minimum of three blocks of information structured in 
lines of a maximum 1024 characters, terminating in one or two end of entry charac-
ters.

A block is identified by its name between [  ].

The end of the source file is identified by the "[EOF]" (End Of File) character string.

Description of 
the blocks

A file is made up of the following blocks:
l A [HEADER] block, containing general information (Date, Manufacturer’s Name).
l The [APPLICATION] block identifies:

l The name of the source application.
l Date of creation.
l Version.
l Comments.

l The [VENDOR] block describes the configuration (number of timers, counters, in-
ternal bits, etc.).

l The [SOURCE UNIT] block for the program modules contains:
l LD code for *.LD files.
l IL code for *.IL files.
l ST code for *.ST files.
l GR7 code for *.GR7 files.
l Properties, parameters and code for DFB files (*.DFB).

l The [DATA UNIT] block for the symbols files contains:
l application variables (file denoted by "*.SCY").
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LD source file Header Block

Application Block

Source Unit Block

[HEADER]
DATE = date #1999-12-10
STANDARD = ’PLCopen  v0.1 1993’
SENDER = ’Schneider Automation S.A. PL7 PRO V3.4’

[APPLICATION]
NAME = ’MACHINE_DOSAGE’
DATE = date_and_time#1999-12-10-14:52:06
VERSION = ’0.125’

[SOURCE_UNIT]
SU_TYPE = PROG
NAME = ’MAST_MAIN’
LANGUAGE = LD
BODY =
ADDRESS = MAST MAIN
PROGRAM
RUNG (*Mixing timer*)
P_CONTACT(%M17),BLOCK(%TM0),H_LINK(7),COIL(%M15);
EMPTY_LINE;EMPTY_LINE;
END_RUNG
RUNG
(*Management of mixer emptying*)
OPEN_CONTACT(%X1.0),H_LINK,P_CONTACT(%M200),
OPEN_CONTACT(%M16),H_LINK(3),OPERATE DEC %MD12 END_BLOCK;
END_RUNG
END_PROGRAM
[EOF]
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IL source file Header Block

Application Block

Source Unit Block

[HEADER]
DATE = date #1999-10-10
STANDARD = ’PLCopen  v0.1 1993’
SENDER = ’Schneider Automation S.A. PL7 PRO V3.4’

[APPLICATION]
NAME = ’MOP5’
DATE = date_and_time#1999-10-10-14:52:06
VERSION = ’0.125’

[SOURCE_UNIT]
SU_TYPE = PROG
NAME = ’MAST_SR1’
LANGUAGE = IL
BODY =
ADDRESS = MAST SR1
 PROGRAM(*PHRASE*)(*  *)    LDN  %M0    ST    %M1
LD    %M2    ST    %M3
(*END_PHRASE*)
END_PROGRAM
[EOF]
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ST source file Header Block

Application Block

Source Unit Block

[HEADER]
DATE = date #1999-08-10
STANDARD = ’PLCopen  v0.1 1993’
SENDER = ’Schneider Automation S.A. PL7 PRO V3.4’

[APPLICATION]
NAME = ’MOP6’
DATE = date_and_time#1999-08-10-14:52:06
VERSION = ’0.125’

[SOURCE_UNIT]
SU_TYPE = PROG
NAME = ’FAST_MAIN’
LANGUAGE = ST
BODY =
ADDRESS = FAST MAIN
PROGRAM(*PHRASE*)(*INIT*)%L1:   
   IF %MW0=%MWW1
           THEN %SR1;
  END_IF;
(*END_PHRASE*)
END_PROGRAM
[EOF]
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G7 source file Header Block

Application Block

Source Unit Block

[HEADER]
DATE = date #1999-06-10
STANDARD = ’PLCopen  v0.1 1993’
SENDER = ’Schneider Automation S.A. PL7 PRO V3.4’

[APPLICATION]
NAME = ’MOP7’
DATE = date_and_time#1999-06-10-14:52:06
VERSION = ’0.125’

[SOURCE_UNIT]
SU_TYPE = PROG
NAME = ’Sequential’
LANGUAGE = OTHERS
BODY =
ADDRESS = MAST Chart
PROG_LANGAGE = GR7VAR_GLOBAL
END_VAR
PROGRAMMAST’Chart’
NB_PAGES = 8
PAGE 0
INITIAL_STEP 0 AT (C 4,L 3) : 
ACTION (N1,LD) :
RUNG EMPTY_LINE;OPEN_CONTACT(%M8),H_LINK(9),
COIL(%M10);
END_RUNG
END_ACTION
END_STEP
TRANSITION (*TOP*) (LD) AT (C 4,L 4) : 
RUNG OPEN_CONTACT(%M1),H_LINK(9),
HASH_COIL;
END_RUNG
END_TRANSITION
T_S_OR_LINK FROM (C 4,L 4) TO (C 4,L 3) := [H_LINK FROM (C 4,L 4)
TO (C 5,L 4), V_LINK FROM (C 5,L 4) TO (C 5,L 2),
 H_LINK FROM (C 5,L 2) TO (C 4,L 2)]END_PAGEPAGE 1
END_PAGE
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Source Unit Block (next)

PAGE 2
END_PAGE
PAGE 3
END_PAGE
PAGE 4
END_PAGE
PAGE 5
END_PAGE
PAGE 6
END_PAGE
PAGE 7
END_PAGE
END_PROGRAM
[EOF]
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Symbols source 
file

Header Block

Application Block

Data Unit Block

[HEADER]
DATE = date #1999-12-10
STANDARD = ’PLCopen  v0.1 1993’
SENDER = ’Schneider Automation S.A. PL7 PRO V3.4’

[APPLICATION]
NAME = ’MOTOR’
DATE = date_and_time#1998-12-02-14:52:06
VERSION = ’0.125’

[DATA_UNIT]
DA_TYPE =
LOCATION =
NAME =
BODY =
VAR_GLOBAL
Surv_niv_malax : Alrm_dia (*Maximum mixer level reached: 25 liters*);
Gest_prod_silo_a : Cpt_remplissage;Gest_prod_silo_c : 
Cpt_remplissage;Gest_prod_silo_b : Cpt_remplissage;
Gest_prod_melangeur : Cpt_remplissage;Surv_malax : 
Ev_dia (*Mixing time too short (<5secs)*);
Vidange_cuve : Simul_vidange;Dcy AT %M0 : EBOOL 
(*Start cycle*);Evt_1 AT %M1 : EBOOL 
(*Silo A valve (=0 closed  =1 open)*); Evt_2 AT %M2 : EBOOL 
(*Silo B valve (=0 closed  =1 open)*); Evt_3 AT %M3 : EBOOL 
(*Silo C valve (=0 closed  =1 open)*); Evt_4 AT %M4 : EBOOL 
(*Hopper B1 valve (=0 closed  =1 open)*); Evt_5 AT %M5 : EBOOL 
(*Hopper B2 valve (=0 closed  =1 open)*); Evt_6 AT %M6 : EBOOL 
(*Mixer valve (=0 closed =1 open)*);
END_VAR
[EOF]
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Exporting a Section , a Subroutine, an Event

Introduction The Export function can be accessed in local mode and in connected mode, with 
the PLC in Stop mode.

It supports export of:
l all or part of a program module from within a language editor (LD, IL, ST, Grafcet),
l a whole section, a program module from within the application browser.

Exporting from 
within an editor

Carry out the following actions:

Exporting from 
within the 
application 
browser

Carry out the following actions:

Step Action

1 Open the section (LD, IL, ST orGrafcet).

2 Select the part of the program to be exported (if nothing is selected, the whole 
module is exported).
For Grafcet, select either:
l the whole module (default),
l the current page (the one where the cursor is),
l from page x to page y inclusive, between values 0 and 7.

3 Select the command File/Export.

4 Select the disk and/or the directory where the file is to be saved using the pull-
down menu In.

5 Enter a file name in the field Name.

6 Confirm with Save.

Step Action

1 Left mouse click on the Section or the Module to be exported or move the cur-
sor using the arrow keys.

2 Using the contextual menu or the File menu or the keys Shift+F10 select the 
command Export  

3 Select the disk and/or the directory where the file is to be saved.

4 Enter a file name in the field Name.

5 Confirm with Save.
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Notes During export, the message "Processing (Esc to cancel):1" is displayed in the sta-
tus bar.

Pressing Esc followed by confirmation stops the export and the source file is not cre-
ated.

Errors The only error that can arise is insufficient disk space available. If this happens, an 
error message is displayed.

The generation of the source file in progress is aborted.
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Importing a Grafcet/Ladder/List/Structured text section

Importing a 
Grafcet section

See: Creating or importing a Grafcet section, p. 107.

Importing a Lad-
der/List/Struc-
tured text section

See: Creating or importing an LD, IL, ST section, p. 105.
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Exporting an LD, IL, ST, Grafcet source file

Introduction The Export function can be accessed off-line or on-line, PLC at Stop).

It is used to export:
l all or part of a program module from a language editor (LD, IL, ST, Grafcet),
l a complete section or program module from the application browser.

Exporting from 
an editor

Carry out the following:

Exporting from 
an application 
browser

Carry out the following:

Errors The only error that can occur with an Export is lack of available disk space; in this 
case an error message is displayed.

Step Action

1 Open the (SR, EVT, PRL, POST) section or module.

2 Select the part of the program to be exported (if nothing is selected, all the 
module is exported).
With Grafcet:
Select either:
l the whole module (by default),
l the current page (the one the cursor is on),
l from page x to page y with x, y between 0 and 7.

3 Select the command File/Export.

4 Select the disk and/or directory where the file is to be saved using the scrollable 
menu In.

5 Enter a filename in the field Name.

6 Confirm with Save.

Step Action

1 Right click on the section or module to be exported or select with the arrow 
keys and then press (Shift + F10).

2 Select the command Export.

3 Select the disk and/or directory where the file is to be saved.

4 Enter the filename in the field Name.

5 Confirm with Save.
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Importing an LD, IL, ST, Grafcet source file.

Introduction  The Import function can be accessed in local mode and in connected mode, with 
the PLC in Stop mode.

It supports import of:
l A source file into a section (empty or already programmed) from a language ed-

itor,
l A section or a module from the application browser. 

Importing from 
within an editor

Carry out the following actions:

Importing from 
within the 
application 
browser

l Importing a Section (See Creating or importing an LD, IL, ST section, p. 105),
l Importing an SR (See Creating or importing a subroutine (SR), p. 109),
l Importing an event (See Creating or importing an event, p. 110),
l Importing a Grafcet source:

l This applies to all or part of the chart (CHART module, Step-Macro).
l It can be carried out from any page referenced by the position of the cursor. 

The imported pages replace the current pages. 
l If Grafcet objects (step activity bits, step time bits) are referenced in the appli-

cation, a message informs the user.
l At the end of the import, the cursor is positioned on the last defined return key 

symbol or on the page which follows the last imported page.

Step Action

1 Open the section, or the module (SR, EVT, PRL, POST).

2 Put the cursor in the editor in the position where you want to insert the code.

3 From the File menu select the command Import.

4 Select the source file relating to the section to be imported.

5 Carry out any necessary corrections (label %Li, Step number…).

6 Confirm the import with Enter or select the command Edit/Accept (CTRL+W) 

or click on the icon  
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l Special cases:
-If eight pages are read, the cursor remains on page seven.
-If the user aborts the import part way through, the cursor is positioned on the 
first page of the import.
-If the contents of a page are incorrect, the editor displays the page in error 
with the correction functions for the page and the look-up functions for the pag-
es already imported.
-The contents of a Macro-Step cannot be imported into the CHART and vice 
versa. 

Notes During import, the message "Processing (Esc to cancel):1" is displayed in the sta-
tus bar.

Pressing Esc followed by confirmation deletes the code already inserted. 

Errors Two types of error are possible:
l Non blocking errors, in this case:

l The corresponding editor is launched on the phrase, the contacts network or 
the chart containing the anomaly.

l The user can correct or abort the import. If the correction is carried out the im-
port continues.

l Blocking error (source file modified in the editor), in this case:
l The user can only abort the import, the import is interrupted.
l The user must remedy the cause and restart the import procedure.

Note:
If an object is not configured, accessing configuration to remedy the problem is pos-
sible, after validation the import can continue.
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Exporting variables

Functionality The Export variables function can be accessed in local mode and in connected 
mode, with the PLC in Stop mode.

Procedure Carry out the following actions:

Notes:
During the processing period the message "Processing object (Escape to can-
cel):xx" (number of the element being processed) is displayed in the status bar.

Pressing Esc followed by confirmation stops the processing and no source file is 
created.

Errors The only error that can arise is insufficient disk space available. If this happens, an 
error message is displayed.

The generation of the source file in progress is aborted.

Step Action

1 Open the variables editor from the application browser by double clicking with 
the left mouse button on one of the data families or by using the keys Shift+F10 
or via the contextual menu command Open. 

2 From the File menu select the command Export.

3 Select the disk and/or the directory where the file is to be saved using the pull-
down menu In.

4 Enter a file name in the field Name.

5 Select the export mode.
l All types: all the database entries are exported,
l Current type: only the data relating to the current display type is processed.

6 Confirm withSave.
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Importing variables

Introduction  The Import variables function can be accessed in local mode and in connected 
mode, with the PLC in Stop mode.

It supports insertion of a data file into the application (%M, %S, %K, %X, E/S, SFB, 
EFB, DFB) from the variables editor.

Managing 
conflicts

There are three kinds of conflicts:
l Address conflict:

l The symbol to be read already exists in the symbols database, but it repre-
sents a different address

l Symbol conflict:
l The address to be read is already represented in the symbols database, but 

by a different symbol.
l Comments conflict:

l The address to be read is already represented in the symbols database with 
the same symbol, but the 2 comments which are associated with them are dif-
ferent.

Three modes of operation allow you to manage these situations:
l Overwrite mode:

l Priority is given to the contents of the source file.
l Do not overwrite mode:

l Priority is given to the contents of the symbols database.
l Dialog mode:

l The user chooses the priority in relation to the conflict displayed.

Procedure Carry out the following actions:

Notes:

Step Action

1 Open the variables editor from the application browser by double clicking with 
the left mouse button on one of the data families, or via the Contextual menu 
select the command Open.

2 Select the command File/Import.

3 Select the file .SCY to be imported.

4 Select the operation mode:
l Overwrite,
l Do not overwrite,
l Dialog.

5 Accept with Open.
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During the processing period the message "Processing object (Escape to can-
cel):xx" with xx the number of the element being processed is displayed in the sta-
tus bar.

Pressing Esc causes the abort after restoring the current variable, the variables al-
ready restored are kept.

Errors On detecting collisions in the database the user can either:
l Keep the contents of the database.
l Overwrite the variable with that from the file being restored.
l Abort the import.
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Importing/Exporting variables in EXCEL format

Introduction  This function concerns the unitary import/export of variables.
It is possible to import/export application variables using a format which is compati-
ble withEXCEL.
This makes it easier to work with and create source files, using  EXCEL.

General points TXT is the chosen format, using tabs as separators. Provision is made for this save 
format in the EXCEL tool.
However, when reading these files in EXCEL, it must be indicated to EXCEL that the 
tabulation character is to be interpreted as a separator (standard principles of file im-
port into  EXCEL).

How to export 
variables in 
EXCEL format

Carry out the following steps:

Step Action

1 In the Structure View of the Application Browser double click on the Vari-
ablesdirectory.

2 Right click (contextual menu) on one of the variable items.

3 Click on open.
Result: a variables window appears.

4 Select File → Export.
Result: the following window appears. 

5 Choose the export destination directory and in the Type field select: "Text 
(separator: tabulations *TXT)".

6 Name the file and click on Save.

Export

Save

Cancel

Pl7user

FIRST screen

?

 Export mode

In:

Name:

Type:

All types

Text (separator: tabulations *TXT)
Source Symbols (*.SCY)
Text (separator: tabulation *TXT)
All (*.*)
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How to import 
variables in 
EXCEL format

Carry out the following steps:

Step Action

1 In the Structure View of the Application Browser double click on the Vari-
ablesdirectory.

2 Right click (contextual menu) on one of the variable items.

3 Click on open.
Result: a variables window appears.

4 Select File → Import.
Result: the following window appears. 

5 Choose the directory from which the import should be carried out and in the 
Type field select: "Text (separator: tabulations *TXT)".

6 Select the file and click on Save.

Import

Open

Cancel

Pl7user

?

 Import mode

Find:

Name:

Type:

Overwrite

Text (separator: tabulation *TXT)
Source Symbols (*.SCY)
Text (separator: tabulation *TXT)
All (*.*)

test. TXT

test. TXT

Dialog
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Exporting a functional module

At a Glance Exporting a functional module involves:
l exporting the sections, events and Grafcet modules which make up the functional 

module,
l and exporting the functional sub-modules which make up the functional module.

The short name and the function name are exported and then restored at the time 
of import.

The Export functional module function can be accessed in offline and online mode, 
with the PLC in Stop mode.

Procedure Carry out the following actions:

Notes:

Exporting a functional module is prohibited if an associated section, event or Grafcet 
module is being modified.

WARNING

When the functional module has one or more DFB instances:

The receiver application must contain the DFB type(s) corresponding to 
the functional module instances, in order to be able to subsequently im-
port the functional module.

Failure to observe this precaution can result in severe injury or 
equipment damage.

Step Action

1 Left click on the module to be exported or position the cursor over it using the 
arrow keys.

2 Using the contextual menu or the File menu or using the keys Shift+F10 select 
the commandExport.

3 Select the disk and/or directory where the file is to be saved (PL7user is the 
default directory).

4 Enter a file name in the Name field (the source file is of the type *.FM)

5 Confirm with Save.
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Exporting a 
functional 
module with 
runtime 
screen(s)

Exporting a functional module creates a directory NameDir.FM, containing:
l a source file NomMod.FM,
l an ECREXP directory where the tree structure dedicated to the runtime screens 

is located.

The export procedure is identical to that described above.

Exporting a 
functional 
module with 
animation 
table(s)

The source file NomMod.FM contains the source of each animation table contained 
in the functional module.

Exporting the functional module is authorized if no animation table is being modified.

The Export procedure is identical to that described above.
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Importing a functional module

At a Glance  Importing a functional module is the same as creating a module by: 
l importing the sections, events and Grafcet modules making up the module,
l and importing the functional submodules making up the functional module.

The short name and the function name are exported and then restored at the time 
of import.

If a section, event, Grafcet module, or functional sub-module making up the import-
ed functional module already exists with the same name, the software allows you to 
enter a new name.

The Import function can be accessed in offline and online mode, with the PLC in 
Stop mode.

Two import procedures are available:
l import without reassignment,
l import with reassignment, which allows you to make changes before starting the 

import.

Procedure for 
importing 
without 
reassignment

Carry out the following actions:

WARNING

When the functional module has one or more DFB instances:

The receiver application must contain the DFB type(s) corresponding to 
the functional module instances, in order to be able to import the func-
tional module.

Failure to observe this precaution can result in severe injury or 
equipment damage.

Step Action

1 Left click on the destination directory (station or functional module directory) or 
position the cursor over it using the arrow keys.

2 Using the Contextual menu, the File menu or the Shift+F10 keys select the 
Import command.

3 Select the source file (*.FM) to be imported.

4 Confirm with Open
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Note:
As only one Grafcet section is allowed in the MAST task, importing a module con-
taining a Grafcet section is prohibited if a Grafcet section already exists.

Procedure for 
importing with 
reassignment

Carry out the following actions:

Note:
For more information on the wizard, see "Importing a functional module using the 
wizard" (See Importing a functional module using the wizard, p. 366).

Importing a 
functional 
module with 
animation 
table(s)

The contents of the file NAME.FM containing the source of each animation table in 
addition to the information linked to the functional module is imported.

The possible conflicts are dealt with in the section Importing animation table(s), p. 
371.

If the procedure with reassignment is selected then:
l it is impossible to reassign a variable which is only present in an animation table,
l reassigned variables are also reassigned for the animation tables which contain 

them.

Importing a 
functional 
module with 
runtime 
screen(s)

If the procedure with reassignment is selected then:
l it is impossible to reassign a variable which is only present in a runtime screen,
l reassigned variables are also reassigned for the runtime screens which contain 

them.

Step Action

1 Left click on the destination directory (station or functional module directory) or 
position the cursor over it using the arrow keys.

2 Using the Contextual menu, the File menu or the Shift+F10 keys select the 
Import command.

3 Select the source file (*.FM) to be imported.

4 Check the box Open with  wizard.

5 Confirm with Open.
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Importing a functional module using the wizard

Introduction When importing with reassignment, if you want assistance check the box Open 
with wizard. This tool guides you through the reassignments.

Detailed below are the different Tabs in the tool.

Directory Tree 
Tab

Supports the modification of the different elements. The source name is quoted as 
a prefix to the new name: Source Name => Target Name.

The entry is enabled by a double left click on the object, confirmed by the Enter 
key, cancelled by the Esc key.

The different elements are:
l Functional Module:

l The name is made up of a maximum of eight alphanumeric characters (‘A’..’Z’ 
and ‘0’..’9’) and underscore (‘_’), the first character obligatorily being a letter.

l The name must be unique.
l The long name associated with a functional module can be displayed and 

modified in the Long name field.
l Section, Task:

l The name is made up of a maximum of sixteen alphanumeric characters 
(‘A’..’Z’ and ‘0’..’9’) and underscore (‘_’), the first character obligatorily being a 
letter.

l The name of a section must be unique.
l The task associated with a section (not including the Grafcet section) can be 

displayed and modified with the help of the associated pull-down menu 
(MAST, FAST).

l Grafcet and Macro-Steps:
l When the Grafcet section is imported in its entirety, it appears in the graphical 

representation of the functional module, and can thus be modified.
l When Grafcet modules are imported independently of their Grafcet section, 

the user can display and modify the name of the Grafcet section in the field 
"Grafcet Section". This field is visible as soon as a Grafcet module is highlight-
ed in the tree directory.

l The name of the Grafcet entities PRL, POST and CHART cannot be modified.
l For the macro-steps Macro<i>, the new name entered must not be more than 

a maximum of 7 characters, only their number can be modified and this num-
ber must be between 0 and 63.

l The new macro-step Macro<i> must be unique, that is no other macro-step 
must have the same number, or correspond to a macro-step Target call.
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l Events:
l The name is made up of a maximum of five characters. Only the modification 

of their number (0..63) is allowed.
l The new event Evt<i> must be unique.

Addresses Tab Presents the symbols and addresses of the functional module and supports modifi-
cation of the name of the different elements.

The entry is enabled by a double left click on the object, confirmed by the Enter 
key, cancelled by the Esc key.

The family field supports the selection of the different imported objects:
l Standard objects are taken into account.
l Derived objects are not taken into account:

l Indexed object.
l Extract bits from indexed object.
l Indexed extract bit.
l Table.
l Indexed table.

DFB Tab Presents the DFB instances which are declared in the functional module.

The entry is enabled by a double left click on the object, confirmed by the Enter 
key, cancelled by the Esc key.
The different elements are:
l Comment:

l The comment associated with a DFB instance in the table can be displayed 
and modified in the Comments field. 

l The comment is written on a single scrollable line. It can contain a maximum 
of 508 characters.

l Type, Source Name, Target Name:
l Type: indicates the type of a DFB.
l Source Name: indicates the source name of the instance.
l Target Name: supports the modification of the target name of every instance.

1. The name is made up of a maximum of thirty-two alphanumeric characters 
(‘A’..’Z’ and ‘0’..’9’) and underscore (‘_’), the first character obligatorily being a 
letter.
2. The Target name of the new instance must be unique, that is, no Target 
symbol nor other instance of Target DFB, nor any DFB type can have the 
same name.

l Ordering DFBs:
l In alphabetical order by the DFB type.
l In alphabetical order by the Source name of the instances.
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External Calls 
Tab

Presents the calls to the SRs from the functional module, and the calls to the Macro-
steps not imported with the functional module (see directory tree).
The entry is enabled by a double left click on the object, confirmed by the Enter 
key, cancelled by the Esc key.

The different calls are:
l Source Call:

l Presents the source SRs and Macro steps.
l Target Call:

l Supports the modification of the target SRs and Macro steps.
l Only the modification of the SR<i> number is allowed.  This number must be 

between 0 and 254.  The new Target call SR<i> must be unique.
l Only the modification of the M<i> number is allowed.  This number must be 

between 0 and 63.  The new Target call must be unique.
l Ordering SRs and Macro-Steps

l First the calls to SRs then the calls to Macros-steps.
l In alphabetical order by the number of the Source call.

Correspondence 
File Zone

This file in text format contains all the information concerning the reassignments car-
ried out in the different tabs described above.

This information is that defined in the tabs:
l Directory Tree.
l Addresses.
l DFB.
l External Calls.

The commands available in the "Correspondence Files" zone are:
l Save:

l Allows you to store in a file the reassignments carried out up to that time.
l Retrieve:

l Allows you to automatically execute the reassignments previously stored in a 
file.

WARNING

The correspondence information is specific to the functional module an-
alyzed.  It is strongly recommended that you save your work to disk be-
fore exiting the "IMF" function, as once it is closed, all the work carried 
out on the functional module is lost.

Failure to observe this precaution can result in severe injury or 
equipment damage.
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 Exporting animation table(s)

Introduction The Export function can be accessed in local mode and in connected mode, with the 
PLC in Run or Stop mode.

It supports export of:
l a single animation table via:

l the application browser,
l the animation table editor.

l a set of animation tables via:
l the application browser,

Rules Exporting an animation table via the animation table editor or via the application 
browser is only possible if the table is not being modified.

Exporting a set of animation tables via the application browser is only possible if no 
animation table editor is open in modification mode.

The export can be interrupted at any moment by pressing the Escape key.  After 
confirming this, the export is stopped and no source file (*.TAB) is created.

Exporting via the 
animation table 
editor

 Carry out the following steps:

Step: Action:

1 Select the File/Export command, then the Export window is displayed on the 
screen.

2 Via the Export window choose:
l in the In zone the path where the source file containing the animation table 

(by default \PL7USER) is stored,
l in the Name zone the name of the source file (Nom.TAB).

3 Confirm withSave.
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Exporting a set 
of animation 
tables via the 
application 
browser

 Carry out the following steps:

Exporting one 
animation table 
via the 
application 
browser

 Carry out the following steps:

Errors The only error that can arise when processing an Export is insufficient disk space 
available. If this happens, an error message is displayed.

Step: Action:

1 Select the Animation tables directory.

2 Select the File/Export command, or from the contextual menu the Export 
command, then the Export window is displayed on the screen.

3 Via the Export window choose:
l in the In zone the path where the source file containing the animation tables 

(by default \PL7USER) is stored,
l in the Name zone the name of the source file (Nom.TAB).

4 Confirm withSave.

Step: Action:

1 Double click on the Animation tables directory.

2 Select the animation table to be exported.

3 Select the File/Export command, or from the contextual menu the Export 
command, then the Export window is displayed on the screen.

4 Via the Export window choose:
l in the In zone the path where the source file containing the animation table 

(by default \PL7USER) is stored,
l in the Name zone the name of the source file (Nom.TAB).

5 Confirm with Save.
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Importing animation table(s)

At a Glance The Import function can be accessed in offline mode and in online mode, with the 
PLC in Run or Stop mode.

It is used to import the following via the application browser:
l a single animation table,
l a set of animation tables.

Rules When importing, if there is an identity problem between the name of the imported 
table and a table already existing in the application, a dialog box appears offering 
the option of renaming the table being imported.

When importing, only the addresses are imported but not the symbols. Therefore, 
the imported animation table is slaved the application’s existing symbols database.

The import can be aborted at any moment by pressing the Escape button and after 
confirming this, the import is stopped and the animation table being imported is not 
imported.
For a source file containing several animation tables, the imported tables are not de-
leted.

Importing a table 
or a set of 
animation tables 
via the 
application 
browser

 Carry out the following actions:

Step: Action:

1 Select the Animation tables directory.

2 Select the File/Import command, or from the contextual menu the select the 
Import command. The Import window is displayed on the screen.

3 From theImport window choose:
l in the Search zone the path of the location from which the source file con-

taining the animation table(s) (by default \PL7USER) is to be read,
l in the Name zone the name of the source file (NAME.TAB).

4 Confirm with Open.
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Errors When importing, if the animation table contains a variable that is not configured in 
the application, a dialog box indicating the problem is displayed, giving the option:
l of either ignoring the variable and continuing the import,
l or of interrupting the import so that the table being imported is not imported, but 

the tables already imported are not deleted.

If, when importing, the source file contains:
l a reference to a DFB type that does not exist in the application, then a dialog box 

is displayed indicating the conflict, giving the option:
l of either ignoring the variable and continuing the import,
l or of interrupting the import so that the table being imported is not imported, 

but the tables already imported are not deleted.
l a reference that does not exist in the application, but whose DFB type does exist, 

then a dialog box is displayed indicating the conflict, and giving the option:
l of either ignoring the variable and continuing the import,
l or of interrupting the import so that the table being imported is not imported, 

but the tables already imported are not deleted.
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Export of runtime screens

Introduction PL7 is used to export runtime screens or families of runtime screens.

The Export function can be accessed in offline mode and in online mode, with the 
PLC in Run or Stop mode.

How to export a 
runtime screen 
(or a family)

 Carry out the following steps:

Step Action

1 In the Application Browser in the structure view double click on the Runtime 
screens directory.
Result:

2 Right click on one of the runtime screen items or on a family directory (example 
here: Home, Information system…).

Ecrans d’exploitation

Ecrans Messages Objets

7 - Bit systèmes
6 - Grafcet

3 - Lisez_moi

COMPORTEMENT DFB

0 - Dosage_Melange_Produits
2 - Ecran_ controle

4 - Ecran_comportement_DFB
5 - Informations_sur_mise_au_point_DFB

8 - Surveillance_malaxeur
DIAGNOSTIC_APPLICATION

DOSAGE_PRODUITS

INFORMATIONS SYSTEME

ACCUEIL
Ecran

1 - Ecran_accueil
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How to export a 
runtime screen 
(or a family)

 Carry out the following steps (next):

Step Action

3 Select the Export command.
Result:

4 Choose the directory from which you wish to import the screen or the family of 
screens.

5 Select the screen and click on Export.

Exporter des écrans

Exporter Annuler

Parcourir...

 Sélection des écrans

 Exporter vers

c:\PL7USER

7 - Bit systèmes
INFORMATIONS SYSTEME

ACCUEIL
Ecran

Ecran_accueil
Copie de Ecran_accueil

Lisez_moi
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Import of runtime screens

Introduction PL7 can be used to import runtime screens or runtime screen families into your ap-
plications.

The Import function can be accessed in offline mode and in online mode, with the 
PLC in Run or Stop mode.

How to import a 
runtime screen 
(or a family)

 Carry out the following steps:

Step Action

1 In the Application Browser in the structure view double click on the Runtime 
screens directory.
Result:

2 Right click on one of the runtime screen items or on a family directory (example 
here: Home, Information system…).

Ecrans d’exploitation

Ecrans Messages Objets

7 - Bit systèmes
6 - Grafcet

3 - Lisez_moi

COMPORTEMENT DFB

0 - Dosage_Melange_Produits
2 - Ecran_ controle

4 - Ecran_comportement_DFB
5 - Informations_sur_mise_au_point_DFB

8 - Surveillance_malaxeur
DIAGNOSTIC_APPLICATION

DOSAGE_PRODUITS

INFORMATIONS SYSTEME

ACCUEIL
Ecran

1 - Ecran_accueil
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How to import a 
runtime screen 
(or a family)

 Carry out the following steps (next) :

Export of a DFB type

At a Glance Export of a DFB type is global and includes:
l the properties of the DFB type,
l the descriptive form,
l the description of public interfaces (inputs, inputs/outputs, outputs) and public 

variables,
l the description of private variables,
l the code.

A DFB type can be exported from the application browser or the DFB type editor.

Two export formats are offered:
l standard (unprotected DFB types ),
l binary (protected (See How to protect a DFB, p. 269) or unprotected DFB types).

Exporting a 
standard format 
DFB type

The Export function can be accessed in local mode and in online mode, the PLC in 
Stop.

Step Action

3 Select the import command.
Result:

4 Choose the directory from which you wish to import the screen or the family of 
screens.

5 Select the screen(s) and click on import.

Importer des écrans

Importer Annuler

Parcourir...

 Sélection des écrans

 Importer depuis

c:\PL7USER

ACCUEIL
Ecran

Ecran_accueil
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Carry out the following actions:

Comments:
Export from the DFB type editor is authorized whether DFB type is enabled or not.

Only an enabled DFB type can be exported from the application browser.

Export of a 
binary format 
DFB type

The Export binary function can be accessed in local mode and in online mode, the 
PLC in Stop.

Carry out the following actions:

Comment:
Export is possible if the DFB type is enabled.

Step Action

1 l Export from the application browser:
1. Left mouse click on the DFB type or put the cursor over it using the arrow 
keys.
2. From the context menu or the File menu or using the keys Shift+F10, se-
lect the Export command.

l Exporting from the DFB type editor:
1. Left mouse click on the DFB type or put the cursor over it using the arrow 
keys.
2. Edit the DFB type right mouse click + Open key.
3. From the File menu, select the Export command.

2 Select the disk and/or directory where the file must be saved using the pull-
down menu In.

4 Enter a file name in the Name field.

5 Confirm using Save.

Step Action

1 Left mouse click on the DFB type or put the cursor over it using the arrow keys.

2 From the context menu or using the keys Shift+F10 select Export binary.

3 Select the disk and/or directory where the file must be saved using the pull-
down menu In.

4 Enter a file name in the Name field.

5 Confirm using Save.
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Importing a DFB type

Introduction The Import function is only accessible in local mode.

The DFB type is imported from within the application browser.

The import of a DFB type is global and includes:
l the properties of the DFB type,
l the descriptive form,
l the description of the public interfaces (inputs, inputs/outputs, outputs) and public 

variables,
l the description of the private variables,
l the code.

Importing a DFB 
type in binary 
format

Carry out the following actions:

Importing a DFB 
type in binary 
format

carry out the following actions:

Step Action

1 Left mouse click on the directory DFB Type or position the cursor over it using 
the arrow keys.

2 Using the Contextual menu or the File menu or the keys Shift+F10 select the 
command Import.

3 Select the source file *.DFB relating to the type to be imported.

4 Confirm with Import.

Step Action

1 Left mouse click on the directory DFB Type or position the cursor over it using 
the arrow keys.

2 Using the Contextual menu select the command Import binary.

3 Select the source file *.UFB relating to the type to be imported.

4 Confirm with Import.
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Specific cases It is possible that the DFB type to be imported is already present in the application.

Three cases are possible:
l The DFB type present in the application is protected:

l In this case the import is impossible.
l The DFB type present in the application is not protected and not instanced:

l A dialog box offers to replace, rename, cancel the import of the DFB type.
l The DFB type present in the application is not protected but instanced:

l If the interfaces are identical, a dialog box offers to replace, rename or cancel 
the import of the DFB type.

l If the interfaces are different, the import is impossible. It is then necessary to 
delete the instances first.
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Exporting an application

Introduction  The Export an application function can be accessed in local mode and in connected 
mode, with the PLC in Stop mode.

Exporting an 
application 
without DFB

Carry out the following actions:

Exporting an 
application with 
DFB

Exporting an application only takes into account the enabled DFB types.

Two cases are possible:
l Non protected DFB(s):

l All the contents of the DFB(s) are saved in the resulting export file *.FEF.
l Protected DFB(s) or DFB(s) exported from PL7-Junior:

l Only the names of the DFB type are saved in the resulting file *.FEF.
l The binary format of the DFB(s) (*.UFB) must also be exported (see Exporting 

a DFB type (See Export of a DFB type, p. 376)).

In the two cases, the Export procedure is identical to that described above.

Exporting an 
application with 
animation tables

Exporting the application includes all the animation tables contained in the directory 
Animation tables in the application browser.

The source file of the application (NomAppli.FEF) contains the source of the anima-
tion tables.

The Export procedure is identical to that described above.

Step Action

1 Open the application to be exported.

2 On the File menu select the command Export an application, or from the di-
rectory Station using the Contextual menu or using the keys Shift+F10 select 
Export an application.

3 Select the disk and/or the directory where the file is to be saved using the pull-
down menu In.

4 Enter a file name in the field Name.

5 Confirm withSave.
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Exporting an 
application with 
operating 
screens

The export of the application leads to the creation of a directory.

This directory NomRep.FEF contains:
l the source file NonAppli.FEF,
l a directory ECREXP in which the tree structure dedicated to the operating 

screens is located.

The Export procedure is identical to that described above.
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Importing an application

At a Glance  The Import application function can be accessed in offline and online mode, with the 
PLC in Stop mode.

The Import application function involves:
l redefining the inputs/outputs,
l finding and replacing modified objects,
l initializing the station with the new application obtained.

Importing an 
application 
without DFBs

Carry out the following actions:

Importing an 
application with 
DFBs

The function Import an application with DFB is only accessible in offline mode.

There are two possible scenarios:
l Non protected DFB(s):

l Their contents which are saved in the *.FEF are imported in the same way as 
the rest of the application.

l The Import procedure is the same as that described above.
l Protected DFB(s):

l When Importing, a dialog box asks for the pathname of the binary file(s) 
(*.UFB) in order to import them.

Carry out the following actions:

Step Action

1 Create an empty application.

2 Using the Contextual menu, the File menu or the keys Shift+F10 select the 
command Import an application.

3 Select the *.FEF file to be imported.

4 Confirm with Open.

5 If applicable correct any non configured objects.

6 Click on OK.

Step Action

1 Create an empty application.

2 Using the Contextual menu, the File menu or the keys Shift+F10 select the 
command Import an application.

3 Select the *.FEF file to be imported.

4 Confirm with Open.

5 If applicable correct any non configured objects.
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 Import/Export
Importing an ap-
plication with 
animation tables

The application import incorporates all the animation tables contained in the file 
NAME.FEF.

If any non configured variables are present in the application, a list appears allowing 
the user to modify the current configuration and continue with the import.

The Import procedure is identical to those described above.

Errors Three possible scenarios:
l Importing an application without DFBs:

l An error message is displayed.

l Importing an application with DFBs:
l An error can appear if:

-The source file has been modified with a text editor.
-The DFB type is not present on the station onto which the application is im-
ported.
-The DFB type is of a different application identification and is incompatible.

l An error message is displayed, and the station is reinitialized to the application 
by default.

l Importing an application with animation tables. 

6 Click on OK.

7 Using the Find drop-down menu, enter the name of  the disk and/or directory 
where the first type of DFB in the (*.UFB) list is located.

8 Confirm withImport.

Step Action
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Exporting an application in FNES format (Input/Output Neutral File)

Introduction  The FNES file (Input/Output Neutral File) generated by an export can only be used 
with a single PLC.

It contains the description of all the symbolized Inputs/Outputs, except for discrete 
Inputs/Outputs when all the Inputs/Outputs are described (symbolized or not).

This functionality is only accessible in local mode.

This functionality is not accessible (menu grayed out) if a modification is being car-
ried out in the editor and vice versa, during the execution of an Export, no other ac-
tion is possible in the editor.

Only the software PL7 Pro allows access to the Export/Import FNES functionality.

Procedure Carry out the following actions:

Notes:
The export can be interrupted by the user using the Escape key, in this case, no FNE 
file is exported.

The default directory offered is that on the Customize Options/Source directory 
menu, subsequently, the offered directory will always be the last entered (for the cur-
rent PL7 session).

Errors The errors that can arise when processing an Export are insufficient disk space 
available or a problem retrieving data. 

An error message is displayed and the process is interrupted. If this happens, no file 
is generated.

Step Action

1 From the Station directory on the Contextual menu or using the File menu or 
the keys Shift+F10, select  Export/Import FNES+Export FNE.

2 Select the destination directory and indicate the name of the file (*.FNE),

3 Click on Save.
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 Import/Export
Importing an application in FNES format

At a Glance Importing a FNES file (Input/Output Neutral File) allows you to increment the appli-
cation’s symbols database, but does not modify its configuration data in any way.

 Inserting symbols into an existing symbols database involves managing the follow-
ing conflicts:
l Address conflict: 

l The symbol to be read already exists in the symbols database, but represents 
a different address.

l Symbol conflict:
l The address to be read is already represented in the symbols database, but 

by a different symbol.

l Comment conflict:
l The address to be read is represented in the symbols database already, by the 

same symbol, but the 2 comments associated with them are different.

To deal with this, 3 import modes are offered:
l Overwrite mode (to overwrite symbol database):

l Priority is given to the contents of the FNES file.

l Do not overwrite mode (does not overwrite symbols database): 
l Priority is given to the contents of the symbols database.

l Dialog mode (default mode):
l The user chooses the priority depending on the conflict displayed.

This function can only be accessed in offline mode.

This function cannot be accessed (menu grayed out) if a modification is in progress 
in the editor and conversely, during Import execution, no other actions are possible 
in the editor.

Only PL7 Pro software provides access to the Import/Export FNES function.
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Procedure Carry out the following actions:

Notes:
The import can be aborted by pressing the Escape key.
The import is aborted after restoring the current object, but the objects that have al-
ready been imported remain.

The directory proposed by default is that specified in the Options/Customize/
Source directory menu. Subsequently, the proposed directory will always be the 
last entered (for the current PL7 session).

If several PLCs are present in the file, a message is displayed giving the user the 
possibility of consulting the list of PLCs or of canceling the import.
If the user chooses to continue the import, the list of associated applications and pro-
cessors is displayed.

Errors There are two possible scenarios:
l Blocking error:

l These errors interrupt the import. They can only occur if the FNE file was gen-
erated outside of PL7 Pro (e.g.: bad syntax in the FNE file).
You must abort the import, correct the error (fix the FNE file), then restart the 
desired Import.

l Non blocking error:
l Example: error caused by a collision or bad configuration.

You must replace the symbol or symbols already configured or cancel the im-
port.

Step Action

1 From the Station directory using the Contextual menu, the File menu or the 
Shift+F10 keys, select Import/Export FNES + Import FNE. 

2 Select the source directory and give the file name (*.FNE).

3  Select import mode:
l overwrite mode,
l do not overwrite mode,
l dialog mode.

4 Confirm with Open.
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Configuring the Uni-telway link
Introduction

Subject This chapter describes how to configure the Uni-telway driver. 

What’s in this 
Chapter?

This Chapter contains the following Maps:

Topic Page

General 388

Configuration of the terminal/PLC link 390

Advanced configuration 396
387



Configuring the Uni-telway link
General

At a Glance The Uni-telway tool is used to configure the operating parameters of the Uni-Telway 
driver depending on the PLC’s terminal port characteristics.

How to configure 
the UNITELWAY 
driver

 The following table describes the procedure for configuring the UNITELWAY driver.

Step Action

1 From the Start menu select the Program group.

2 Select the Modicon Telemecanique program group.

3 Select XWAY Driver Manager.

4 Click on the UNITELWAY tab.
Result: the following window appears: 

Management properties of XWAY drivers

OK

UNITELWAY Driver V7.7 IE17
Copyright © 1995-1999 Schneider Automation
Status:   In service

Configuration

XWAY Manager FPC10 Driver UNITELWAY Driver XWAY Test

FPWFPW
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Configuring the Uni-telway link
5 Click on the Configuration button.
Result: The dialog box below appears: 

6 Configure:
l the communication port,
l the transmission speed,
l the UNITELWAY address.

7 Click on Save.

Step Action

Configuration UNI -TELWAY - UNTLW01

Enregistrer

Ouvrir

Par défaut

Fichier Edition ?

300

Auto adaptation
(en secondes)

Modem

Maître

31

1

Base Nombre

9600

600 19200

1200 38400

2400 57600

4800 115200

COM1

COM2

COM3

COM4

 Vitesse (bauds) Port COM

Param...

 Adresse UNI-TELWAY
Operate modes manual 09/2000 389



Configuring the Uni-telway link
Configuration of the terminal/PLC link

At a Glance Various configuration parameters are available for the Uni-telway driver.
Main configuration screen. 

Description of 
the COM Port 
zone

This zone allows you to select the terminal serial port (COM1 to COM4), to be used 
for Uni-telway communication. The default value is COM1 (COM2 on TELEMECA-
NIQUE FTX or CCX terminals).
Use the other COMs according to the availability on your hardware. 

The Param. button makes the following dialog box appear: 

This allows you to force the hardware configuration of the selected serial port. By 
default, the configuration is determined automatically by the driver at start up.

UNI-TELWAY Configuration – UNTLW01

Save

Open

By default

File Edit ?

300

Auto adaptation
(in seconds)

Modem

Master

31

1

Base Number

9600

600 19200

1200 38400

2400 57600

4800 115200

COM1

COM2

COM3

COM4

 Baud rate COM Port

Param…

 UNI-TELWAY Address

Note: apart from with the generally marginal use of serial link cards or internal mo-
dems which do not comply with the normal values used for the serial port’s hard-
ware configuration, it is advisable to select Automatic configuration. When this 
box is ticked, you no longer have access to I/O address, Interrupt and RS 485 Port.

Cancel

OK

I/O Address

Automatic Configuration

Auto

Interrupt

RS485 Port

Auto
By default

UNI-TELWAY Configuration- Port
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Using the COM 2 port in RS 232 C
The FTX 417-40 terminal allows the use of the COM 2 port in serial link  RS 232C. 
This type of use necessitates the deselection of theAutomatic configuration and 
RS485 Port boxes.

Description of 
the speed zone 
and the address 
zone

Speed Zone (bauds):
This zone is used to select the standard speed of the serial link, from 300 to 115200 
bauds. If the actual link speed is different from the selected speed, the auto driver 
adapts its speed. The Auto adaptation field defines the auto adaptation mechanism 
time in seconds. The driver automatically changes its speed after n seconds if the 
connection is not established at the current speed. Auto adaptation is disabled for a 
value of 0. The values by default are 9600 bauds for the speed and 1 second for the 
auto adaptation.

Uni-telway address zone:
This zone is used to select the standard link address as well as the number of ad-
dresses to which the Uni-telway driver responds. The default values are 1 for the 
standard address and 3 for the number of addresses that respond to the following 
configuration: Ad0=1, Ad1=2, Ad2=3 (Ad0 corresponding to the server address, Ad1 
to the client application address and Ad2 to the listening application address).

Description of 
the Save button

Save button:
is used to save the Uni-telway driver configuration. 
The Save button appears in the following dialog box: 

UNI-TELWAY Configuration- Save

Cancel

OK

Dynamically reinitialize driver (in the memory)

Save configuration file (DUNTLW.00?)
Operate modes manual 09/2000 391



Configuring the Uni-telway link
Elements and their functions:

Description of 
the Open button

The Open button:
is used to read the Uni-telway driver configuration.
The Open button appears in the following dialog box: 

Elements and their functions:

Element Function

Saving a configura-
tion file 
(DUNTLW.00?

The configuration of the Uni-telway driver is saved in a configuration file 
on disk (usually DUNTLW.001 in the xwaydrv directory). This file is 
read by the driver when the computer boots up. The modifications will 
therefore be acknowledged the next time the computer is started.

Dynamically reini-
tialize the driver (in 
memory)

The configuration is directly described in the driver memory. Modifica-
tions are acknowledged immediately by the driver.
Dynamic reinitialization is impossible:
l if the driver is not loaded into the memory (at installation, for exam-

ple),
l if the modifications relate to parameters that cannot be dynamically 

modified (the COM port, for example),
l if the driver is being used (if the PL7 is connected, for example).

Element Function

Open a configuration file 
(DUNTLW.00?)

The configuration of the Uni-telway driver is read in a configura-
tion file on disk (usually DUNTLW.001). From this, you can view 
and modify the driver’s initial configuration (read upon start-up).

Read current driver con-
figuration (in memory)

The configuration is read directly in the driver memory. From this 
you can view and modify the driver’s real time configuration. This 
selection is deactivated if the driver is not loaded into the memory 
(at installation, for example).

UNI-TELWAY Configuration- Open

Cancel

OK

Read current driver configuration (from memory).

Open configuration file (DUNTLW.00?)
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Description of 
the Default 
button and the 
Modem button

The Default button:
is used to reset the values of the COM Port, Speed (bauds) and Uni-telway groups 
to their default values, to port COM1 (COM2 for FTX or CCX terminals), speed 9600 
bauds, auto adaptation 1 second, standard address 1 and number of addresses 3.
The Modem button:
is used to select the use of a MODEM and the associated parameters.
The Modem button makes the following dialog box appear:  

Elements and their functions:

Element Function

Connection by 
MODEM

Is used to select the management of the MODEM by the driver.

Telephone 
number

Is used to enter the telephone number of the remote MODEM to be called. 

HAYES Initial-
ization

Is used to define the HAYES command string emitted by the driver in order 
to initialize the MODEM each time it connects.

Note: Consult the documentation of your MODEM to ensure that it is initialized cor-
rectly. By default the MODEM connection is disabled.

UNI-TELWAY Configuration- MODEM

Cancel

OK

Telephone number

MODEM connection

By default
HAYES Initialization ATV1E0B0F0&M0X4&E0&D2D
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Description of 
the Master 
button

The Master button:
is used to activate the Uni-telway protocol in master mode on the PC.
The Master button makes the following dialog box appear: 

The Uni-telway master check box is used to select the protocol management in 
master mode on the PC.
The Base and Number fields respectively are used to input the first slave and the 
number of slaves on the PC which may or may not need to be scanned. The default 
values are base 1 and number 31.

With Polled Slaves the Base will inform the master of the slave address from which 
it will start to scan and the Number will be the number of slave addresses to scan.

With Reserved Slaves (not polled), these are the addresses that the PC reserves 
for applications using the Uni-telway driver which transmit to the slaves. The Base 
will therefore be the first address and the Number will depend on the application us-
ing the driver (with PL7, Number=3). These addresses must not be used by a slave.

The Time Out field gives the polling response time in milliseconds.

Note: it is not advisable to enter a value lower than the 100ms default value, be-
cause of the PC’s timing constraints (high CPU consumption for low timeouts). By 
default, master mode is disabled.

UNI-TELWAY Configuration - Master

OK

Cancel

By default

UNITELWAY master

Base 1

Base 1 3

Number 31

 Reserved slaves (not polled)

 Polled slaves

TimeOut (ms) 100

Number
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the following diagram shows a configuration example: 

In this case the configuration will be Uni-telway-Master:
Polled slaves
Base=1 and Number=10
Reserved slaves (not polled)
Base=11 and Number=3 (if the PL7 is using the Uni-telway driver).

Ad0=1
Ad1=2
Ad2=3

Ad0=4
Ad0=5

Ad0=6
Ad0=7
Ad0=8

Ad0=9
Ad0=10

Slave 1

Slave 2

Slave 3

Slave4
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Advanced configuration 

At a Glance An advanced configuration is also available for the Uni-telway driver.

How to access 
advanced 
configuration for 
the Uni-telway 
driver

 The following table describes how to access advanced configuration:

Step Action

1 From the configuration window click on File then select Advanced configura-
tion, as shown in the following window:

2 Click on advanced configuration.
Result: the following window appears:

Configuration UNI -TELWAY - UNTLW01

Enregistrer

Ouvrir

Par défaut

Fichier Edition ?

300

Auto adaptation
(en secondes)

Modem

Maître

31

1

Base Nombre

9600

600 19200

1200 38400

2400 57600

4800 115200

COM1

COM2

COM3

COM4

 Vitesse (bauds) Port COM

Param...

 Adresse UNI-TELWAY

Enregistrer Ctrl+E
Ouvrir Ctrl+O

Configuration Avancée Ctrl+A
Tous paramètres par Défaut Ctrl+D

Quitter

Configuration UNI-TELWAY - Avancée

Par défaut

OK

Annuler

 Types de cable

 Power Management

 Bits de données

Dévalider l’APM en connecté

COM shareTous types
TSXSCA72
TSXSCA72+
TFTXCBP02
RS232

7
 Buffers driver

SBUF

RBUF

IBUF
Page 

ABUF

3

0

16

Version 3
Version  5

Sans
Impaire
Paire

Link TimeOut

RXTX Delay

Ack TimeOut

-1

1000

Hold COM
Use VCD

Read 
Enable FIFO
NUM PLC

 Divers

8
 Bits de 

1 2

 Adressage

 Parité

-1
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CAUTION

Advanced parameters may only be modified by special instruction from 
the software using the Uni-telway driver or under the supervision of the 
technical support department of Schneider Automation SA.

Failure to observe this precaution can result in injury or equip-
ment damage.
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Configuring the FIPWAY link
Presentation

Subject of this 
chapter

This chapter describes configuration operations for the FIPWAY driver.

What’s in this 
Chapter?

This Chapter contains the following Maps:

Topic Page

General 400

Configuring the terminal/FIPWAY link 402

Advanced Configuration 406
399



Configuring the FIPWAY link
General

At a Glance The FIPWAY tool is used to configure the operating parameters of the terminal’s 
FIPWAY driver.

How to configure 
the FIPWAY 
driver

 The following table describes the procedure for configuring the FIPWAY driver.

Step Action

1 From the Start menu select the Program group.

2 Select the Modicon Telemecanique program group.

3 Select XWAY Driver Manager.

4 Click on the FPC10 Driver tab.
Result: the following window appears: 

Management properties of XWAY drivers

OK

FPC10 Driver V2.3 IE 12
Copyright © 1995-1999 Schneider Automation
Status driver 1: Non operational
Status driver 2: Non operational

Configuration

XWAY Manager FPC10 Driver UNITELWAY Driver XWAY Test

FPWFPW
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Configuring the FIPWAY link
5 Click on the Configuration button.
Result: The dialog box below appears: 

6 Configure:
l the FIPWAY operating mode and address,
l the driver instance,
l the FIPIO operating mode and connection point.

7 Click on Save.

Step Action

Configuration FIP FPC 10 - Par défaut

Enregistrer

Ouvrir

Par défaut

Fichier Edition ?

Mode FIPWAY

 Adresse FIPWAY  Instance driver

 Adresse FIPIO

Réseau

Mode FIPIO

63

FIP01

FIP02

Station

Point de raccordement FIPIO

31

0
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Configuring the terminal/FIPWAY link

At a Glance Various configuration parameters are available for the Fipway driver.
Main configuration screen: 

Description of 
the FIPWAY 
Address zone

This zone is used to select the FIPWAY operating mode (the driver is selected on 
the FIPWAY network), as well as the network parameters and associated stations.
Network gives the network number and Station gives the station number.
The default values are Network: 0 and Station: 31.

Description of 
the FIPIO 
Address zone

This zone is used to select the FIPIO operating mode (the driver is selected on a 
FIPIO bus) for the driver, as well as the associated Connection point  The default 
connection point is 63.

Description of 
the Driver 
instance zone

This zone is used to select the driver instance to be modified. In most cases only 
one FPC10 card is installed on the computer for FIP communication. Thus, only the 
FIP01 driver instance will be used. However, if a second FPC10 card is installed, a 
second driver instance FIP02 is necessary.

FIP FPC 10 configuration – Default

Save

Open

By default

File Edit ?

FIPWAY mode

 FIPWAY address  Instance driver

 FIPIO Address

Network

FIPIO Mode

63

FIP01

FIP02

Station

FIPIO connection point

31

0
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Description of 
the Save button

Save button:
is used to save the FIP FPC10 driver configuration.
The save button makes the following dialog box appear: 

Elements and their functions:

Element Function

Save in a configuration file 
(DFPWAY.00?)

The FIP FPC10 driver configuration is saved on disk in a con-
figuration file (usually DFPWAY.001). This file is read by the 
driver when the computer boots up. Modifications are taken 
into account the next time the computer is booted up.

Dynamically reinitialize the 
driver (in memory)

The configuration is written directly to the driver memory. Mod-
ifications are acknowledged immediately by the driver. 
Dynamic reinitialization is impossible:
l if the driver is not loaded into the memory (at installation, for 

example),
l if the modifications apply to parameters which cannot be 

dynamically modified (for some advanced parameters for 
example).

l if the driver is being used (if the PL7 is connected, for ex-
ample).

FIP FPC10 Configuration - Save

Cancel

OK

Dynamically reinitialize the driver (in the memory)

Save a configuration file (DFPWAY.00?)
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Description of 
the Open button

The Open button:
is used to read the FIP FPC10 driver configuration.
The Open button causes the following dialog box to appear: 

Elements and their functions:

Element Function

Open a 
configuration file 
(DFPWAY.00?)

The FIP FPC10 driver configuration is read in a configuration file on disk 
(usually DFPWAY.001). From this, you can view and modify the driver’s 
initial configuration (read upon start-up).

Read current driv-
er configuration 
(in memory).

The configuration is read directly in the driver memory. From this you can 
view and modify the driver’s real time configuration. This selection is de-
activated if the driver is not loaded into the memory (at installation, for ex-
ample).

FIP FPC10 Configuration - Open

Cancel

OK

Read the current driver configuration (from the memory).

Open a configuration file (DFPWAY.00?)
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Description of 
the Default 
Button

The Default button:
is used to reinitialize the FIPWAY Address group values, FIPIO Address group val-
ues and Driver instance group values to their default values, either:
l FIPWAY mode,
l Network 0 and Station 31,
l FIPIO connection point 63,
l FIP01 Instance.
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Advanced Configuration

At a Glance An advanced configuration is also available for the FIPWAY driver.

How to access 
advanced 
configuration for 
the FIPWAY 
driver

 The following table describes how to access advanced configuration:

Step Action

1 From the configuration window click on File then select Advanced configura-
tion, as shown in the following window: 

2 Click on Advanced Configuration.
Result: the following window appears: 

The I/O Address fields, the Interrupt, Transfer Mode and DNA Channel zones 
are used to adapt the driver configuration to the FPC10 card hardware config-
uration. Modify these values if you modify the hardware configuration of your 
FPC10 card in relation to the factory configuration.

Management properties of XWAY drivers

OK

FPC10 Driver V2.3 IE 12
Copyright © 1995-1999 Schneider Automation
Status driver 1: Non operational
Status driver 2: Non operational

Configuration

XWAY Manager FPC10 Driver UNITELWAY Driver XWAY Test

FPWFPW

FIP FPC10 Configuration - Advanced

By default

OK

Cancel

I/O Address

 Interrupt

 DMA Channel

 Transfer mode Buffers driver

SBUF

RBUF

IBUF
Page align

IRQ 3

IRQ 5
IRQ 10

IRQ 11

IRQ 15 Channel 7

Channel 5

Channel 6

Programmed I/O mode

DMA Mode

WorldFIPABUF

PRUC 0

210h

3

0

16
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Configuring the FIPWAY link
CAUTION

Significant risks

The other advanced parameters may only be modified by special in-
struction from the software using the FIP FPC10 driver or under the su-
pervision of the technical support department of Schneider 
Automation SA.

Failure to observe this precaution can result in injury or equip-
ment damage.
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OS Loader
Introduction

Subject of this 
chapter

This chapter presents the standard functions of the OS Loader.

What’s in this 
Chapter?

This Chapter contains the following Maps:

Topic Page

The OS Loader: At a Glance 410

Displaying the PLC OS version 412

Downloading an OS 413

Communication error during downloading 414

Limitations of the OS Loader 415
409



OS Loader
The OS Loader: At a Glance

Introduction This software is used to update the operating system on the TSX Micro and TSX 
Premium PLCs by a download via the terminal port.

It also gives the option of reinstalling a previous version of the OS.

The functions of 
the OS Loader

The OS Loader is used:
l to display the OS version installed on the PLC,
l to download the operating system into a PLC memory system.

CAUTION

The download operation includes a delicate phase during which any 
PLC power outage is likely to render it unusable.

Failure to observe this precaution can result in injury or equip-
ment damage.
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OS Loader
How to access 
the OS Loader

Carry out the following steps:

Step Action

1 Click on Start → Program.

2 Select the Modicon Telemacanique menu.
Result:

3 Next, click on OK.
Result:

Avertissement
Prendre les précautions nécessaires pour qu’aucune coupure secteur n’ait lieu sur l’au-
tomate pendant toute la durée du téléchargement (plusieurs minutes).

Si une coupure secteur intervient pendant ce téléchargement,l’automate peut passer dé-
finitivement hors service.

Vérifier que l’on dispose d’une sauvegarde du programme applicatif de l’automate, si le 
programme est exécuté en RAM interne de l’automate.

(l’opération de téléchargement de l’Operating System peut provoquer l’effacement du 
programme applicatif dans la RAM interne de l’automate)

Les fichiers Operating System automate(*.bin) sont livrés sur la disquette “Disquette OS 

OK

Untitled - DS - LOADER
Fichier AP ?

Prêt
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OS Loader
Displaying the PLC OS version

Introduction The OS Loader is used to display various information on the OS version installed on 
the PLC:
l the product reference,
l the specific-application type,
l the hardware variant,
l the software version (SV) of the operating system,
l the development index (DI) of the operating system.

How to access 
the OS version 
display

 Carry out the following steps:

Step Action

1 In the OS Loader window, click on the PLC menu.

2 Click on Display version.
Result:

Version de L’Operating System de l’automate

OK

Référence Commerciale 

Type Métier

Variante Matérielle

VL

IE

TSX 57352

CPU

9

3.7

88

:

:

:

:

:
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Downloading an OS

Preliminary 
operations

Before installing the new operating system on the PLC, you are advised to:
l copy the contents of the CD-ROM containing the OS into a hard disk directory 

and work from this directory (downloading time optimized),
l consult the Readme.txt file document on the CD-ROM.

Disconnect the PLC from all networks before downloading.
The Uni-telway driver must be installed on the terminal and must be the only resident 
driver.

Dedicated features of the TSX Micro: set the "Write Project" micro-switch (situat-
ed in the battery recess), into the OFF position. When the download is complete, put 
the micro-switch back into the ON position.

How to select an 
OS

 Carry out the following steps:

Downloading a 
new OS

 Carry out the following steps:

Step Action

1 Select the File → Select command from the OS Loader window.

2 Select the drive containing the OS CD-ROM (or the hard disk directory to which 
it has been copied).

3 Select the file which relates to the type of processor in question.

Step Action

1 Select the PLC → Load Operating System command.
A dialog box displays the information concerning:
l the operating system on the PLC,
l the new operating system to be installed.
A warning message indicates:
l the risks in the event of a power outage,
l that the PLC has switched to STOP mode.

2 Click on the Load button.
Once the download has been completed, there are two possible scenarios:
l PLC without application or in STOP mode prior to downloading:

close the dialog box by double clicking on the system box.
l PLC in RUN mode prior to downloading:

a dialog box offers to switch the application to RUN mode; confirm your 
choice by clicking on YESorNO.

3 Close the dialog box by double clicking on the system box.
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OS Loader
Communication error during downloading

Introduction Communication errors are caused by certain events (loss of connection, power out-
age…).
These errors can be classified into two types:
l minor,
l fatal.

Minor errors Example: disconnection of the terminal port.
A dialog box offers whether to continue or to stop the download :
l select the Repeat command after having fixed whatever was causing the down-

load to be interrupted or,
l select the Abort load command : the PLC passes into "loading" mode, so you 

will have to restart a new download of the operating system in order to use the 
PLC,

l click on OK to return to the main window.

Fatal errors Example: power outage.
The PLC then becomes unusable. The leds RUN, I/O and ERR are constantly lit and 
the terminal/PLC dialog is impossible.
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Limitations of the OS Loader

The limitations of 
the OS Loader

An operating system cannot be downloaded in the following cases :
Carry out these actions in the event of these cases:

Case Action

the PLC is out of service 
or does not respond any 
more

Impossible to establish the connection!
Check that the PLC has not suffered a power outage, that it is al-
ways connected to console and that no other tool is connected to 
the terminal port.

The PLC is still reserved 
by another tool

Cannot load 
Disconnect the unit which is reserving the PLC.

the binary file to be loaded 
is incompatible with the 
target processor

Cannot load 
Check the type of PLC then select the adapted binary file.

The selected file is not 
(*.Bin) type

Use a (*.Bin) type file.

the binary file to be loaded 
is incompatible with the 
application in the PLC

Warning : the application will be lost when the OS is loaded.
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Windows
Presentation

Subject of this 
chapter

This chapter deals specifically with Windows.

What’s in this 
Chapter?

This Chapter contains the following Maps:

Topic Page

PL7 online help 418

Help Topics Browser 419

PL7 contextual Help 421

General points relating to Windows 422

Equivalent Windows keyboard: Basic principle 423

The menu keys 424

Windows dialogue box keys 425

Keys for modifying text 427

Text selection keys 428

Work station and Windows Explorer keys 429

Print management in Windows 430
417



Windows
PL7 online help

At a glance PL7 online help describes the set up of various software editors in a sequential fash-
ion. It provides detailed information on: 
l users access rights,
l PL7 general information (setting up an application, addressing bit objects and 

words, memory management, etc.)
l PL7 language instructions (functions, syntaxes, operands),
l using PL7 (programming, debugging, diagnostics),
l TSX Micro and Premium application-specific functions (Process control, Up-

counting, Weighing, etc.).

Access mode 
using PLC

There are two access modes:
l from a helpbrowser,
l directly from a context sensitive Help PL7 screen.
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Help Topics Browser

At a Glance The Help Topics browser provides for three types of search:
l from the Contents, which displays a view of the all the different chapters of the 

Help system,
l using the Index, which displays an alphabetical list of key words,
l using the Find mode, which displays all the words used in the on-line Help in al-

phabetical order. 

Illustration of the 
browser

The following illustration shows the browser open at Contents  

?

Help topics: PL7 Help ?

Close CancelPrint…

?
?
?
?
?
?
?
?
?
?
?
?

Click on a topic, then on Display Or click on another tab, e.g. Index

Contents

Application management

Index Find

Application browser
Functional modules
Application configuration
Editing variables
Programming in Ladder Language (LD)
Programming in Instruction List Language (IL)
Programming in Structured Text Language (ST)
Programming in Grafcet Language (GR7)
DFB function blocks
Debugging
Diagnostics
Documentation

Using the software
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Accessing the 
browser

Contents tab

Index tab

Find tab 

Step Action

1 Select the Index command from the ? menu or click on the icon .

2 Select then open the required directory.

Step Action

1 Select the Find ... command from the ? menu or click on the  icon then select 

the Index tab.

2 Enter the key word.

3 Select then open the required topic.

Step Action

1 Click on the  icon then select the Find tab.

2 Enter the word to be found.

3 Select then open the required topic.

???

???

???
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Windows
PL7 contextual Help

At a Glance Contextual Help is used to directly access information from the selected element. 

Accessing the 
Contextual Help

Two exclusive modes of access are used to access Contextual Help.
Standard screens

Modal dialog boxes

Step Action

1 Select the What’s this? command from the ? menu or click on the  icon, 

2 Select the element for which you require technical information (menu, screen, tool-
bar, etc.).

Step Action

1 Click on the  icon of the current element.

???

???
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General points relating to Windows

Introduction Some general points relating to Windows are explained below:
l organization of workspace windows,
l modification of the applications directory and the working directory.

Organization of 
workspace 
windows

You can open several windows at the same time on your PC.
Example: Configuration editor, MAST task section, FAST task section, etc.
In order to quickly reorganize all the open windows on the screen, select the PL7 
Window menu and click on the appropriate sub-menu.

The following table shows you the different sub-menus and their functions:

Modification of 
the applications 
directory and the 
working 
directory

When PL7 opens an existing application, it copies it into the working directory; all 
modifications are made on this copy which must be saved using the File → Save 
command in the application archive directory.

The working directory disk and the application directory are defined at installation 
and can be modified with the Option → Custom command. The modifications will 
take effect after the next PL7 session.

Sub-menu Function

Cascade Arranges the open windows so that the title bar of each of them is visible.

Tile Horizontal-
ly

Tiles the open windows side by side so that they are all visible horizontally.

Tile Vertically Tiles the windows side by side so that they are all visible vertically.

Arrange Icons Aligns all the window icons.

Note: To quickly access one of the open windows, select its name at the bottom of 
the Windowmenu.
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Equivalent Windows keyboard: Basic principle

Presentation Combination of keys producing the same effect as a command using the mouse.
The screen displays the keys to press to activate the required function from the key-
board: you just need to type ALT + the underlined letter for the menus and the but-
tons and only the underlined letter for the sub-menus.

Illustration The following window is an example: 

To open the File menu you must type ALT+F, and to open the sub-menu New... type 
N.

PL7 PRO
Tools ?

RUNRUN STOPSTOP ??????
PL Options

New...
Open…

Exit Ctrl+Q

1 Demo5725.stx

File
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Windows
The menu keys

Introduction The following keys or combination of keys can be used to select the menus and the 
commands.

The keys and 
their functions

This table shows the keys or combinations of keys and their functions:

Press… to…..

ALT or 
F10

Select the first menu from the menu bar or cancel the selection.

ALT + 
character 
key

Choose the menu whose number or underlined letter corresponds to the one 
that you are typing.

Right and 
left arrows

go from one menu to another

Up and 
down ar-
rows

go from one command to another.

ENTER Choose the menu name or the command selected.

A charac-
ter key

Choose the command whose number or underlined letter corresponds to the 
one that you are typing.

ESC l cancel the name of the menu selected,
l or close the open menu.
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Windows
Windows dialogue box keys

Introduction To work in a dialogue box you can use various keys or combinations of keys.

The keys and 
their functions

The following table shows the keys or combinations of keys and their functions:

Press… to…..

TAB Go from one option to another (from left to right and from top to bottom).

SHIFT+TA
B

Go from one option to another in the opposite direction.

CTRL+TAB Go to the next tab.

CTRL+SHI
FT+TAB

Go to the previous tab.

ALT + char-
acter key

Select the option or the group whose number or underlined letter corresponds 
to the one you are typing.

An arrow 
key

l move the cursor from selecting one option (e.g.: button) to another  in a 
group of options,

l or move the cursor to the left, right, up or down in a list or text field.

HOME Select the first element or character in a list or text field.

END Select the last element or character in a list or text field.

Page Up 
and Page 
Down

Scroll up or down a screen list.

ALT+Page 
Down

Open a list.

SPACE l select an element or cancel a selection in a list,
l confirm the button in question,
l activate or deactivate a box to be checked.

CTRL+/
(forward 
slash)

Select all the elements in a list field.

CTRL+\ 
(back 
slash)

Cancel all the selections except the current selection.

SHIFT+ ar-
rows

Delete or cancel the selection character by character in a text field.

SHIFT+HO
ME

Delete or cancel the selection up to the first character in a text field.

SHIFT+EN
D

Delete or cancel the selection up to the last character in a text field.
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ENTER l carry out a command,
l choose the selected element from a list, then carry out the command,
l click on the button with the bold border.

ESC or 
ALT+F4

Close a dialogue box without carrying out the command.

Arrow keys Moving the cursor or insert point into the text fields or entry fields.  

Press… to…..
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Windows
Keys for modifying text

Introduction You can modify text with keys or a combination of keys.

The keys and 
their functions

The following table shows the keys or combinations of keys and their functions:

Press… to…..

Go back l delete the character to the left of the insert point,
l or delete the selected text.

DEL l delete the character to the right of the insert point,
l or delete the selected text.

SHIFT+DEL Delete the selected text and put it in the clipboard.

SHIFT+INS Paste the text from the clipboard into the active window.

CTRL+INS Copy the selected text and put it in the clipboard.

SHIFT+Z Cancel the last modification.
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Text selection keys

Introduction The following keys can be used in most Windows applications, but they do not nec-
essarily work everywhere you can select text or in all applications. All the following 
selections start at the insert point. If a text is already selected, the keys cancel the 
selection.

The keys and 
their functions

The following table shows the keys or combinations of keys and their functions:

Press… To select or deselect…..

SHIFT+ left and right 
arrow

One character at a time to the left or right.

SHIFT+ up and down 
arrow

A text line up or down.

SHIFT+Page Up All the test from the previous screen.

SHIFT+Page Down All the test from the following  screen.

SHIFT+HOME The text up to the beginning of the line.

SHIFT+END The text up to the end of the line.

CTRL+SHIFT+ left ar-
row

The word before.

CTRL+SHIFT+ right ar-
row

The word after.

CTRL+SHIFT+HOME The text up to the beginning of the document.

CTRL+SHIFT+END The text up to the end of the document.
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Work station and Windows Explorer keys

Introduction To work in the windows or theProgram management group, you can use various 
keys and combinations of keys.

The keys and 
their functions

The table below shows the keys or combinations of keys and their functions:

Press… to…..

F2 Rename an element.

F3 Search for a file or data set.

CAP + DEL Delete the element directly without putting it in the recycle bin.

ALT+Enter Display the properties of the selected element.

CTRL+A Select all.

F5 Update the information in a window.

CAP while click-
ing on the Close 
button

Close the selected file and all its parent files.
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Print management in Windows

Introduction Print management is a Windows application that manages print works.
When you print a document from a Windows application this transmits to the print 
manager all the information on the printing, the fonts and the document file.

Description Print management:
l takes care of printing the document while you continue to work on other Windows 

applications,
l indicates problems if an error occurs,
l prints the documents on a local or network printer.

How to install a 
printer

 Carry out the following steps:

Note: It is possible to print several documents at a time or one document after the 
other.  The documents are then placed in a queue which is used to verify printing 
information.  

Step Action

1 Click on Run.

2 Click on Parameters.

3 Click on Printers.

4 Click on add a printer and follow the instructions of the Add printer assistant.
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Glossary
Animation table Table created by the user or created contextually from within a language editor or 
an operating screen.
In connected mode allows you to view the development of the PLC’s variables and 
to force the values when debugging.

ASCII American Standard Code for Information Interchange.
Is pronounced "aski".This is an American code (but has become an international 
standard) which allows by means of 7 bits the definition of all the alphanumeric char-
acters used in English, punctuation marks, certain graphical characters as well as 
various commands.

Auto Run Function which allows you to automatically execute the application program on the 
PLC at initialization. 

BIT Contraction of the English words Binary Digit.
This is the binary unit of information which can represent two distinct values (or 
states) :0 or 1. A field of 8 bits makes up what we call 1 Byte or 1 octet.

Block functions Blocks contained in the PL7 product (defined by Schneider).
The user has only to parameterize these blocs in the variables editor heading "Pre-
defined FB".
These blocks are:

A

B
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l Timer,
l Monostable,
l Up/down counter,
l Drum,
l Register.

Breakpoint Used in "debug" mode in the application.
It is unique (only one at a time) and once reached, signals to the processor to stop 
the execution of the program.
Used in connected mode, it can be positioned in one of the following program ele-
ments:
l Ladder rung,
l Structured Text or Instruction List statement,
l Structured Text line (line mode).

Comment A comment of 508 characters can be associated to each address even if the latter 
does not have a symbol, from within the variables editor.

Comment for ST 
language

The comment (optional) can be integrated  anywhere in a statement.It is separated 
at both ends by the characters (*and *)and can occupy a maximum of 128 lines.Its 
size is limited to 256 characters (new lines are included in the count).
The comments are stored in the PLC and can be accessed at any time by the us-
er.They therefore use up program memory.

Constants Memory unit (Bit, Word, Dword, etc.) whose contents cannot be modified by the pro-
gram being executed.

CPU Central Processing Unit
This is the microprocessor.It is made up of the control unit and the arithmetic logic 
unit.The purpose of the control unit is to extract from the central memory the instruc-
tion to be executed as well as the data necessary for the execution of this instruction, 
to establish the electric connections in the arithmetic logic unit and to start the data 
processing in this unit.You can sometimes find ROM or   RAM memories included 
on the same chip, or even I/O interfaces or buffers.

CU Central Unit: generic name for Schneider Automation processors.

C
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DFB The DFB types (Derived Function Blocks) are function blocks which can be pro-
grammed by the user in ST or LD language.
Using these DFB types in an application:
l simplifies the design and input of the program,
l improves the readability of the program,
l facilitates its debugging,
l decreases the amount of code generated.
PL7 Pro software is needed to create a DFB type.

DFB instance This regards a copy of a DFB type when the latter is called from within a language 
editor.
The instance has a name. Input/output interfaces, public and private variables are 
duplicated (one duplication per instance, the code is not duplicated)
A DFB type can have several instances.

Documentation Contains all the information on the application, the documentation is printed after be-
ing put together and is used for maintenance purposes.
It contains information regarding:
l hardware and software configuration,
l the program,
l the DFB types,
l the variables and the animation tables,
l the cross references.
When putting the documentation together, it is possible to include only certain head-
ings, if the user so wishes.

Driver Program which informs the operating system of the presence and characteristics of 
a peripheral. 

Events Software or hardware initiated modules (module operation). 
Events have priority over MAST or FAST tasks, they are executed as soon as they 
are detected.
Event EVT0 has the highest priority, the others have the same level of priority.

D

E
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FAST task Task activated periodically (the period controlled in the configuration of the proces-
sor) used to execute a part of an application with superior priority to a MAST (mas-
ter) task.

Flash EPROM PCMCIA memory cards:
l internal (TSX37) containing program, constants, memory %MW,
l external (TSX37-57) containing program and constants.

FNES Fichiers Neutres d’Entrées Sorties (Input/Output Neutral Files).The FNES format 
describes the PLCs in terms of rack, cards and channels using a tree structure.
It is based on the CNOMO standard (Comité de Normalisation des Outillages de Ma-
chines Outils).

Function Functions delivered with PL7 and accessed from the Tools/Library menu.
The user has only to parameterize these functions. He can develop others with the 
help of a development kit SDKC which is an option of PL7. 

Function view View allowing you to see the program part of the application by means of functional 
modules created by the user (see definition Functional module).

Functional 
module

A functional module is a grouping together of program elements (sections, subrou-
tines, macro-steps, animation tables, operating screens…) intended to carry out an 
automation function.
A functional module can itself be broken up into functional modules of a lower level, 
these modules taking on, in relation to the main function, one or several automation 
sub-functions.

Grafcet Grafcet language.
Grafcet language conforms to "Sequential Function Chart" language (SFC) of the 
IEC 1131-3 standard.
Grafcet allows the operation of sequential automation to be represented graphically 
and in a structured manner.This graphical description of the automated sequential 
performance and the different situations which arise is carried out with the help of 
simple graphical symbols.

F

G
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Instructions for 
ST language

An instruction can be either simple (Assign, Increment, Call SR…) or control struc-
ture (IF, WHILE, FOR, REPEAT...). The character ; is obligatory at the end of each 
instruction.

Label A label (optional) allows you to find a statement or a rung in a program module and 
is required to allow a jump after a GOTO instruction.The following syntax %Li:with i 
between 0 and 999.
The label is positioned at the beginning of the statement or rung and can only be 
assigned to a single statement or rung within the same program module.The order 
of label address is not important, it is the input order of the statements or rungs which 
is taken into account by the system at scanning. 

Ladder Rung language.
A program written in rung language is composed of a series of rungs executed se-
quentially by the PLC.

LIST Instruction list language.
A program written in instruction list language is composed of a series of instructions 
executed sequentially by the PLC.Each instruction is composed of an instruction 
code and an operand.

Macro-step A macro-step is the symbolic representation of a unique set of steps and transitions, 
which starts with an input step (IN) and terminates with an output step (OUT).
A macro-step can call another macro-step (nesting).

Mono task Application made up of a single task, has to be a MAST task (master task).

Multi task Application made up of several tasks (MAST, FAST, event).
An order of priority for task execution is defined by the PLC’s operating system.

I

L

M
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Operating screen This is a tool integrated into software applications PL7-PRO and PL7-PRODYN from 
version 3.0 onwards. It is intended to facilitate the operation of an automated pro-
cess. The end-user controls and monitors the operation of the installation and in 
case of a problem, he can act quickly and easily. 

Protection Function preventing the reading of the contents of a program module (read protec-
tion), or the reading and modifying of the contents of a program module (read/write 
protection).
Protection is confirmed by a password.

RS 232C Communication series standard which defines among others the following service 
voltage:
l a signal of +12V indicates a digital 0,
l a signal of -12V indicates a digital 1.
However detection to thresholds of +3V and –3V is allowed in case of a weakened 
signal.
Between these two bounds, the signal will be considered invalid.
RS 232 links are quite sensitive to interference.The standard recommends not ex-
ceeding 15metres in distance and 9600 bauds (bits/sec) maximum.

RS 485 Communication series standard which works differentially at 10V/+5V.It uses 2 
wires for sending and receiving.Its "3-state" output allows it to go into listening mode, 
when the transmission has finished.

Run Function which allows you to execute the application program on the PLC.

O

P

R
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Rung A rung is entered between two potential bars in a Ladder editor and is composed of 
a group of graphical elements joined to each other by horizontal or vertical links.The 
maximum dimensions of a rung are 16 lines and 11 columns (for PLCs TSX/PMX/
PCX 57), or 7 lines and 11 columns (for PLCs TSX 37) split into two zones:the test 
zone and the editing zone.

Section Program module belonging to a task (MAST, FAST) which can be written in a lan-
guage chosen by the programmer (Structured Text, Ladder, List, Grafcet).
A task can be made up of several sections, the order of execution of the sections 
within the task corresponds to the order in which they were created. This order can 
be modified.

ST Structured text language.
Structured text language allows you to create programs by writing lines of code com-
posed of alpha-numeric characters.This language can only be used for the software 
PL7 Junior and PL7 Pro on PLCs TSX/PMX/PCX 57. In the version PL7 Pro, this 
language allows the creation of user function blocks DFB.

Statement Basic unit of List language or Structured Text language.
A statement is made up of lines, which are themselves made up of instructions.
It begins with an exclamation mark, can include a comment and can be marked with 
a label.

Step A Grafcet step designates a state of sequential operation of automation.
Initial step defines the initial automation situation.
Single step defines a stable automation situation.
Actions can be associated.These can be expressed in Ladder, Structured Text or 
List language.

Stop Function which allows you to stop the execution of the application program on the 
PLC.

Subroutine Program module belonging to a task (MAST, FAST) which can be written in a lan-
guage chosen by the programmer (Structured Text, Ladder, List).
A subroutine can only be called by a section or another subroutine (nesting) belong-
ing to the task in which it is registered.

Symbol A symbol is a string of a maximum of 32 alpha-numeric characters, of which the first 
character is alphabetic.

S
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It allows you to personalize a PLC object in such a way as to facilitate the maintain-
ability of the application, it is used on the PLC if the user wants to.

Task Group of sections and subroutines, executed cyclically or periodically for the MAST 
task or periodically for the FAST task.
A task has a level of priority which is linked to the input and output.

Time Out Exceeding delay.
Stopping of the application or deconnection following a too-long period of inactivity.

Transition A transition indicates the possibility of development between several steps.
A transition condition called Receptivity is associated with it.
The transition is valid if :
l the upstream steps (directly linked to this step) are active,
l the associated receptivity is true.
The releasing of a transition provokes the change of status for the steps which are 
linked to it.
The receptivities are expressed in Ladder, Structured Text or List language.

Variable Memory unit of a type (Bit, Word, Dword, etc.) whose contents cannot be modified 
by the program being executed.

T

V
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A
Access to a subroutine, 163
Access to PL7, 47
Accessing a statement or instruction list, 154
Accessing a subroutine, 185
Accessing the configuration, 85
Adjustment of the application specific 
functions, 305
Animating the program, 285
Animating variables, 314
Animation of variables, 310
Application browser, 102
Application opening, 49
Assisted entry of a function in List, 161

B
Backing up, 60
Breakpoint, 297

C
Comments, 229
Comparing applications, 58
Configuration editor, 28
Connections, 20
Counter/ down counter, 241
Create section, 105
Creating a DFB instance, 265
Creating a DFB type, 261
Creating a functional module, 248
Creating a Grafcet module, 203
Operate modes manual 9/2000 
Creating a Grafcet section, 107
Creating a Ladder program, 119
Creating a Structured Test program, 175
Creating a Subroutine, 109
Creating an animation table, 256
Creating an application, 48
Creating an event, 110
Cross Referencing, 145, 166, 188, 221
Cutting/Copying/Pasting variables, 237

D
Debugging, 35
Debugging functional modules, 306
Designing a Grafcet program, 196
Detaching/Deleting functional modules, 251
DFB debugging, 308
DFB Diag error messages, 329
Display variables, 235
Displaying variables, 127, 157, 179
Documentation, 334, 337
Downloading an OS, 413, 414
Drum, 241

E
Editing a section, 111
Editing a sub-program, 111
Editing an event, 111
Entering a DFB instance, 268
Eprom Flash Back up, 59
Event, 110
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Export an application with DFB types, 270
Export of runtime screens, 373
Export Section/SR/EVT, 351
Exporting a DFB type, 270
Exporting a source file, 354
Exporting an application, 380
Exporting an application in FNES format 
(Input/Output Neutral File), 384
Exporting animation table(s), 369
Exporting variables, 357

F
FIPWAY Configuration, 400, 406
Forcing analog inputs

TSX Micro, 303
TSX Premium, 304

Function block, 182
Function blocks and DFB instances in 
Ladder, 139
Function modules, 246
Functional module debugging, 250
Functional module export, 362
Functional module import, 364

G
Grafcet configuration

TSX 37, 82
TSX 57, 99

Grafcet debugging, 288
Grafcet graphic objects, 198

I
Implementation of diagnostics DFB, 328
Import of runtime screens, 375
Import section, 105
Import/Export source file, 344
Importing a DFB type, 270
Importing a functional module, 366
Importing a Grafcet section, 107
Importing a Subroutine, 109
Importing an application, 382, 385
Importing an application with DFB types, 270
Importing an event, 110
440 
Importing animation table, 371
Importing DFB, 378
Importing LD, IL, ST, 355
Importing variables, 358
Input of a function block, 131
Input of a predefined block, 160

L
Ladder Editing, 30
Library function (ST editor), 183
Limitation of the OS Loader, 415
Link configuration, 390, 402
List Editing, 31
List of forced bits, 317

M
Memory Usage, 63
Modification of the program in Run mode, 
284
Modifying a network of contacts, 122
Modifying a Structured Test program, 176
Modifying Grafcet programs, 216
Modifying section order, 112
Modifying variables, 316
Module call stack, 326
Module configuration

TSX 37, 78
TSX 57, 94

Module/channel diagnostics, 323
Monostable, 240

O
Online symbolization, 130, 159, 181
Operating screen, 39

P
Parametrizing the function blocks, 239
PL7 address, 62
PL7 Security, 46
Presymbolization of variables, 232
Print management in Windows, 430
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Printing variables, 243
Processor

TSX 37, 73, 75
TSX 57, 89, 91

Program diagnostics, 324
Program printing, 149, 170, 192, 225
Programming a DFB type, 262
Programming a functional Module, 249
Properties of a function module, 247
Protecting a DFB type, 269
Protecting an application, 50

R
Register, 241
Replacing a variable, 143, 164, 186, 219
Runtime screens, 113

S
Saving an application, 53
Sending a command to the PL7, 65
Series 7 timer, 240
Short cut keyboard, 427, 428
Software configuration

TSX 37, 81
TSX 57, 98

Software installation, 21
Sorting variables, 234
Specific Ladder input, 121
Step by step mode, 300
Structure of a List program, 152
Structure of an ST program, 174
Structured language editor (ST), 32
Symbols, 229

T
Timer, 240
Transferring a program from PC, 55
Transferring data, 57
TSX 37

hardware configuration, 86
module configuration, 80
supply configuration, 88
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TSX 57
module configuration, 96

U
Uni-telway Configuration, 388
Uni-telway configuration, 396

V
Variables editor, 29
Variables in EXCEL format, 360

W
Windows

short cut keyboard, 429
short cut keyboards, 424, 425

Working with animation tables, 312
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